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Warranty  

All products manufactured by ICP DAS are under warranty regarding defective materials for 

a period of one year, starting from the date of delivery to the original purchaser.  

 

Warning 

ICP DAS CO., LTD. assumes no liability for damages consequent to the use of this product. 

ICP DAS CO., LTD. reserves the right to change this manual at any time without notice. The 

information furnished by ICP DAS CO., LTD. is believed to be accurate and reliable. 

However, no responsibility is assumed by ICP DAS CO., LTD. for its use, or for any 

infringements of patents or other rights of third parties resulting from its use. 

 

Copyright and Trademark Information 

© Copyright 2015 by ICP DAS CO., LTD. All rights reserved worldwide. 

 

Trademark of Other Companies 

The names used for identification only maybe registered trademarks of their respective 

companies. 

 

License 

The user can use, modify and backup this software on a single machine. The user may not 

reproduce, transfer or distribute this software, or any copy, in whole or in part. 

 

Technical Output: 

Please contact local agent or email problem-report to service@icpdas.com . 

For more product information, please refer to https://www.icpdas.com . 

 

 

mailto:service@icpdas.com
https://www.icpdas.com/
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1. Introduction: UA IIoT Communication Server 

This chapter introduces UA series and its functions, software/hardware specifications. 

1.1 Introduction 

UA-2200/UA-5200/7200 Series is a series of IIoT (Industrial IoT) Communication Server for 

integrating the system and devices of IT and OT. UA features the IIoT Gateway function that 

allows users to access the remote I/O modules and controllers via Modbus TCP/RTU/ASCII, 

MQTT, and EtherNet/IP communication protocols. IIoT gateway function can also convert 

these I/O data to OPC UA or MQTT protocols for the needs of connecting with the MES, ERP, 

SCADA and Cloud services. Besides, UA features the Data Logger function that allows users 

to write the I/O data directly into the remote database, and save to the local fi le as the historical 

records. UA supports Cloud platform that can connect to Amazon AWS, Microsoft Azure or 

other Cloud platforms to send over the I/O data; and support Cloud logic service platform 

“IFTTT” which can connect many web APPs that allows users to receive first-hand notification 

messages through the most commonly used mobile APPs when an event triggered. UA Series 

enhances the networking and interoperability between IT and OT. Through UA series, users 

can easily deploy for Industrial IoT. 

 
 UA Series: 

UA-5200 Series 

UA-5231 UA-5231M 
UA-5231M-4GE 
UA-5231M-4GC 

UA-5231M-3GWA 

  

 

UA-2200 and 
UA-7200 Series 

UA-7231M UA-2241M 
UA-2241MX-4GE 
UA-2241MX-4GC 
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1.2 Features 

 

 Simultaneous Writing for Remote Database and Local Data Logger 

 Offline Data Recovery Mechanism for Remote Database 

 Support to Enable OPC UA and MQTT at the Same Time 

 MQTT Broker (Including WebSocket) 

 Support a Complete Information Protection Mechanism 

- HTTPS 

- Communication Encryption 

- Dynamic Blocklist 

- Whitelist 

 IoT Cloud Platform Connection 

- Microsoft Azure 

- Amazon Web Services 

- IBM Bluemix 

- Alibaba Cloud 

 IFTTT Logic Control Triggers the APP Notification Function 

 PID Logic Operation Function 
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1.3 Specifications 

 Hardware Specifications: UA-2200 Series 

Tab. 1) CH1 Hardware Specifications: UA-2200 

Model UA-2241M UA-2241MX-4GE UA-2241MX-4GC 

Main Unit 

CPU ARM CPU, 1.0 GHz 

System Memory DDR3 SDRAM 512 MB 

Storage 
· Flash 512 MB 

· microSD socket with one 4 GB microSD card (support up to 32 GB microSDHC card) 

Non-Volatile 

Memory 
FRAM 64 KB 

Real Time Clock Provide second, minute, hour, date, day of week, month, year 

Display 

Signal  VGA (Analog RGB), reserved 

LED Indicators 

Status 
PWR (Power), RUN 

(Running), L1, L2, L3  
PWR (Power), RUN (Running), L1, L2, L3, 4G  

I/O Expansion 

I/O Type Support 1 optional XV-board to expand I/O or RS-485 ports (*1) 

COM Ports 

Console Port RS-232 (RxD, TxD and GND); Non-isolated 

ttyO2 RS-485 ( Data+, Data- ); 2500 VDC isolated 

ttyO4 RS-232 (RxD, TxD and GND); Non-isolated 

ttyO5 RS-485 ( Data+, Data- ); 2500 VDC isolated 

HMI 

Rotary Switch 1 x 10 Position (0 ~ 9) 

Ethernet 

Ports 2 x RJ-45, 10/100/1000 Based-TX ( Auto-negotiating, Auto MDI/MDI-X, LED indicators ) 

USB 

Connector 2 x 2.0 host 

Power 
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Model UA-2241M UA-2241MX-4GE UA-2241MX-4GC 

Input Range +12 ~ +48 VDC 

Consumption 4.8 W 6.5 W 

Mechanical 

Casing Metal 

Dimensions (mm) 35 x 167 x 119 (W x L x H) 

Installation DIN-Rail 

Environmental 

Temperature 
Operating Temperature: -25 ~ +75°C 

Storage Temperature: -40 ~ +80°C 

Humidity 10 ~ 90% RH, non-condensing 

3G System Wireless Communication 

Data 

Transmission 

Rate 

- 

· DC-HSPA+ Download: Max. 42 Mbps; Upload: Max 5.76 Mbps 

· TD-SCDMA Download: Max. 4.2 Mbps; Upload: Max 2.2 Mbps 

· CDMA2000 EVDO Download: Max. 14.7 Mbps; Upload: Max 

5.4 Mbps 

Frequency Band - 
 WCDMA 850/900/2100 

MHz 

 WCDMA 900/2100 MHz 

 TD-SCDMA 1900/2100 MHz 

 CDMA2000 (BC0) 800 MHz 

4G System Wireless Communication (*2) 

Data 

Transmission 

Rate 

-  Download Max 100 Mbps; Upload Max 50 Mbps 

Frequency Band - 
 FDD LTE: 

B1/B3/B5/B7/B8/B20  

 FDD LTE: B1/B3/B8 

 TDD LTE: B38/B39/B40/B41 

Specification Memo:  

*1. Refers to the UA website Supported List for the available XV-board and supported UA 

models.  

*2. 4G System Note: 

UA-2241MX-4GE: Support 4G LTE (FDD) Communication (Asia Only, Except China) 

UA-2241MX-4GC: Support 4G LTE (FDD, TDD) Communication (For China only) 

  

https://www.icpdas.com/en/product/guide+IIoT+Controller_Server+Communication__Server#2829
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 Hardware Specifications: UA-5200 Series 

Tab. 2) Hardware Specifications: UA-5200 

Model UA-5231 UA-5231M UA-5231M-3GWA UA-5231M-4Gx 

Main Unit 

CPU ARM CPU, 1.0 GHz 

System Memory DDR3 SDRAM 512 MB 

Storage 
Flash eMMC 8 GB 

microSD socket with one 4 GB microSD card (support up to 32 GB microSDHC card) 

Non-Volatile 

Memory 
FRAM 64 KB 

Real Time Clock Provide second, minute, hour, date, day of week, month, year 

Display 

Signal  VGA (Analog RGB), reserved 

LED Indicators 

Status 
PWR/RUN (Power/Running),  

L1, L2 

PWR/RUN,  

L1, L2, 3G 

PWR/RUN,  

L1, L2, 4G 

I/O Expansion 

I/O Type Support 1 optional XV-board to expand I/O or RS-485 ports (for Rev.B version) (*1) 

COM Ports 

Console Port RS-232 (RxD, TxD and GND); Non-isolated 

ttyO2 RS-485 ( Data+, Data- ); 2500 VDC isolated 

ttyO4 RS-232 (RxD, TxD and GND); Non-isolated 

ttyO5 RS-485 ( Data+, Data- ); 2500 VDC isolated 

HMI 

Rotary Switch 1 x 10 Position (0 ~ 9) 

Ethernet 

Ports 1 x RJ-45, 10/100/1000 Based-TX ( Auto-negotiating, Auto MDI/MDI-X, LED indicators ) 

USB 

Connector 1 x 2.0 host 

Power 

Input Range +12 ~ +48 VDC 
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Model UA-5231 UA-5231M UA-5231M-3GWA UA-5231M-4Gx 

Consumption 4.8 W 6.5 W 

Mechanical 

Casing Plastic Metal 

Dimensions (mm) 91 x 132 x 52 (W x L x H) 117 x 126 x 58 (W x L x H) 

Installation DIN-Rail Mounting 

Environmental 

Operating 

Temperature 
-25 ~ +75°C 

Storage 

Temperature 
-40 ~ +80°C 

Humidity 10 ~ 90% RH, non-condensing 

 

Wireless Model UA-5231M-3GWA UA-5231M-4GE UA-5231M-4GC 

3G System Wireless Communication 

Data Transmission 

Rate 

· WCDMA / HSPA+  

  Download: Max. 

14.4Mbps;  

  Upload: Max 5.76Mbps 

· DC-HSPA+ Download: Max. 42 Mbps; Upload: Max 

5.76 Mbps 

· TD-SCDMA Download: Max. 4.2 Mbps; Upload: Max 

2.2 Mbps 

· CDMA2000 EVDO Download: Max. 14.7 Mbps; 

Upload: Max 5.4 Mbps 

Frequency Band 
· WCDMA 

850/900/1900/2100 MHz 

· WCDMA 

850/900/2100 MHz 

· WCDMA 900/2100 MHz 

· TD-SCDMA 1900/2100 MHz 

· CDMA2000 (BC0) 800 MHz 

4G System Wireless Communication (*2) 

Data Transmission 

Rate 
- · Download Max 100 Mbps; Upload Max 50 Mbps 

Frequency Band - 
· FDD LTE: 

B1/B3/B5/B7/B8/B20  

· FDD LTE: B1/B3/B8 

· TDD LTE: B38/B39/B40/B41 

Specification Memo:  

*1. Refers to the UA website Supported List for the available XV-board and supported UA 

models.  

*2. 4G System Note: 

UA-5231M-4GE: Support 4G LTE (FDD) Communication (Asia Only, Except China) 

UA-5231M-4GC: Support 4G LTE (FDD, TDD) Communication (For China only)    

https://www.icpdas.com/en/product/guide+IIoT+Controller_Server+Communication__Server#2829
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 Hardware Specifications: UA-7200 Series 

Tab. 3) Hardware Specifications: UA-7200 

Model UA-7231M 

Main Unit 

CPU ARM CPU, 1.0 GHz 

System Memory DDR3 SDRAM 512 MB 

Non-Volatile Memory FRAM 64 KB 

Storage 

Flash eMMC 8 GB 

microSD socket with one 4 GB microSD card (support up to 32 GB microSDHC 

card) 

Real Time Clock Provide second, minute, hour, date, day of week, month, year 

LED Indicators 

Status 

1 x PWR 

1 x RUN 

1 x Ethernet 

1 x PoE 

COM Ports 

Ports 1 x 5-wire RS-232/485 (COM1) 

Bias Resistor Switch-selectable (1 kΩ for RS-485, Non-Resistor for RS-232) (COM1 DIP Switch) 

Terminal Resistor Switch-selectable (120 Ω, Enable/Disable) (COM1 DIP Switch) 

Isolation Isolated 

HMI 

DIP Switch 1 x 9 Position (0 ~ 8, ON) (System Boot DIP Switch) 

Ethernet 

Ports 1 x RJ-45, 10/100 Base-TX 

PoE PoE (IEEE 802.3af, Class 1) 

Power 

Input Range +12 ~ +48 VDC 

Consumption 3.5 W 

Mechanical 

Casing Metal 
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Model UA-7231M 

Dimensions (mm) 97 x 114 x 38 (W x L x H) 

Installation DIN-Rail 

Environmental 

Operating Temperature -25 ~ +75°C 

Storage Temperature -40 ~ +80°C 

Humidity 5 ~ 90% RH, non-condensing 
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 Software Specifications: UA-2200 / UA-5200 / UA-7200 Series 

Tab. 4) Software Specifications: UA Series 

Model UA-2200/UA-5200 Series UA-7200 Series 

OS 

Linux Linux Kernel 3.2.14 

Protocol 

OPC UA Server 

● OPC Unified Architecture: 1.02 
● Core Server Facet 
● Data Access Server Facet 
● Method Server Facet 
● UA-TCP UA-SC UA Binary 
● User Authentication: Username/Password, X.509 Certificate 
● Security Policy: 

> None 
> Basic128Rsa15 (Sign / Sign & Encrypt) 
> Basic256 (Sign / Sign & Encrypt) 
> Basic256Sha256 (Sign / Sign & Encrypt) 
> Aes128_Sha256_RsaOaep (Sign / Sign & Encrypt) 
> Aes256_Sha256_RsaPss (Sign / Sign & Encrypt) 

● Recommend Max. 20 Client Sessions, and Max. 8000 Tags (Note 1).  

  (Without using encrypted communication) 

MQTT Broker 
Compliance with MQTT v3.1.1 protocol. Provide MQTT message distribution 
management. Support TLS/SSL and Web Socket communication. 
Recommend 200 connections of clients or devices (Max. 400). (Note 1) 

MQTT Client  

Connect the MQTT Broker to read/control the devices supporting the MQTT protocol, 
or connect the MQTT Broker to externally read/control the devices supporting other 
protocols that linking with the UA series. (MQTT Ver. 3.1.1; TLS Ver. 1.2) 
Recommend Max. 200 Connections. (Note 1) 

Modbus TCP 
Master 

To read or control the devices that support standard Modbus TCP Slave protocol.  
Recommend Max. 100 modules. (Note 1) 

Modbus RTU/ASCII 
Master 

A max. of 3 ports: ttyO2, ttyO4, ttyO5 to 
connect other Modbus RTU Slave devices 
(e.g. M-7000). Recommend Max. 32 
devices per port (32*3 port=96) for better 
communication quality. (Note 1) 

A max. of 1 ports: COM1 to connect other 
Modbus RTU Slave devices (e.g. M-7000). 

Recommend Max. 32 devices per port 
(32*1 port=32) for better communication 

quality. (Note 1) 

EtherNet/IP 
Scanner 

Support connect EIP-2000 series modules of ICP DAS. 
Recommend Max. 50 devices per UA. (Note 1) 

XV-board 
Support XV-board series modules of ICP 
DAS. 

- 

Firewall 

Whitelist 
List IP addresses and ranges allowed through the firewall to prevent unauthorized 
access and system attacks. 

Dynamic Blocklist 

Set conditions to monitor the connection status of the service port. When the external 
IP connections exceed the condition setting value, the dynamic blocklist will 
automatically block the subsequent connection of the IP to avoid a large number of 
abnormal connections from blocking network services and protect system stability. 

Data Logger 

Local Data Logger  Record I/O data, and save to the local MicroSD card or SSD in CSV format. 

Remote Database Record I/O data, and send to the remote database of MS SQL / MySQL / MariaDB. 
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Model UA-2200/UA-5200 Series UA-7200 Series 

Recommend Max. 1 Databases per Time, and Max. 1000 Tags.  

Function 

PID Function Combine the remote I/O devices for the PID logic control system. 

Internal Module Can create virtual variables as an intermediary for reading, writing, or data exchange. 

IoT Service Integration 

Microsoft Azure MQTT Service can connect to MS Azure IoT Hub for Cloud platform service. 

Amazon Web 
Services 

MQTT Service can connect to AWS IoT Core for Cloud platform service. 

IBM Bluemix MQTT Service can connect to IBM Bluemix for Cloud platform service. 

IFTTT 
Support Logic event sending to IFTTT Web platform. IFTTT Logic Trigger APP (Line, 
Twitter, Gmail ...) 

Note 1. When using multiple Protocol functions, the user needs to control the device number to under 80% of 
the CPU usage. Please refer to the CPU Usage of the UA Web UI. (as the figure below) 

 

 

  



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

31 

1.4 Appearance 

 
UA-2241M / UA-2241MX-4GC / UA-2241MX-4GE 
 

 

Fig. 1) CH1 Appearance: UA-2200 
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UA-5231 

 

 

 

 

Fig. 2) Appearance: UA-5231 
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UA-5231M 
 

 
 

 

Fig. 3) Appearance: UA-5231M 
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UA-5231M-3GWA / UA-5231M-4GE / UA-5231M-4GC  
 

 

 
 

 
Fig. 4) Appearance: UA-5231M-3GWA/-4GE/-4GC 
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UA-7231M 
 

 

 
Fig. 5) Appearance: UA-7231M 
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1.5 Pin Assignment 

 UA-2200 Series Pin Assignment 

UA-2241M / UA-2241MX-4GC / UA-2241MX-4GE 

 

 
Fig. 6) Pin Assignment: UA-2200 Series 

 

 UA-5200 Series Pin Assignment 

UA-5231 / UA-5231M / UA-5231M-3GWA / UA-5231M-4GC / UA-5231M-4GE 

   Versions shipped before 2021/09 

 

   Versions shipped after 2021/09 

 

Fig. 7) Pin Assignment: UA-5200 Series-1 
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   Versions shipped between 2021/05 ~ 2021/09 (Notice) 

The pin assignment diagram on the shell of the UA-5231 shipped between 2021/05 and 

2021/09 (as shown below), the Ground (GND) with the red line is ineffective when 

connected to RS-232 (ttyO4, Console), please uses another Ground (GND in blue box) 

 
Fig. 8) Pin Assignment: UA-5200 Series-2 

Because the shell of UA-5231 does not indicate the date of shipment or the hardware version, 
the users must log in to the UA Web User Interface and check the Version Information. 

When the [Flash Information] of [Version Information] is displayed as “eMMC”, the 
connection of RS-232, the Ground should be connected to the GND position in the blue 
box above. 

 
Fig. 9) [Flash Information] in [Version Information] 
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 UA-7200 Series Pin Assignment 

     

 

System Boot DIP Switch:                      RS-232/485 COM Port (COM1): 

 

                    
 

COM1 DIP Switch: 

 
Fig. 10) Pin Assignment and DIP Switch of UA-7200 Series   



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

39 

1.6 Dimensions 

 

UA-2241M / UA-2241MX-4GE / UA-2241MX-4GC 

 
Unit: mm 

 

 

Fig. 11) Dimensions: UA-2200 Series 
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UA-5231 

Unit: mm 

 

 
 
 

UA-5231M / UA-5231M-3GWA / UA-5231M-4GE / UA-5231M-4GC 
 

Unit: mm 

 

Fig. 12) Dimensions: UA-5200 Series 
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UA-7231M 

Unit: mm 
 
 

 

Fig. 13) Dimensions: UA-7231M 
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2. Quick Start 1: Hardware/Network Connection 

This chapter describes the devices hardware connection, network connection and quick setting 

for the UA Controller, and how to connect to the UA controller web-based UI via a browser. 

Nest chapter will set up web functions, and complete an example project. 

2.1 Hardware Connection 

This section describes the hardware wiring and connection for the UA Controller. 

2.1.1 Preparations for Devices 

In addition to the UA series controllers (Ex: UA-5231), please prepare the following: 

1. PC/NB: Can connect to the network and set the network  

2. Ethernet Hub or Switch: Ex: NS-205A, or PoE Switch NSM-208PSE for UA-7200 

3. Power Supply: +12 ~ +48 VDC (Ex: MDR-60-24)  

 

2.1.2 Hardware Wiring 

Connect the UA with the RJ-45 Ethernet port to an Ethernet hub/switch (Fig.2 for PoE Switch of 

UA-7200) and PC. You can also link directly the UA to PC with an Ethernet cable.  

After power is connected, please [ wait 1 minute] for UA start-up procedure. When the 

"RUN/PWR" light of UA-5200 or "RUN” light for UA-2200/7200 starts flashing, it represents the 

boot is complete. 

 

 

 
Fig. 14) CH2 Hardware Wiring 

Switch/Hub 

S 

Cable 
 

Cable 

Power Supply 
V 

-V 

Fig.1 

LAN1 

UA Series 

PC/NB 

PoE Switch/Hub 
UA-7200 

Cable 

Cable 

Power Supply 

Fig.2 

PC/NB 
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2.2 Network Connection 

This section introduces how to connect to the UA Web User Interface (UA Web UI).  

Setting new UA or the new user please uses the method A in the Chapter 2.2.1 (The 

same method as the “UA Series Quick Start” manual).  

Other users please see the following introductions to choose method B(Sec.2.2.2) or C. 

 

The methods to login the UA series Web UI: 

 

A. Using Factory Default Setting: Suitable for setting a new UA controller and the PC 

network IP is not in the same domain with UA. This method changes the PC network 

IP to be the same domain with the UA factory default network IP to login the Web UI. 

(Refer Section 2.2.1) 

 

B. Using Software Utility: Suitable for quick setting when many UA servers are in the 

network but the IP are unknown. UA Series provides a free software utility for auto 

searching UA controllers in the network and can quick jump to the login web page of UA. 

(Refer Section 2.2.2)  

 

C. Using IP Address: Suitable for the UA has a fixed IP and in the same domain with 

the PC. If the UA has a fixed IP and in the same domain with the PC, users can directly 

enter the IP in the address bar of a web browser and log in to the Web UI of the UA.  

 

 

 

 

 

 

 

 

 

 

Fig. 15) UA Log in Web Page 

 

UA-2200/5200/7200 have the same software functions, and the Web UI settings are 

similar. This manual will use UA-5200 as the main demonstration. If the settings are 

different, the manual will explain them separately. 
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2.2.1 Connection by Factory Default Settings (For New UA) 

The factory default settings of the UA series are as the following table:  

Tab. 5) Factory Default Settings of UA Series 

Factory Default Settings of UA Series 

Network 

IP 
LAN1: 192.168.255.1 
LAN2: 10.0.0.1 Assign UA a new IP setting 

according to your case.  
UA-2200 series uses LAN1 to 
connect PC. 

Mask 255.255.0.0 

Gateway 
LAN1: 192.168.1.1 
LAN2: 10.168.1.1 

Web UI 
Account 

Username root After login, change the 
default username/password 
to use other functions.  Password root 

 

[Steps] 

 

1. Change PC’s Network and Internet IP setting to be in the same network with UA.  

Note. Write down the PC’s original IP settings before modifying. And change PC 

settings back after setting UA. 

EX: 

Example: PC’s IP Setting Example 

IP address 192.168.255.10 

Subnet mask 255.255.0.0 

Default gateway 192.168.1.1 

Fig. 16) PC IP Setting Example 

2. Make sure the UA and PC is connecting through Ethernet. And then open a PC side browser 

(Ex: Chrome, IE…). Type UA’s IP http://192.168.255.1 in the URL address. Use default 

Web UI username/password root/root to login the system. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 17) UA default IP Login Web Page 

http://192.168.255.1/
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3. Click 【System Setting】【Account Setting】to change the default Username / 

Password to use other functions (Functions will be gray before changed).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 18) Account Setting 

 

4. Click 【System Setting】【Time Setting】, check if the UA time is correct. If not, modify 

or set Time Synchronization.  

  

Fig. 19) Time Setting 
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5. Click【System Setting】【Network Setting】>【Network Setting(LAN1)】to change 

the IP setting by user network. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 20) Network Setting 

 

6. Save the IP setting, restore the PC original IP settings, and type the new IP in the 

browser to login the Web UI of UA series. Then configure user’s UA project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 21) UA new IP login web page 
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2.2.2 Connection by Utility Searching  

Setting new UA or the new user please uses the method in the Chapter 2.2.1. (A) 

If the UA has a fixed IP and in the same domain as the PC, users can directly enter the IP in 

the address bar of a web browser and log in to the Web UI of the UA. (C) 

 

This section introduces the 2nd method(B) that users use the UA Utility to search the 

Network IP. This method is suitable for connecting multiple UA series controllers to the 

Internet, but the IP addresses of UA are unknown or need to modify the UA quickly. 

 

The Utility is a free tool software to quickly search each UA/BRK/UA-IO series on the network 

and connect to its Web UI for setting UA/BRK/UA-IO series products and project. 

In the PC, download and install the Utility (EZ-UAQ Utility) suitable for your PC, and then run 

it to connect the device. Please download the utility program from the website:  

https://www.icpdas.com/en/download/show.php?num=8560&model=UA   

 
Fig. 22) Download EZ-UAQ Utility 

1. Install and execute the Utility 

Download and unzip the Utility, double-click the executable file (EZ-UAQ Utility.msi) to 

install and execute the Utility software. 

(If there is an old version of Utility on the PC, please uninstall it first.) 

 

 
Fig. 23) Install and execute EZ-UAQ Utility     

https://www.icpdas.com/en/download/show.php?num=8560&model=UA
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2. Search the UA/BRK/UA-IO series modules 

Click the “Search Module” button, the utility will search and list all UA/BRK/UA-IO 

modules in the network. 

  
Fig. 24) Search Module in EZ-UAQ Utility 

3. Connect to the UA Series 

Double click the module list (from the “Module Name” to the “IP address”) you want to 

connect to, and it will directly link to the UA/BRK/UA-IO webpage via the default Web 

browser (Chrome, Edge, IE…). 

 

  

Fig. 25) Connect to the UA Series via EZ-UAQ Utility 

 

1 

2 
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4. Connection to the UA Web UI 

The default web browser will be run and direct go to the UA login web site.  

Please enter the username and password to login the UA series Web UI.  

The factory default username: root. The factory default password: root. After login in, 

change the default Username/password first, or user cannot use any other function (New 

design for data security). 

 

Fig. 26) Go to the UA Login web page via EZ-UAQ Utility 

5. Login the Web UI of the UA Series  

When login into the web interface, the UA default home page (the main configuration 

screen) will as below, and will automatically read setting of that UA to the webpage. 

 

Fig. 27) Login the UA web page via EZ-UAQ Utility  
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3. Quick Start 2: Web UI / Setting Steps 

This chapter introduces the UA Web User Interface (UI), the steps for project / function / list 

settings, and a project example. For more project examples please see Chapter 4. The detail 

parameters of the menus, functions, etc. will introduce in the next chapters Chapter 5. 

 

First, login the UA Web UI as below. (Default username/password: root/root) 

If your UA controller is not connect to the network yet, please refer to Chapter 2.  

 

 

 

 

 

 

 

 

Fig. 28) CH3 The UA Login web page 

After log in the Web UI, users can see the Version & Device Information, including the version 

of the install Firmware program, main program, Web Interface, Flash and Battery information.  

 

Fig. 29) Version and Device Information 
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3.1 Web UI Environment Overview 

The function areas of the Web UI:  

This chapter will overview these areas. The following chapters will introduce the settings of 

the functions and parameters.  

 

1. Function Wizard: A quick setup area for commonly used projects or functions. The Web 

UI will enable a Wizard mode and show a “Step Box”. The user just 

follows the “Step Box” step-by-step and then can complete the project 

quickly and rightly. (Refer to Chapter 4) 

 

2. Main Menu Area: The main menu contains all the setting functions that classified into 

several categories. Click the main menu item, the sub-menu will 

appear on the left of the page, and the function descriptions will 

appear under the main menu area. (Refer to Chapter 5) 

 

3. Sub-Menu Area: The sub-menu will display detailed functions under the selected main 

menu. The user could setup or review detailed function options in the 

setting area. (Refer to Chapter 5 ) 

 

4. Setting Area:  The setting area is for displaying and setting the functions and 

parameters of UA series controller. The content of this area will be 

vary according to the selected main menu and sub-menu.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 30) Function Area of the UA UI 

1 

2 

3 4 
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3.2 Setting Steps for Project / List 

 【Project Setting Steps】: 

The setting for UA series controller is to set up from the left to the right of the main menu 

functions. The “Function Wizard” even provides the “Step Box” for users to follow the steps 

and prevent from selecting the wrong function.  

 

The Web UI screen of UA Series is as following; User can set up own UA project. 

If user has not login your UA Web UI, refer to CH2 Quick Start 1. 

 

CH4 [Function Wizard]: In the upper right corner of the web UI, to guide users quickly set 

up a project. It provides many quick setting option items. With the step-by-step guide of the 

function wizard, the project can be completed quickly. Please see Chapter 4. 

 

CH5 [Main Menu]: The user can also select the function of the main menu to set projects by 

himself. For the detailed function and parameter descriptions, please refer to Chapter 5.  

 

 
Fig. 31) Web interface functions and chapters 

CH4 

CH5 
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For Example: the setting steps of the Modbus communication conversion with the OPC UA 

protocol are as below: 

 

Steps for setting the Project: 

Controller Setting > Module Setting > Connecting OPC UA (in IoT Platform) > Conversion > 

File Setting > Execution 

 

Main Menu:  

 

 

Function Wizard Step Box: (EX. Modbus RTU <=> OPC UA) 

 

Fig. 32) Project Steps / Main Menu / Function Wizard Step Box 

Click the Function Wizard and select the “(Master) Modbus RTU <=> OPC UA” item. 

 

 
Fig. 33) Function Wizard Items 

The Web UI will enable a Wizard guide and show a “Step Box” (as below picture). The user 

just needs to follow the “Step Box” step-by-step and then can complete the project quickly and 

correctly. 

 

 
Fig. 34) Sample of the Step Box 
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 【List Setting Steps】: 

 

In the steps of setting up the project, various lists need to be set up, including: modules, 

connections, I/O channels, variables, communication connections, database... etc. About the 

List setting of module, connection…, they have the similar steps as below. 

 

Steps for Setting List:  

1. Select the connection port for the module (or connection…) 

2. Click the icon  to switch the mode(Name/Select The Module) to add a new module: 

Name: give a name, then click the button [ ] to add a list of module, connect… 

or Select The Module: Select an ICP DAS module/list (For Modbus RTU/TCP) 

3. Click the button [Edit] to enter the Content Setting page. Set up the list content.  

4. Click [Save] to back, and then [Save] the list page. 

 

Steps for List: e.g. Modbus RTU Module List.  

 

 

Fig. 35) List Setting Steps 

 

The next chapter 4.Function Wizard: Project Quick Setup will provide various examples 

about setting the commonly projects and functions.  

  

1. Select the port 

3. Click Edit to set up content 

4. Click Save 

2. Click . Select an ICP DAS module name 
 
or give a Name, click ‘+’ to add one module or 
other list. 
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3.3 Project Setting – A Quick Setup Example 
 

This example will setup a project for conversion of OPC UA and Modbus RTU (Master) 

communication protocol using the Function Wizard. The devices include a UA-5231M 

controller and an M-7055D module that wired with RS-485 interface to read/write the Modbus 

RTU I/O data and need the convert setting. The wiring is show as the picture below. 

 

 

 

 

 

 

 

Fig. 36) Wiring of the Project example 

Note:【Function Wizard】at the up-right corner of the Web UI is a quick setup area. 

The hardware/network connection methods please see the CH. 2 . 
 

This sample uses the conversion function of the Function Wizard to convert the Modbus RTU 

and OPC UA. First, click the “(Master) Modbus RTU <=> OPC UA” item of the Function 

Wizard. 

 

 
Fig. 37) Function Wizard Example of Modbus RTU  OPC UA 

The Web UI will enable a Wizard guide mode and show a “Step Box” (as below picture). The 

user just needs to follow the “Step Box” step-by-step and then can complete the project quickly 

and correctly. 

 

 

Fig. 38) Step Box example 

 

M-7055D 

DO x 8 

 DI x 8 

(9600, 8, N, 1) 

RS-485 
ttyO2 

UA-5231M 
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After click the【(Master) Modbus RTU <=> OPC UA】, follow the “Step Box” to complete the 

7 steps: (The step with a bold underline means it is the current step.) 

 

Fig. 39) Steps Box of Function Wizard Modbus RTU  OPC UA 

 Step 1. Controller COM Port Setting 

 

Fig. 40) Example Step 1: Controller COM Port Setting 

This step sets up the COM port interface of the UA controller to connect with the module 

and the communication setting. 

 

<This Example>  

The UA uses the ttyO2 port to connect with the M-7055D, so set the Serial Port: ttyO2. 

The M-7055D module default setting is “9600, 8, N, 1”, so set Baud Rate: 9600, others 

need not to change. After setting, click [Save] button to store this page setting. (The 

user also can save the whole project until the step of “Save Project”.) 

 

Note: If user uses other port to link other module, or the module is not in the default 

state, please set this step according to your case. The user can find the M-7055D 

default state in the Module CD or its Product Web Site .  

 

Fig. 41) Example Step 1: Setting Interface 

http://www.icpdas.com/en/product/M-7055D-G
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 Step 2. Module Setting 

 
Fig. 42) Example Step 2: Module Setting 

Click the next step, and enter the Step 2 [Module Setting] of the UI setting. 

This step is for setting the connected modules. The user can set each module a name 

(Default name: Name), click [ ] button to create a new module, and click [Edit] button 
to configure the module content and Modbus mapping table. 
 

<This Example>  

In “Module Setting”, select the Serial Port: ttyO2, and select ICP DAS Module: M-7055D, 
the system will auto setup the ICP DAS module. If not use ICP DAS module, please give a 

name and click the button [ ] to add a Module List.  

 
Fig. 43) Example Step 2: Module Setting 1 

Add a module M-7055D as below, and then click [Edit] button to enter the “Module 

Content Setting” page. 

 

Fig. 44) Example Step 2: Module Setting 2 

3 

2. Click  to switch mode.  
Select ICP DAS Module M-7055D. 

1. Select Port: ttyO2 
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[Module Content Setting] page can set the module and its Modbus mapping table. 

 

If use ICP DAS module, system will auto-setup the module and its Modbus Mapping 

Table. Such as this example, we select the module from “Load ICP DAS Module”, it auto-

shows the M-7055D (DO x 8, DI x 8) module content and Modbus Mapping Table as below. 

 

 

Fig. 45) Example Step 2: Module Setting 3 

 

  



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

59 

If not use ICP DAS Module, please check the module’s user manual to find out the module 

Modbus Address, and refer to the chapter “Module Setting” of the UA manual as below. 

 

Please set up the addresses mapping with the module I/O channels in the [Modbus 

Mapping Table Setting]. The system provides 4 Modbus data models (as below) “01” to 

“04” for mapping to the DO, DI, AO and AI channels. 

Note: the start address of UA series is bass on “0”. 

Some modules start address are bass on “1”, but 

please note UA is follow the rule of start address “0”, 

and set enough Data Number for mapping to the 

I/O channels of the linking module.  

Fig. 46) Example Step 2: Module Setting 4 

In this example, M-7055D has 8 DO and 8 DI channels, please create the table as following 

pictures of the [Modbus Mapping Table Setting]. After complete the setting, the DO and 

DI Modbus address settings will show in the [Modbus Mapping Table]. 

 

M-7055D 8 DO setting (left) and the [Coil Status(0x)] table after setting (right):  

   

M-7055D 8 DI setting (left) and the [Input Status(1x)] table after setting (right):  

   

Fig. 47) Example Step 2: Module Setting 5 

The Modbus Mapping table is showing as below. Click [OK] to save and exit. 

 

For more setting item 
descriptions, please refer to 
chapter Chapter 5.2. Module 
Setting.  

 

 

Fig. 48) Example Step 2: Module Setting 6 

DO mapping 01 

DO x 8 

Click [Add] 

DI mapping 02 

DI x 8 

Click [Add] 
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 Step 3. OPC UA Connection 

 
Fig. 49) Example Step 3: OPC UA Connection 

Click the next step, and enter the Step 3 [OPC UA Connection] of the UI setting 

 

This step is for setting the IoT platform and the OPC UA connection, e.g. the server 

name, port, login identity information, etc. 

 

We select the “Modbus RTU / OPC UA” conversion at the beginning, so this step will auto 

enter the [OPC UA Connection > Local Server] page of IoT Platform Setting. The “Step 

Box” will prevent the user from selecting the wrong platform. 

 

<This Example>  

The server name and port of [OPC UA Connection] will auto show up, user needs not to 

change in this example, but can change the port if needs. 

The Anonymous Login default enables, you need not to change in this example. At last, 

click [Save] button.  

   
Fig. 50) Example Step 3: Local Server Setting 

 

For enabling other logins, please see the [OPC UA Connection] in the Chapter 5.3 IoT 

Platform Setting . 

 



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

61 

 Step 4. OPC UA Certificate 

 
Fig. 51) Example Step 4: OPC UA Certificate 

Click the next step, and enter the Step 3 [OPC UA Certificate] of the UI setting. 

This step is about setting the OPC UA Certificate for the security and encryption, e.g. 

upload, download, remove certificate. If user's project does not need to use the secure 

encryption connection, please skip this step and click the next step directly. 

The connected Server/Client adds the certificate to each other for secure encryption: 

 Get the Trusted Certificate file from the connecting OPC UA Client and save it in the 

PC. In this step, select the file and upload it to the UA controller. 

 Provide the OPC UA Server certificate of this UA controller to the Client device. In 

this step, download the certificate file (Certicate_IPAddress_.tar), decompress it 

(icpdasuaserver.der) and upload it to the client device. 

 
Fig. 52) Example Step 4: OPC UA Server 

Tab. 6) CH3 Function: File Setting > OPC UA Certificate 

File Setting > OPC UA Certificate > Upload the file to the controller 

Trusted 

Certificate 

Select File: select the OPC UA Trusted Certificate file in PC to upload to 

the UA controller. 

Upload: upload the Trusted Certificate file to the UA controller. 

 File format must be DER. Extension name must be “der / cer / crt”.  

   
 If select a wrong file, the system will show an error message. 

 
File Setting > OPC UA Certificate > Download the file from controller 

OPC UA 

Server 

Certificate 

Download: Download the OPC UA Server Certificate file to the current 

using computer. 

 File format: DER.  File name: Certicate_IP-address_.tar  

e.g. .  
Before using, decompress to icpdasuaserver.der, as below. 

 
For more settings, refer to the [5.8.3 OPC UA Certificate] in the Chapter 5.8 File Setting .  

1 

2 
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 Step 5. Enable Converting Module 

 
Fig. 53) Example Step 5: Enable Converting Module 

Click the next step, and enter the Step 5 [Enable Converting Module] UI setting 

 

This step is for enabling the Modbus RTU / OPC UA conversion. 

 

This step will auto enter the [OPC UA > Modbus RTU (Master)] page of Conversion 

setting because we select the “Modbus RTU / OPC UA” conversion at the beginning. The 

“Step Box” will prevent the user from selecting the wrong platform. 

 

<This Example>  

In this setting page, please check the enable box of the module M-7055D we set up in 

the previous steps. Then click [Save] button. 

 

The above action will enable all I/O channels of the M-7055D for communication 

conversion. If users need to enable some channels only, please click [Edit] to enable 

individual channels. (Refer to Chapter 5.4) 

 

  
Fig. 54) Example Step 5: Module List Steps 

 
 

  

1. Check the box 

2. Save 
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 Step 6. Save Project 

The setting of this example is finished now. Click the next step [Save Project], the Step 

Box will show an animation as below picture, that means the project is saving. When the 

animation disappears, the project is saved completely. 

 

                  
Fig. 55) Example Step 6: Save Project 

 

 Step 7. Run the Project 

The project, after saving, needs to be executed. Click the next step [Run the Project]. 

This step can also via the [System Setting > Controller Service Setting > Run Project] 

to Stop and Run the project. 

 

            
Fig. 56) Example Step 7: Run the Project 

 

When the words “Please wait” disappears, the new words “Success” appears, that means 

the UA controller is running new project successfully. Then the Step Box will disappear 

automatically now, and back to the first screen view of the Web UI.  

 

The new project now completes the setting, uploading and running in the UA controller and 

can process the conversion communication. Users can see the I/O status from the menu 

[I/O Status]. For more about the Web UI settings, please refer to CH4 and CH5. 

 

 

Fig. 57) Example Step finish an view the status 
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4. Function Wizard: Project Quick Setup 

Chapter 4 is about the UA project setup. [Function Wizard] in the up-right corner of the Web 

UI provides an easy and quick setting “Step Box” that very suitable for the new users. 

 

[Function Wizard Step Box]  

(abbreviation [Step Box])  

 

 
Step Box is a step guide of the Function 

Wizard. When users select an item, the Web 

UI will enable a Wizard and show a “Step Box” 

for user to follow the “Step Box” step-by-step 

and then can complete the project easily & 

quickly. 

 

This chapter introduce the Function Wizard 

category and items, the examples for setting 

steps of the projects/functions are on the FAQ 

Webpage. The are several categories (in red 

box, they also are the FAQ Category) and 

items in each section. We will develop more 

items in the future. 

 

When set up the project, please choose an 

item from a category and follow the steps. 

Please at least refer one example in this 

chapter to know the setting steps and tips. 

 

All setting examples of most used Function 

Wizard items are put on the UA series FAQ 

website. Please refer to ICP DAS homepage 

> Support > Product FAQ > IIoT > UA series 

>Communication Server > UA FAQ – 

Function Wizard. 

Fig. 58) CH4 function Wizard: Step Box / function Items    
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Example FAQ of Function Wizard as following:  

1. Enter ICP DAS Homepage > SUPPORT > Production FAQ web page  

2. On the left side menu, click the IIoT of the Product FAQ 

3. Select UA Series > Communication Server 

4. Select the “+” icon on the right side of the UA FAQ-Function Wizard, find the 

Category and Item you want. 

5. Click the “Use Module Name” of the FAQ you need to see the example. 

 
UA FAQ Web Page: https://www.icpdas.com/en/faq/index.php?kind=326#950  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 59) UA FAQ Web Page 

  

1 

2 

3 

4 

5 

https://www.icpdas.com/en/faq/index.php?kind=326#950


UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

66 

4.1 [Module Communication Conversion] Category 

“Module Communication Conversion” of UA series, a very commonly used function, can 

effectively communicate the IoT devices or systems (e.g. cloud, database…) with I/O data of 

the module (e.g. Modbus module). This section will introduce the setting steps and the function 

parameters of the “Module Communication Conversion”. In the category, there are several 

items that can be divided into the following protocol types and will introduce them in the FAQ: 

OPC UA, MQTT, MQTT JSON, and Internal for virtual.  

 

 
Fig. 60) Module Communication Conversion Function 

Tab. 7) CH4 Descriptions: Module Communication Conversion Items 

Item Description 

Modbus RTU <=> OPC UA 

Modbus TCP <=> OPC UA 

Modbus ASCII <=> OPC UA 

Using the OPC UA Service to convert with Modbus 

RTU/TCP/ ASCII protocols. 

MQTT <=> OPC UA  
Using the OPC UA Service to convert with EtherNet/IP 

protocols. 

EIP <=> OPC UA  
Using the OPC UA Service to convert with EtherNet/IP 

protocols. 

Modbus RTU <=> MQTT  

Modbus TCP <=> MQTT 

Modbus ASCII <=> MQTT 

Using the MQTT Service to convert with Modbus 

RTU/TCP/ ASCII protocols. 

EIP <=> MQTT 
Using the MQTT Service function to convert with 

EtherNet/IP protocols. 

Modbus RTU <=> MQTT JSON  

Modbus TCP <=> MQTT JSON 

Modbus ASCII <=> MQTT JSON 

Using the MQTT Service function in-group of JSON 

format to convert with Modbus RTU/TCP/ ASCII 

protocols. 

Internal <=> OPC UA 

Using the OPC UA Service function to convert Internal to 

OPC UA (Server) protocol, or as an intermediary to provide 

data exchange for OPC UA Client to Client. 
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UA FAQ Web Page: https://www.icpdas.com/en/faq/index.php?kind=326#950  
Tab. 8) FAQ Table of Module Communication Conversion Items 

No. Function Wizard FAQ - Item PDF 

[ Module Communication Conversion ] 

cnv-01 
Modbus RTU <=> OPC UA   

Modbus ASCII <=> OPC UA 

Use M-7055D 

(With instructions for verifying OPC UA) 

cnv-02 MQTT <=> OPC UA Use MQ-7255M 

cnv-03 (EtherNet/IP) EIP <=> OPC UA Use EIP-2060  

cnv-04 Modbus TCP <=> MQTT Use DL-302  

cnv-05 (EtherNet/IP) EIP <=> MQTT Use EIP-2060  

cnv-06 
Modbus RTU <=> MQTT JSON  

Modbus ASCII <=> MQTT JSON 
Use M-7055D  

Cnv-07 Internal <=> OPC UA 
Data Exchange for OPC UA Client to 

Client 

Cnv-08 
Modbus / EIP <=> MQTT / MQTT JSON 

==> AWS 
Use MQTT to upload data to AWS 

 
 
 

  

https://www.icpdas.com/en/faq/index.php?kind=326#950
https://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-01.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-02.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-03.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-04.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-05.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-06.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-07.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-07.pdf
https://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-cnv-08.pdf
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4.2 [Module Connecting to Azure] Category 

"Module Connecting to Azure" is a common way to integrate IoT devices into the cloud. Many 

of the applications use MQTT connection to the cloud for the setting is fast and easy. The UA 

series also provides the MQTT function for module to connect to the Azure platform and allows 

users to publish messages to Microsoft Azure and receive messages from Microsoft Azure. 

 

Before setting the Azure connection, user needs to apply user SAS Token and Root CA from 

Microsoft Azure. This FAQ will introduce the setting steps and the function parameters. There 

are 3 items about Azure function in the “Function Wizard”. All connections use the MQTT 

Service. Here will introduce the Modbus TCP / Azure. 

 

   
 

 
Fig. 61) Module Connection to Azure function 
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Tab. 9) Function List of Module connection to Azure 

Item Description 

Modbus RTU <=> Azure 

Allow the Modbus RTU connecting to the Microsoft Azure 

platform and can publish messages to Microsoft Azure and 

receive messages from Microsoft Azure. 

Modbus TCP <=> Azure 

Allow the Modbus RTU connecting to the Microsoft Azure 

platform and can publish messages to Microsoft Azure and 

receive messages from Microsoft Azure.  

Modbus ASCII <=> Azure 

Allow the Modbus RTU connecting to the Microsoft Azure 

platform and can publish messages to Microsoft Azure and 

receive messages from Microsoft Azure. 
 

  

 
UA FAQ Web Page: https://www.icpdas.com/en/faq/index.php?kind=326#950  
Tab. 10) FAQ Table of Module connection to Azure 

No. Function Wizard FAQ - Item PDF 

[ Module Connecting to Azure ] 

azr-01 Modbus TCP <=> Azure Use DL-302   [Attachment] 

 

 

  

https://www.icpdas.com/en/faq/index.php?kind=326#950
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-azr-01.pdf
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4.3 [Data Log] Category 

UA series supports Data Logger function. Its Local Data Logger can save l/O data log to local 

CSV file, and record I/O status at the scheduled time. Furthermore, users can set the time 

interval of which CSV file to generate and divide on the local side. Its Remote Database can 

import I/O data collection directly into the remote SQL database, e.g. MS SQL, MySQL, 

MariaDB …, for the Big Data analysis.  

 

 
Fig. 62) Data Log Application 

 

This section will introduce the setting steps and the function parameters of the “Data Log”. In 

the category, there are 6 items about Modbus RTU/TCP module for Local Data Logger or MS 

SQL, MySQL/MariaDB… Remote Database. This section will introduce the function items in 3 

sub-sections.  

  
Fig. 63) Data Log Function 

Tab. 11) Data Log Function Items 

Item Description 

Modbus RTU => Local Data Logger 

Modbus TCP => Local Data Logger 

Provide users to record I/O data of Modbus 

RTU/TCP module to internal register.  

Modbus RTU => MS SQL 

Modbus TCP => MS SQL 

MQTT => MS SQL 

Provide users to record I/O data of Modbus 

RTU/TCP module into remote database MS SQL. 
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Item Description 

Modbus RTU => MySQL(MariaDB) 

Modbus TCP => MySQL(MariaDB) 

MQTT => MySQL(MariaDB) 

Provide users to record I/O data of Modbus 

RTU/TCP module into MySQL/MariaDB remote 

database. 

 

 
UA FAQ Web Page: https://www.icpdas.com/en/faq/index.php?kind=326#950  
Tab. 12) FAQ Table of Data Log Function 

No. Function Wizard FAQ - Item PDF 

[ Data Log ] 

dbl-01 Modbus RTU => Local Data Logger Use tM-AD4P2C2 and DL-302  

dbl-02 Modbus TCP => Local Data Logger Use DL-302  

dbl-03 Modbus RTU => MS SQL Use tM-AD4P2C2 and DL-302  

dbl-04 Modbus TCP => MS SQL Use DL-302  

dbl-05 Modbus RTU => MySQL(MariaDB) Use M-7026  

dbl-06 Modbus TCP => MySQL(MariaDB) Use TPD-703 and DL-302  

dbl-07 MQTT => MS SQL Use MQ-7255M 

dbl-08 MQTT => MySQL(MariaDB) Use MQ-7255M 

 

 

  

https://www.icpdas.com/en/faq/index.php?kind=326#950
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-01.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-02.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-03.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-04.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-05.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-06.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-07.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-dbl-08.pdf
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4.4 [PID] Category 

PID (Proportional-Integral-Derivative) control is the most widely used in industrial control 

systems. A regulator that controlled in accordance with Proportional, Integral and Derivative is 

called PID control for short, also called PID regulator. When the user cannot fully grasp or 

measure parameters of the control system, the PID regulator is the best solution. 

 

The PID controller is a common feedback loop component in industrial control applications. 

The controller compares the collected data with a reference value and then uses this difference 

to calculate a new input value whose purpose is to allow the system data to reach or remain at 

the reference value. 

 

Fig. 64) PID Application 

This section introduces the setting steps and the function parameters of the PID. There are 2 

items about “PID” function in the “Function Wizard”. The 2nd item [PID Operation + OPC UA 

Communication Conversion] is combining the 1st item [PID Operation] and the FAQ. The PID 

operation is for AI/AO data only, please select the AIO module when use the PID related 

Function Wizard. 

 
 

[Step Box] of [PID Operation] : 

 
 
 
[Step Box] of [PID Operation + OPC UA Conversion] :  
 

 
Fig. 65) PID Step Box 
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UA FAQ Web Page: https://www.icpdas.com/en/faq/index.php?kind=326#950  

 
Tab. 13) FAQ Table of PID Function 

No. Function Wizard FAQ - Item PDF 

[ PID ] 

pid-01 PID Operation Use M-7026  

 

 

 

 

  

https://www.icpdas.com/en/faq/index.php?kind=326#950
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-pid-01.pdf


UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

74 

4.5 [APP Message Notify] Category 

 

The "APP Message Notify" in the UA Function Wizard provides a condition trigger of IFTTT.  

IFTTT (if this then that) is a cloud service platform that easy to get your apps and devices 

working together via creating chains of simple conditional statements (applets). An applet is 

triggered by changes that occur within other web services such as Line, Twitter, Gmail, 

Instagram, etc. For example, “if” Line (Service A) has a new message, “then” send an email to 

Gmail (Service B). With the IFTTT cloud platform and UA functions, the users can send 

messages to IFTTT-related cloud services such as Line, Twitter, etc. when the special events 

occur. 

   

Fig. 66) APP Message Notify – IFTTT Condition Trigger 
 

This section introduces the setting steps and the function parameters of the “APP Message 

Notify” and its item of “IFTTT Condition Trigger (Line, Face, Twitter)” function in the “Function 

Wizard”.  

 

 
 

[Step Box] of [ IFTTT Condition Trigger (Line, Twitter) ] : 

 
Fig. 67) APP Message Notify – IFTTT Condition Trigger Step Box 

 

UA FAQ Web Page: https://www.icpdas.com/en/faq/index.php?kind=326#950  
Tab. 14) FAQ Table of APP Message Notify 

No. Function Wizard FAQ - Item PDF 

[ APP Message Notify ] 

app-01 IFTTT Condition Trigger (Line, Twitter) Use M-7055D  

app-02 IFTTT Condition Trigger (Line, Twitter) Set up LINE Message Notify on IFTTT 

 

  

https://www.icpdas.com/en/faq/index.php?kind=326#950
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
https://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-02.pdf
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4.6 [MQTT_Customized] Category 

 

The " MQTT_Customized " in the UA Function Wizard provides a custom MQTT format setting 

function. Users can customize the MQTT format layout and add the module value to the 

publishing message. With customized MQTT message content, this function can support 

multiple IoT platforms. 

 

For example, to connect to the Azure platform, the user can use the standard MQTT JSON 

format; to connect to the AWS platform, the user can use the general standard MQTT format; 

to connect to the ThingSpeak platform, the user needs to customize the MQTT format 

according to the user needs. Then, the user can use this [MQTT customization] function to 

define and set up the needed MQTT format. 

 

This section introduces the setting steps and the function parameters of the “MQTT 

_Customized” and its item of “MQTT IoT Cloud” function in the “Function Wizard”.  

 

 
 

[Step Box] of [ MQTT IoT Cloud ] : 

  
Fig. 68) MQTT Customized Function Step Box 

 

UA FAQ Web Page: https://www.icpdas.com/en/faq/index.php?kind=326#950  
Tab. 15) FAQ Table of MQTT Customized function 

No. Function Wizard FAQ - Item PDF 

[ APP Message Notify ] 

Mqc-01 MQTT IoT Cloud => ThingSpeak 

Use MQTT Customized function to link 

and upload Modbus TCP/RTU data to 

ThingSpeak 

 

  

https://www.icpdas.com/en/faq/index.php?kind=326#950
https://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-mqc-01.pdf
https://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-mqc-01.pdf
https://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-mqc-01.pdf
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5 Main Menu: Parameter Settings 

5.1 Main Menu: System Setting 

System Setting is the first item of the Main Menu and the first screen view when login the UA 

Web UI. The System Setting provides the functions for system management of UA series 

controller and displays the version information of the system (Higher-left picture). 

 

[System Setting] includes several sub-menu functions (Left picture) and the function 

descriptions are listed on the page of the Main Menu, such as the controller service, time, 

network, account, boot and COM port interface settings. This chapter will introduce these 

function items and setting parameters. 

 

  
Fig. 69) CH5.1 Main menu: System Setting 

 

The setting for UA series controllers is to set up from the left to the right of the main menu 

functions. User can find the setting step and Web UI information in the following chapters. 

   CH2 Quick Start 1: Hardware/Network Connection  

   CH3 Quick Start 2: Web UI / Setting Steps   

   CH4 Function Wizard: Project Quick Setup  
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5.1.1 Controller Service Setting 

Controller Service Setting provides the function to display and set the running status of the 

controller service about the project, MQTT Broker and DDNS. 

 

 
Fig. 70) System Setting > Controller Service Setting 

Tab. 16) Descriptions: System Setting > Controller Service Setting 

System Setting > Controller Service Setting > Functional status 

Run Project Display the current status of project running in the UA series controller 

and provide “Run” and “Stop” button to switch the status.  

Default: Run. 

MQTT Broker Display the current status of MQTT Broker of the UA series controller 

and provide “Run” and “Stop” button to switch the status.  

Default: Run. 

DDNS Display the current status of DDNS Client of the UA series controller 

and provide “Run” and “Stop” button to switch the status.  

Default: Stop. 

System Log After being enabled, UA will record the following UA status data every 

30 minutes: 

1. Record IP information 

2. TCP connection status 

3. Web service status 

4. CPU usage 

5. MQTT Broker test connection status 

The recorded log data will be stored in MicroSD Card, and the file can 

be downloaded through the web interface [File Setting] > [Log File 

Download] > [DataLog] > [syslog] 
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5.1.2 Time Setting 

Time Setting provides the function to display and set the date, time and time zone of the 

controller, including manually, synchronization, etc. 

Time Setting provides 3 functions: Data and Time Display, NTP Time Synchronization Setting 

and Set the Time Manually. 

 
Fig. 71) System Setting > Time Setting > Date and Time 

Tab. 17) Descriptions: System Setting > Time Setting > Date and Time 

System Setting > Time Setting > Date And Time Display 

Date Display the date of the UA series controller. The yellow block means 

current day. User can switch to show the date in other month. 

Time Display the current time of the UA series controller, including hour, 

minute and second. 

 

 
Fig. 72) System Setting > Time Setting > NTP Time Synchronization 

Tab. 18) Descriptions: System Setting > Time Setting > NTP Time Synchronization 

System Setting > Time Setting > NTP Time Synchronization Setting 

Functional 

Status / NTP 

Time Server 

Set up one NTP Time Server from the google (4), windows and nist 

(4) servers for synchronization. Click “Customize The Server” and 

enter the IP address or the domain name can set up user own time 

server.  

Time Zone Set up the time zone. 

Save Click to save the settings of this item. 
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Fig. 73) System Setting > Time Setting > Set the Time Manually 

Tab. 19) Descriptions: System Setting > Time Setting > Set the Time Manually 

System Setting > Time Setting > Set The Time Manually  

Time Setting Set the system time of the UA controller by manually. Directly 

enter the new year/month/date and hour:minute:second. 

Read The Local 

Computer Time 

Click [Read] can copy the current time of the using computer to 

the “Time Setting” of this item. 

Time Zone Set up the time zone. 

Save Click to save the settings of this item and update the data of 

“Time Setting” to the “Date And Time Display” on the top of this 

page. 
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5.1.3 Network Setting 

Network Setting provides the function to display and set the network settings, including IP 
address, host controller, DDNS, etc. 
 
NOTE:  

1. UA-5200/7200 series has 1 LAN (LAN1);  

UA-2200 series has 2 LANs (LAN1 / LAN2). 

2. UA-2200 series supports static IP only, so it needs to specify an IP address for 

each LAN1 and LAN2. 

3. The IPs of LAN1 and LAN2 of UA-2200 series must be set in different subnets.  

Ex: Set one IP to 192.168.84.80, and set the other IP to other subnets, e.g. 10.1.1.2. 

4. Reminder for UA-2200 series using mobile network: 

A. When there is a mobile network: LAN1 and LAN2 cannot set gateway parameters. 

B. When there is no mobile network: Only one of the LAN1 or LAN2 can set the 

gateway parameters. 

 

 
Fig. 74) System Setting > Network Setting > LAN 
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Tab. 20) Descriptions: System Setting > Network Setting > LAN  

System Setting > Network Setting > Network Setting (LAN1) 

Connection 

Mode 

Specify an IP address: Users input the values in the fields of IP, 

Mask and Gateway according to customer's network. Detail 

information for the factory default value of UA controller network 

refers to the Section 2.2.1.  

IP The LAN1 IP address of this UA.  

Factory Default: 192.168.255.1  

Mask The LAN1 mask address of this UA.  

Factory Default: 255.255.0.0 

Gateway The LAN1 gateway address of this UA.  

Factory Default: 192.168.1.1 

Save Click to save the settings of LAN1 item. 

System Setting > Network Setting > Network Setting (LAN2) 

Connection 

Mode 

Specify an IP address: Users input the values in the fields of IP, 

Mask and Gateway according to customer's network. Detail 

information for the factory default value of UA controller network 

refers to the Section 2.2.1.  

IP The LAN2 IP address of this UA.  

Factory Default: 10.0.0.1  

Mask The LAN2 mask address of this UA.  

Factory Default: 255.255.0.0 

Gateway The LAN2 gateway address of this UA.  

Factory Default: 10.168.1.1 

Save Click to save the settings of LAN2 item. 
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Fig. 75) System Setting > Network Setting > IPv6 

 
Tab. 21) Descriptions: System Setting > Network Setting > IPv6 

System Setting > Network Setting > IPv6 

LAN1 IPV6 address of this controller LAN1 or LAN2. 

Connection 

Mode 

Set the IPV6 address and specify the IP, prefix length, and gateway 

fields below to manually input. 

or automatically generated by DHCP 

IP IPV6 address of this controller LAN1 or LAN2 

Prefix length IPV6 subnet prefix length of the controller LAN1 or LAN2 

Gateway IPV6 gateway address of the controller LAN1 or LAN2 

Save Click to save the settings of this item. 
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Fig. 76) System Setting > Network Setting > Hostname 

Tab. 22) Descriptions: System Setting > Network Setting > Hostname 

System Setting > Network Setting > Hostname Setting 

Hostname The host name of this UA. Default: system value. User can give a 

new name, but cannot be null.  

Save Click to save the settings of this item. 

 

 
Fig. 77) System Setting > Network Setting > DDNS 

Tab. 23) Descriptions: System Setting > Network Setting > DDNS 

System Setting > Network Setting > Dynamic DNS Setting 

Service 

Provider 

Select the company of the DDNS service. Default: NO-IP. 

Supports: NO-IP, ChangeIP.com, DynDNS, FreeDNS.  

*Username Set up the login user name. The star * means the field cannot be null. 

Default: undefined. 

*Password Set up the login password. The star * means the field cannot be null. 

*Domain 

Name 

Define the parked domain name of the DDNS. 

The star * means the field cannot be null. Default: undefined. 

Save Click to save the settings of this item. 

 

* The star “ * ” means the field cannot be null. 
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 ** Network Setting (Mobile Network): 

 
Fig. 78) System Setting > Network Setting > DDNS 

Reminder for UA-2200 series using mobile network: 

A. When there is a mobile network: LAN1 and LAN2 cannot set gateway parameters. 

B. When there is no mobile network: Only one of the LAN1 or LAN2 can set the 

gateway parameters. 

Setting Steps & Notice:  

1. This “Mobile Network” setting items appears only on the mobile model of UA controller (-

4GE/4GC/3GWA). 

Insert the SIM card into the SIM card socket of UA, and then power on or restart the 

UA. Login the web UI again. When the “SIM Card Status” item appears “Working”, the 

network connection is successful. Users can check the 3G/4G LED Status of UA Series to 

know the module status.  

 
 

Tab. 24) Descriptions: System Setting > Network Setting > 3G/4G LED Status 

LED LED Status Module Status 

4G 

Green Light Flash: 

ON for 2 seconds, OFF for 1 sec, 

and flashing alternately. 

The modem is functioning normally, and the 

SIM card inside. 

Green Light Flash: 

ON for 1 second, OFF for 2 secs, 

flashing alternately, or OFF . 

The modem is not functioning, no SIM card 

inside, or the PIN is still locked. 

Green Light Flash: Quickly Data is transmitting.  

3G 

Green: ON 
The modem is functioning normally, and the 

SIM card inside. 

OFF 
The modem is not functioning, no SIM card 

inside, or the PIN is still locked. 

 
2. Enter the PIN number to unlock the SIM card: 
 

 

* The SIM card of a telecom company is usually locked and protected by a PIN number. 

Please unlock the PIN before setting the Mobile Network function. 

* The PIN access will be locked out after three fault attempts. The user needs to 

contact the telecom company of the SIM card to unlock it before proceeding. 

3. Set up the network settings (see next page), check the "Enable" items, and click the "Save 

and Connect" button. When the "Connection Status" becomes "Connected", the connection 

is successful. 
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4. When the mobile network is enabled, the mobile network will serve as the main route to the 

external network. 

 
Fig. 79) System Setting > Network Setting > Mobile 

Tab. 25) Descriptions: System Setting > Network Setting > Mobile  

System Setting > Network Setting > Network Setting(Mobile Network) 

Signal Display the strength level of the Mobile Network Signal.  

Signal strength range:  

(The strongest signal) -51 ~ -113 (No signal) 

Connection 

Status 

Display the connection status:  

Connected or Disconnected. 

IP  Display the IP address that UA occupies through Mobile Network. 

Automatic 

Connection 

When Power On 

If check the “Enable” box, it will enable the UA controller to complete 

the Mobile Network connection automatically when power on UA 

controller. 

Dial-up Number Default: *99#. User can change it by the proprietary number 

provided by the Telecommunication Service Company. 

APN Please refer to “this document” provided on the UA Web HMI page 

to configure the setting.  

Authentication Please refer to “this document” provided on the UA Web HMI page 

to configure the setting. 

Mobile Code It is an optional setting. It depends on the service of the 

Telecommunication Company provides. Refer to “this document”. 

Disconnect Click button can disconnect the Mobile Network connection. 

Save and 

Connection 

Click button to save the setting and start to connect the Mobile 

Network. 

http://192.168.1.248/Document/gprs_apn.pdf
http://192.168.1.248/Document/gprs_apn.pdf
http://192.168.1.248/Document/gprs_apn.pdf
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5.1.4 Account Setting 

Account Setting provides the function to set the login username and password of the UA web 

UI. 

 

 
Fig. 80) System Setting > Account Setting  

Tab. 26) Descriptions: System Setting > Account Setting  

System Setting > Account Setting > Account Settings Page 

Username The login username for the UA Web UI. Factory default: root 

Password The login password for the UA Web UI. Factory default: root 

 

A strong password checking mechanism is added to the password 

setting. The new password must meet the following conditions: 

 Be at least 8 characters’ long 

 Contains at least one lowercase letter 

 Contains at least one uppercase letter 

 contains at least one number 

 Contains at least one symbol (! @ # $ % ^ & * ( ) , . ? " : { } | < 

> \\ / ; = - [ ] ~ +) 

Retype Password Retype the password for the operation conform when setting the 

new account information. 

Save Click to save the settings of this page. 

 

After first login, change your password as soon as possible for your system safety. 

 

Steps to change the username and password: 

1. Type the new username in the “Username” item. 

2. Type the new password in the “Password” item. 

3. Retype the new password in the “Retype Password” item. 

4. Click the “Save”. Then re-login the UA Web UI with the new username and password. 
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Tab. 27) Descriptions: Factory Default Settings of UA Series 

 

Factory Default Settings of UA Series 

Network 

IP (LAN1) 
IP (LAN2) 

192.168.255.1 
10.0.0.1 Assign UA a new IP 

address according to your 
case.  
For UA-2200 series, set 
the LAN1 for the 
connection. 

Mask 255.255.0.0 

Gateway 
LAN1: 192.168.1.1 
LAN2: 10.168.1.1 

Web UI 
Account 

Username root After login, change your 
password as soon as 
possible.  
(Section 5.1.4 for Web UI) Password root 
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5.1.5 Boot 

Boot function provides the function to reboot the UA series controller, and enable the function 

to run the project, MQTT broker or DDNS at startup. 

 

Fig. 81) System Setting > Boot Setting  
Tab. 28) Descriptions: System Setting > Boot Setting  

System Setting > Boot > Restart 

Restart the controller Click “Reboot” can restart the UA controller at once. 

System Setting > Boot > Run at startup 

Project Check the “Run at startup” box can set the project to run at the 

UA controller startup. Default: check. 

MQTT Broker Check the “Run at startup” box can set the MQTT Broker to 

run at the UA controller startup. Default: check. 

DDNS Check the “Run at startup” box can set the DDNS to run at the 

UA controller startup. Default: uncheck. 

System Log After being enabled, UA will record the following UA status 

data every 30 minutes: 

1. Record IP information 

2. TCP connection status 

3. Web service status 

4. CPU usage 

5. MQTT Broker test connection status 

The recorded log data will be stored in MicroSD, and the file 

can be downloaded through the web interface [File Settings] > 

[Log File Download] > [DataLog] > [syslog] 

Save Click to save the settings of this page. 
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5.1.6 COM Port Interface Setting 

COM Port Interface Setting allows display and set the COM port interface of the UA series 

controller for the RS-232/RS-485 serial communication. 

 

  
Fig. 82) System Setting > COM Port Interface Setting  

Tab. 29) Descriptions: System Setting > COM Port Interface Setting  

System Setting > COM Port Interface Setting > COM Port Interface Setting Page 

Serial Port Choose the serial port of UA controller that links with the I/O module.  

UA-2200/5200: ttyO2 (RS-485); ttyO4 (RS-232); ttyO5 (RS-485) 
  Default: ttyO2. Select the port that the module is actually connected to. 

UA-7200: COM1 (RS-232/485) 

Baud Rate 

 

Choose a baud rate to communicate with the module: 1200, 2400, 4800, 

9600, 19200, 38400, 57600 and 115200. The UA controller and the I/O 

module need have the same baud rate. Default: 115200. 

Data Bits The number of bits used to represent one byte of data: 7 bits or 8 bits. 

Default: 8 Bits. 

Parity Choose one way for the parity checking.  

Options: None, Even, and Odd. Default: None. 

Stop Bits Choose the number of stop bit: 1 bit or 2 bits. Default: 1. 

Silent 

Interval (ms)  

Set a time interval for the command.  

Minimum: 20 ms. Default: 500 ms 

Save Click to save the settings of this page. 
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5.1.7 Web and Secure 

This function is to set the security options and related parameter descriptions of the web page. 

 

 

Fig. 83) System Setting > Web and Secure > Web Server 
Tab. 30) Descriptions: System Setting > Web and Secure > Web Server 

System Setting > Web and Secure – Web Sever 

HTTP Check box to enable web HTTP communication (Default: Enable)  

HTTPS Check box to enable web HTTPS communication (Default: Disable) 

When enabled, use the UA dedicated port number 8443 and upload the 

certificate and private key files. 

Certificate Certificate required for HTTPS communication. The user can select the 

certificate file on the browser side by clicking the “Select File” button. 

Then upload by clicking the “Upload” button. 

Private Key Private key required for HTTPS communication. The user can select the 

Private Key file on the browser side by clicking the “Select File” button. 

Then upload by clicking the “Upload” button. 

 

After uploading the certificate and private key, when using HTTPS to securely encrypt the 

webpage, please enter “https://” in the address bar of the browser, add the IP, add the UA 

HTTPS port number ":8443" after the IP, and then press Enter to enter the webpage, the 

example is as follows: 
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Fig. 84) System Setting > Web and Secure > Firewall 

Click [Edit] to expand the [Whitelist] setting page, as follows: 

 
Or 

 

Fig. 85) System Setting > Web and Secure > Firewall > Whitelist 
Tab. 31) Descriptions: System Setting > Web and Secure > Firewall  

System Setting > Web and Secure – Firewall 

Whitelist Click [Edit] to expand the settings page to allow connected device 

IP or IP range devices 

Add Rule Type There are two types of whitelist rules: single IP address, IP range 

Single IP Address Allows one single device with a specified IP to connect 

IP Range Allow devices within an IP range to connect 

Add Rule After setting a rule, click the [Add Rule] button once and the rules 

will be listed below. 

Action To delete a rule, click the [Delete] button of the rule list 

Submit After setting all the rules, click [Submit] to complete the whitelist 

setting. 

Save Save all settings on this web page. 
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5.1.8 EZ-UAQ Utility 

This function is mainly to set up the password for operating the functions from the EZ-UAQ 

Utility. 

 

 
Fig. 86) System Setting > EZ-UAQ Utility 

Tab. 32) Descriptions: System Setting > EZ-UAQ Utility 

System Setting > EZ-UAQ Utility 

Password set up the password for operating functions from EZ-UAQ Utility. 

Password rules: Allow English and numbers, no special symbols, 

at least 4 characters 

Confirm Password Type the password to confirm the setting password  

 

UA supports the new version of EZ-UAQ Utility functions starting from V1.4.2.0, as follows 

(for details, please refer to the Utility manual) 

 

 Module Details (TCP、UDP、Protocol、Port) 

 Reduce CPU Usage 

 Update Firmware, Update Project 

 Download Modbus and OPC UA Configuration 

 Download Log 

 Download Project 
 

When EZ-UAQ Utility uses the above functions and connects to UA, UA will require password 

verification, and the operation will only be processed if the verification is passed. The user 

sets the EZ-UAQ Utility password here to verify the password sent by the Utility. 
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5.2 Main Menu: Module Setting 

Module Setting is the second item of the Main Menu. The Module Setting provides the 

functions for UA series controller to connect the remote Modbus (RTU/TCP/ASCII module), 

remote MQTT and remote EtherNet/IP module. 

 

[Module Setting] includes three sub-menu functions (see the picture below) and the function 

descriptions are listed on the page of the Main Menu, such as the Modbus RTU Module 

(Master), TCP Module (Master), ASCII Module (Master), MQTT and ICP DAS EIP Module. The 

Module Setting will support more modules in the future. This chapter will introduce the current 

function items and setting parameters. 

 
Fig. 87) CH5.2 Main Menu: Module Setting  

 

The setting for UA series controllers is to set up from the left to the right of the main menu 

functions. User can find the setting step and Web UI information in the following chapters. 

   CH2 Quick Start 1: Hardware/Network Connection  

   CH3 Quick Start 2: Web UI / Setting Steps   

   CH4 Function Wizard: Project Quick Setup  

 
Recommend to use ICP DAS module, system will auto set up the Modbus Mapping Table. 
The user can check the module Modbus address or I/O number from the user manual.  
Website: https://www.icpdas.com/en/product/p02.php?root=537  

 

https://www.icpdas.com/en/product/p02.php?root=537
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5.2.1 Modbus RTU (Master) 

This setting is for UA Controller connecting the remote Modbus RTU Slave module. 

 
Fig. 88) Modbus RTU Module  

This page is for setting the communication values with the connected modules. First choose 

the serial port that connected with the module, and each module can give a name (Default: 

Name). Click [ ] button could add a new module. If using ICP DAS module, user just need 

to select the model number, system will auto add and setup the module. Click [Edit] button 

can configure the module content and the Modbus mapping table. 

 

Setting Steps: 

1. Select the module Serial port 

2. Click the switch icon  to select the adding mode: 

a) Select The Module: Select an ICP DAS model (as the pic), system will auto setup. 

b) Name: Give a name, e.g. M-7055D. Click [ ] to add a module for user setting. 

3. Click the button [Edit] to enter the Module Content Setting page 

View or set the Modbus Mapping Table for the UA series and module I/O channels 

 

Fig. 89) Modbus RTU Module Setting Steps 
The function items and setting parameters of the [Modbus RTU Module List]: 

2. Click switch icon to select an ICP DAS module for auto setting,  
or give a name, click ‘+’ to add a module for user setting. 

1. Select the connecting serial port 

3. Click to set the module content 
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Fig. 90) Module Setting > Modbus RTU > Module List 

Tab. 33) Descriptions: Module Setting > Modbus RTU > Module List 

Module Setting > Modbus - RTU Module (Master) > Modbus RTU Module List 

Serial Port Choose the serial port of UA controller that links with the I/O module.  

UA-2200/5200: ttyO2 (RS-485); ttyO4 (RS-232); ttyO5 (RS-485) 

UA-7200: COM1 (RS-232/485) 

Import Module 

Profile: Upload 

Module Profile 

1.Click to import the pre-edited .csv module profile (see UA-FAQ) 

2.Click to import the .json ICP DAS module list. Go to UA Download 

Center > Firmware to download the new .json Module List. 

Select All  

 

Check the box “Select All” will select all modules in the list. 

Check the box in the left of the module is to select that module list, 

can delete or copy the module. 

 Click to add a list of module. 

No. The number of the module list (System arrange, not editable) 

*Module Name / 

Nickname  

Module name (*: cannot be null). Click  can switch setting mode. 

Name: User set up the module. Select The Module: Select a ICP 

DAS model, system auto-setup the module. 

Edit Click to set the module in the Module Content Setting page. 

Copy Select the module wants to copy by check the 

box and click [Copy] can copy module by 

assigning port and Number. Yes: copy the 

module and exit. No: exit without copy. 

Remove Click to delete the checked module(s) 

Remove all Click to delete all modules linked with the 

selected port. Remove: delete the modules 

and exit. No: exit without delete module. 

 

The page number / total pages of the module list. Click < or > to go 

to the previous or the next page. 

Save Click to save the settings of this page. 

https://www.icpdas.com/en/download/show.php?num=7996&nation=US&kind1=&model=&kw=ua-
https://www.icpdas.com/en/download/show.php?num=7996&nation=US&kind1=&model=&kw=ua-
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Click [Edit] button to enter the “Module Content Setting” page. 

Enter the Module Content Setting page. 

 

Fig. 91) Module Setting > Modbus RTU > Module Content 
Tab. 34) Descriptions: Module Setting > Modbus RTU > Module Content 

Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name Give a name, e.g. model number or name. Default: Name. 

Slave ID Set the module Slave ID of the UA. (Range: 1 ~ 247) 

Timeout Set the timeout value for the module. Default: 500 ms 

Write Retry Check to retry writing again when there is no response after the set time 
is up, and it can be set up to retry 3 times 

Modbus Mapping Table Setting 

Data Model System provides 4 Modbus data 

models for mapping to the 

Modbus address of the Ch.: Coil 

Status, Input Status, Holding 

Registers, Input Registers. 

Data Model Modbus Addr. Ch. Type 

Coil Status 0xxxxx DO 

Input Status 1xxxxx DI 

Holding Registers 2xxxxx AO 

Input Registers 3xxxxx AI 
 

Data Model System provides 4 Modbus data models for mapping to the Modbus 

address of the channels. 

Start Address The start address of the Modbus command. Note: the Start Address of 
UA is base 0, even if some modules are base 1, here it needs to follow 
UA to set base 0. 

Data Number Set the number of module channel (DO, DI, AO, AI) data according to 
"Data Model". Default: 1. 

Type This item only appears when the data model is 03 or 04. Set it according 
to the module data: 16-bit Short, 16-bit Unsigned Short, 32-bit Long, 32-
bit Unsigned Long, 64-bit Int64, 32-bit Float, 64-bit Double. 
Note: 32-bit and 64-bit data occupy 2 and 4 Modbus Register addresses. 

Create Tables Click [Add] button, it will add a table in the Modbus mapping table. 

If select ICP DAS module, system will 
auto set up the Modbus Mapping Table, 
or user needs to check the module 
Modbus address or I/O number from 
the module user manual. 
> Modbus Mapping Table Setting: 

Set module in the order of Data 
Model, Start Address and Data 
Number, then click “Add”. 

Ex: M-7055D has 8 Data Models of “01 
Coil Status (0x)” (Mapping: DO), so 
select Model “01”, Start Add. “0”, 
Number “8”, and click “Add”. 
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The finished Modbus Mapping Table as below.  
 

Address Setting: 

Display and edit the Modbus Mapping Table. 

 

 
Fig. 92) Module Setting > Modbus RTU > Mapping Table > Address 

 
If user selects ICP DAS module, the system will auto set up the Modbus Mapping Table. If 
not, user needs to check the module Modbus address or I/O number from the module user 
manual. 
Tab. 35) Descriptions: Module Setting > Modbus RTU > Mapping Table > Address 

Modbus Mapping Table – Address Setting 

Address Setting The “Address Setting” page of the Modbus Mapping Table 

Nickname Setting Click can switch to the The “Nickname Setting” page of the 

Modbus Mapping Table. (Next page) 

Modbus Mapping 

Table 

Coil Status(0x): Mapping to DO Modbus address 

Input Status(1x): Mapping to DI Modbus address  

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Address The start address of the Modbus command. Default: 0.  

Note: the Start Address of UA is base 0, even if some modules are 

base 1, here it needs to follow UA to set base 0. 

Number The number of the Modbus address. Need to give enough number 

for the DO, DI, AO, AI channels of the module. At least 1. 

Type DO/DI type: Bool (Boolean) 

AO/AI type: depend on setting of [Modbus Mapping Table Setting] 

Edit Click to change the address and Number. 

Delete Click to delete this address table. 

Save Click to save and exit this table editing. 

Cancel Click to exit without saving and back to the module list page. 

OK Click to save this page settings and back to the module list page. 
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Nickname Setting: 

Setting the variable nickname and description. 

 
Fig. 93) Module Setting > Modbus RTU > Mapping Table > Nickname 

Tab. 36) Descriptions: Module Setting > Modbus RTU > Mapping Table > Nickname 

Modbus Mapping Table – Nickname Setting 

Modbus Mapping 

Table 

Coil Status(0x): Mapping to DO Modbus address 

Input Status(1x): Mapping to DI Modbus address  

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Table Display Click [Show] to display all fields, click [Hide] to hide some fields. 

Address Modbus address. System auto arrange. 

Variable name The variable name of the mapping address. Default: Tag0 and auto 

arrange the number. User can define the name. 

Data Type Display data type of the variable. (Not editable) 

Swap Check to swap the byte order (Lo-Hi/Hi-Lo) for 4-byte or 8-byte. 

Description Write a note for this variable. 

OK Click to save this page settings and back to the module list page. 
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 ** Scaling  

Scaling is only available in the AI/AO settings of Modbus RTU/TCP. When the variable 

value needs to be scaled or converted before output, click the "Advanced Setting" button of 

the variable on the Scaling page, input the Min./Max./Offset of the Reference/Output items, 

add a description, and check "Enable" box, The Scaling conversion function will be activated. 

 
Fig. 94) Module Setting > Modbus RTU > Mapping Table > Scaling 

Tab. 37) Descriptions: Module Setting > Modbus RTU > Mapping Table > Scaling 

Modbus Mapping Table – Scaling 

Modbus 

Mapping Table 

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Scaling do not support 01 Coil Status(0x):DO & 02 Input Status(1x):DI 

Table Display Click [Show] to display all fields, click [Hide] to hide some fields. 

Address Modbus address. System auto arrange. 

Reference The I/O variable of the Modbus address. 

Output The scaling variable for scaling output. User can define the variable name. 

Scaling 

Click [Show Detail] to set up the Scaling parameters, and click [Hide Detail] 

to hide the parameters.  

Fill in the Min/Max range values of the source in the Reference column. Fill 

in the Min/Max range values after scaling in the Output column. If needs 

offset, fill the offset value in the Offset item. Remember check “Enable” box. 

Enable Check the box of the variable can enable just that variable for scaling. 

Description Write a note for this variable. 

OK Click to save this page settings and back to the module list page. 
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 ** Bitwise  

Bitwise is only available in the AI/AO settings of Modbus RTU/TCP. When the data 

needed to take out the value of the specified bit, fill in the variable name in the specified Bit# 

of the required address, and the value of the bit can be output to the filled variable. 

 
Fig. 95) Module Setting > Modbus RTU > Mapping Table > Bitwise 

Tab. 38) Descriptions: Module Setting > Modbus RTU > Mapping Table > Bitwise 

Modbus Mapping Table – Bitwise 

Modbus 

Mapping Table 

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Bitwise do not support 01 Coil Status(0x):DO & 02 Input Status(1x):DI 

Bitwise do not supports 32-bit Float & 64-bit Double data types. 

Table Display Click [Show] to display all fields, click [Hide] to hide some fields. 

Address Modbus address. System auto arrange. 

Reference The Bit# variables of the Modbus address. 

Bitwise 

Set up the variables for Bitwise. Click [Advanced Settings] to set up the 

Bitwise parameters, and click [Hide] to hide the parameters.  

Fill in the variable names to the Bit# that wanted to do the Bitwise. The value 

in the fixed bit number will be assigned into the variable.  

OK Click to save this page settings and back to the module list page. 
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5.2.2 Modbus TCP (Master) 

This setting is for UA Controller connecting the remote Modbus TCP Slave module. 

 
Fig. 96) Modbus TCP Module  

This section shows the settings for the Modbus TCP module on Ethernet LAN. User can give 

module a name (Default: Name), click [ ] button to add a new module, and then setup the 

module. If using ICP DAS module, user can just select the model, system will auto add and 

setup the module. Click [Edit] button to set the module content and the Modbus mapping table. 

 

Setting Steps: 

1. Click the switch icon  to select the adding mode: 

a) Select The Module: Select an ICP DAS model (as the pic), system will auto setup. 

b) Name: Give a name, e.g. DL-302. Click [ ] to add a module for user setting. 

2. Click the button [Edit] to enter the Module Content Setting page 

View or set the Modbus Mapping Table for the UA Series and module I/O channels 

 

  

Fig. 97) Modbus TCP Module Setting Steps 
 
 
The function items and setting parameters of the [Modbus TCP Module List]: 
 

2. Click to set the module content 

1. Click switch icon to select an ICP DAS module for auto setting,  
or give a name, click ‘+’ to add a module for user setting. 
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Fig. 98) Module Setting > Modbus TCP > Module List 

Tab. 39) Descriptions: Module Setting > Modbus TCP > Module List 

Module Setting > Modbus - RTU Module (Master) > Modbus RTU Module List 

Import Module 

Profile: Upload 

Module Profile 

1.Click to import the pre-edited .csv module profile (see UA-FAQ) 

2.Click to import the .json ICP DAS module list. Go to UA Download 

Center > Firmware to download the new .json Module List. 

Select All  

 

Check the box “Select All” will select all modules in the list. 

Check the box in the left of the module is to select that module list, can 

delete or copy the module. 

 Click to add a list of module. 

No. The module number in the module list (System arrange, not editable) 

*Module Name 

/ Nickname 

 

Module name (*: cannot be null). Click  can switch setting mode. 

Name: User give a name to set up the module. Select The Module: 

Select a ICP DAS model, system auto-setup the module. 

Edit Click to set the module in the Module Content Setting page. 

Copy Select the module wants to copy by check 

the box and click [Copy] can copy module 

by assigning port and quantity.  

Yes: copy the module and exit. 

No: exit without copy. 

Remove Click to delete the checked module(s) 

Remove all Click to delete all modules linked with the 

selected port.  

Remove: delete the modules and exit. 

No: exit without delete module. 

 

The page number / total pages of the module list. Click < or > to go to 

the previous or the next page. 

Save Click to save the settings of this page. 

 

Click [Edit] can enter the [Module Content Setting] page to set up the module and the 

Modbus address mapping table. 

https://www.icpdas.com/en/download/show.php?num=7996&nation=US&kind1=&model=&kw=ua-
https://www.icpdas.com/en/download/show.php?num=7996&nation=US&kind1=&model=&kw=ua-
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Fig. 99) Module Setting > Modbus TCP > Module Content 

Tab. 40) Descriptions: Module Setting > Modbus TCP > Module Content 

Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name Give a name, e.g. model number or name. Default: Name. 

IP The IP address of the connected module. Default: 0.0.0.0 

Port The port number for Modbus TCP. Default: 502 

Slave ID Set the Slave ID of the UA. (Range: 1 ~ 247) 

Timeout Set the timeout value for the module. Default: 500 ms 

Polling Interval Set a time interval for the command. Default: 500 ms  

Modbus Mapping Table Setting 

Data Model System provides 4 Modbus data 

models for mapping to the 

Modbus address of the Ch.: Coil 

Status, Input Status, Holding 

Registers, Input Registers. 

Data Model Modbus Addr. Ch. Type 

Coil Status 0xxxxx DO 

Input Status 1xxxxx DI 

Holding Registers 2xxxxx AO 

Input Registers 3xxxxx AI 
 

Start Address The start address of the Modbus command. Note: the Start Address of 
UA is base 0, even if some modules are base 1, here it needs to follow 
UA to set base 0. 

Data Number Set the number of module channel (DO, DI, AO, AI) data according to 
"Data Model". Default: 1. 

Type This item only appears when the data model is 03 or 04. Set it according 
to the module data: 16-bit Short, 16-bit Unsigned Short, 32-bit Long, 32-
bit Unsigned Long, 64-bit Int64, 32-bit Float, 64-bit Double. 
Note: 32-bit and 64-bit data occupy 2 and 4 Modbus Register 
addresses. 

Create Tables Click [Add] button, it will add a table in the Modbus mapping table. 

If select ICP DAS module, system will 
auto set up the Modbus Mapping 
Table, or user needs to check the 
module Modbus address or I/O 
number from the module user manual. 
> Modbus Mapping Table Setting: 

Set module in the order of Data 
Model, Start Address and Data 
Number, then click “Add”. 

Ex: DL-302 has 6 Data Models of “04 
Input Registers (3x)” (Mapping: AI), so 
select Model “04”, start 0, number 6, 
type Short, and click “Add”. 
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The finished Modbus Mapping Table as below is in order of DO, DI, AO and AI.  
 

Address Setting: 

Display and edit the Modbus Mapping Table. 

 

 
Fig. 100) Module Setting > Modbus TCP > Mapping Table > Address 

If user selects ICP DAS module, the system will auto set up the Modbus Mapping Table. If 
not, user needs to check the module Modbus address or I/O number from the module user 
manual. 
Tab. 41) Descriptions: Module Setting > Modbus TCP > Mapping Table > Address 

Modbus Mapping Table – Address Setting 

Address Setting The “Address Setting” page of the Modbus Mapping Table 

Nickname Setting Click can switch to the The “Nickname Setting” page of the 

Modbus Mapping Table. (Next page) 

Modbus Mapping 

Table 

Coil Status(0x): Mapping to DO Modbus address 

Input Status(1x): Mapping to DI Modbus address  

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Address The start address of the Modbus command. Default: 0.  Note: the 

Start Address of UA is base 0, even if some modules are base 1, 

here it needs to follow UA to set base 0. 

Number The number of the Modbus address. Need to give enough number 

for the DO, DI, AO, AI channels of the module. At least 1. 

Type DO/DI type: Bool (Boolean) 

AO/AI type: depend on setting of [Modbus Mapping Table Setting] 

Edit Click to change the address and Number. 

Delete Click to delete this address table. 

Save Click to save and exit this table editing. 

Cancel Click to exit without saving and back to the module list page. 

OK Click to save this page settings and back to the module list page. 
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Nickname Setting: 

Setting the variable nickname and description. 

 
Fig. 101) Module Setting > Modbus TCP > Mapping Table > Nickname 

Tab. 42) Descriptions: Module Setting > Modbus TCP > Mapping Table > Nickname 

Modbus Mapping Table – Nickname Setting 

Modbus Mapping 

Table 

Coil Status(0x): Mapping to DO Modbus address 

Input Status(1x): Mapping to DI Modbus address  

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Table Display Click [Show] to display all fields, click [Hide] to hide some fields. 

Address Modbus address. System auto arrange. 

Variable name The variable name of the mapping address. Default: Tag0 and auto 

arrange the number. User can define the name. 

Data Type Display data type of the variable. (Not editable) 

Swap Check to swap the byte order (Lo-Hi/Hi-Lo) for 4-byte or 8-byte. 

Description Write a note for this variable. 

OK Click to save this page settings and back to the module list page. 
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 ** Scaling  

Scaling is only available in the AI/AO settings of Modbus RTU/TCP. When the variable 

value needs to be scaled or converted before output, click the "Advanced Setting" button of 

the variable on the Scaling page, input the Min./Max./Offset of the Reference/Output items, 

add a description, and check "Enable" box, The Scaling conversion function will be activated. 

 
Fig. 102) Module Setting > Modbus TCP > Mapping Table > Scaling 

Tab. 43) Descriptions: Module Setting > Modbus TCP > Mapping Table > Scaling 

Modbus Mapping Table – Scaling 

Modbus 

Mapping Table 

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Scaling do not support 01 Coil Status(0x):DO & 02 Input Status(1x):DI 

Table Display Click [Show] to display all fields, click [Hide] to hide some fields. 

Address Modbus address. System auto arrange. 

Reference The I/O variable of the Modbus address. 

Output The scaling variable for scaling output. User can define the variable name. 

Scaling 

Click [Show Detail] to set up the Scaling parameters, and click [Hide Detail] 

to hide the parameters.  

Fill in the Min/Max range values of the source in the Reference column. Fill 

in the Min/Max range values after scaling in the Output column. If needs 

offset, fill the offset value in the Offset item. Remember check “Enable” box. 

Enable Check the box of the variable can enable just that variable for scaling. 

Description Write a note for this variable. 

OK Click to save this page settings and back to the module list page. 
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 ** Bitwise  

Bitwise is only available in the AI/AO settings of Modbus RTU/TCP. When the data 

needed to take out the value of the specified bit, fill in the variable name in the specified Bit# 

of the required address, and the value of the bit can be output to the filled variable. 

 
Fig. 103) Module Setting > Modbus TCP > Mapping Table > Bitwise 

Tab. 44) Descriptions: Module Setting > Modbus TCP > Mapping Table > Bitwise 

Modbus Mapping Table – Bitwise 

Modbus 

Mapping Table 

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Bitwise do not support 01 Coil Status(0x):DO & 02 Input Status(1x):DI 

Bitwise do not supports 32-bit Float & 64-bit Double data types. 

Table Display Click [Show] to display all fields, click [Hide] to hide some fields. 

Address Modbus address. System auto arrange. 

Reference The Bit# variables of the Modbus address. 

Bitwise 

Set up the variables for Bitwise. Click [Advanced Settings] to set up the 

Bitwise parameters, and click [Hide] to hide the parameters.  

Fill in the variable names to the Bit# that wanted to do the Bitwise. The value 

in the fixed bit number will be assigned into the variable.  

OK Click to save this page settings and back to the module list page. 
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5.2.3 Modbus ASCII (Master) 

This setting is for UA Controller connecting the remote Modbus ASCII Slave module. 
 

 
Fig. 104) Modbus ASCII Module  

This page is for setting the communication values with the connected modules. First choose 

the serial port that connected with the module, and each module can give a name (Default 

name: Name). Click [ ] button could add a new module, and then click [Edit] button to 

configure the module content and the Modbus mapping table. 

 

Setting Steps: 

1. Select the module connecting Serial port 

2. Give the module name or nickname, e.g. module number. Default: Name 

3. Click the button [ ] to add a new module 

4. Click the button [Edit] to enter the Module Content Setting page 

Set up the Modbus Mapping Table for the UA controller and module I/O channels 

 

  
Fig. 105) Modbus ASCII Module Setting Steps 

The function items and setting parameters of the [Modbus ASCII Module List]: 
 

2. Give a name, ex: module name 

3. Click to add 

1. Select the connecting serial port 

4. Click to set the module content 
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Fig. 106) Module Setting > Modbus ASCII > Module List 

Tab. 45) Descriptions: Module Setting > Modbus ASCII > Module List 

Module Setting > Modbus - ASCII Module (Master) > Modbus ASCII Module List 

Serial Port Choose the serial port of UA controller that links with the I/O module. 

UA-2200/5200: ttyO2 (RS-485); ttyO4 (RS-232); ttyO5 (RS-485) 

UA-7200: COM1 (RS-232/485) 

 Click to add a list of module. 

 Check the box in the left of the module is to select that module list, 

can delete or copy the module. 

Check the box “Select All” will select all modules in the list. 

No. The module number in the module list (System arrange, not 

editable) 

*Module Name / 

Nickname 

Module name or nick name. User can give a new name.  

(The star * means this field cannot be null.) 

Edit Click to set the module in the Module Content Setting page. 

Copy Select the module wants to copy by 

check the box and click [Copy] can copy 

module by assigning port and Quantity.  

Yes: copy the module and exit. 

No: exit without copy. 

Remove Click to delete the checked module(s) 

Remove all Click to delete all modules linked with 

the selected port.  

Remove: delete the modules and exit. 

No: exit without delete module. 

 

The page number / total pages of the module list. Click < or > to go 

to the previous or the next page. 

Save Click to save the settings of this page. 

 

Click [Edit] button to enter the “Module Content Setting” page. 
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Fig. 107) Module Setting > Modbus ASCII > Module Content 

Tab. 46) Descriptions: Module Setting > Modbus ASCII > Module Content 

Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name Give a name, e.g. model number or name. Default: Name. 

Slave ID Set the module Slave ID of the UA. (Range: 1 ~ 247) 

Timeout Set the timeout value for the module. Default: 500 ms 

Modbus Mapping Table Setting 

Data Model System provides 4 Modbus data 

models for mapping to the 

Modbus address of the Ch.: Coil 

Status, Input Status, Holding 

Registers, Input Registers. 

Data Model Modbus Addr. Ch. Type 

Coil Status 0xxxxx DO 

Input Status 1xxxxx DI 

Holding Registers 2xxxxx AO 

Input Registers 3xxxxx AI 
 

Start Address The start address of the Modbus command. Note: the Start Address of 

UA is base 0, even if some modules are base 1, here it needs to follow 

UA to set base 0. 

Data Number Set the number of module channel (DO, DI, AO, AI) data according to 

"Data Model". Default: 1. 

Type This item only appears when the data model is 03 or 04. Set it according 

to the module data: 16-bit Short, 16-bit Unsigned Short, 32-bit Long, 32-

bit Unsigned Long, 64-bit Int64, 32-bit Float, 64-bit Double. 

Note: 32-bit and 64-bit data occupy 2 and 4 Modbus Register addresses. 

Create Tables Click [Add] button, it will add a table in the Modbus mapping table. 

 
The finished Modbus Mapping Table as below is in order of DO, DI, AO and AI.  
 

 
> Modbus Mapping Table Setting: 

Set module in the order of Data 
Model, Start Address and Data 
Number, then click “Add”. 
 

Ex: Module has 6 Data Models of “04 
Input Registers (3x)” (Mapping: AI), so 
select Model “04”, start 0, number 6, 
type Short, and click “Add”. 
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Address Setting: 

Display and edit the Modbus Mapping Table. 

 

 
Fig. 108) Module Setting > Modbus ASCII > Mapping Table > Address 

Tab. 47) Descriptions: Module Setting > Modbus ASCII > Mapping Table > Address 

Modbus Mapping Table – Address Setting 

Address Setting The “Address Setting” page of the Modbus Mapping Table 

Nickname Setting Click can switch to the The “Nickname Setting” page of the 

Modbus Mapping Table. (Next page) 

Modbus Mapping 

Table 

Coil Status(0x): Mapping to DO Modbus address 

Input Status(1x): Mapping to DI Modbus address  

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Address The start address of the Modbus command. Default: 0. Note: the 

Start Address of UA is base 0, even if some modules are base 1, 

here it needs to follow UA to set base 0. 

Number The number of the Modbus address. Need to give enough number 

for the DO, DI, AO, AI channels of the module. At least 1. 

Type DO/DI type: Bool (Boolean) 

AO/AI type: depend on setting of [Modbus Mapping Table Setting] 

Edit Click to change the address and Number. 

Delete Click to delete this address table. 

Save Click to save and exit this table editing. 

Cancel Click to exit without saving and back to the module list page. 

OK Click to save this page settings and back to the module list page. 
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Nickname Setting: 

Setting the variable nickname and description. 

 
Fig. 109) Module Setting > Modbus ASCII > Mapping Table > Nickname 

Tab. 48) Descriptions: Module Setting > Modbus ASCII > Mapping Table > Nickname 

Modbus Mapping Table – Nickname Setting 

Modbus Mapping 

Table 

Coil Status(0x): Mapping to DO Modbus address 

Input Status(1x): Mapping to DI Modbus address  

Holding Registers(4x): Mapping to AO Modbus address 

Input Registers(3x): Mapping to AI Modbus address 

Table Display Click [Show] to display all fields, click [Hide] to hide some fields. 

Address Modbus address. System auto arrange. 

Variable name The variable name of the mapping address. Default: Tag0 and auto 

arrange the number. User can define the name. 

Data Type Display data type of the variable. (Not editable) 

Swap Check to swap the byte order (Lo-Hi/Hi-Lo) for 4-byte or 8-byte. 

Description Write a note for this variable. 

OK Click to save this page settings and back to the module list page. 
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5.2.4 MQTT Module 

This setting is for UA Controller connecting the remote MQTT module. 
 

 
Fig. 110) MQTT Module 

This page is for setting the communication values with the connected modules. First choose 

the Ethernet LAN port that connected with the module, and each module can give a name 

(Default name: Name). Click [ ] button could add a new module, and then click [Edit] 

button to configure the module content and the MQTT variable table. 

 

Setting Steps: 

1. Give the module name or nickname, e.g. MQ-7255, DL-302. Default: Name 

2. Click the button [ ] to add a new module 

3. Click the button [Edit] to enter the Module Content Setting page 

Set up the Modbus Mapping Table for the UA controller and module I/O channels 

 

 
Fig. 111) MQTT Module Setting Steps 

 
The function items and setting parameters of the [MQTT Module List]: 

1. Give a name, Default: Name 

2. Click to add 

3. Click to set the module content 
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Fig. 112) Module Setting > MQTT Module > List 

Tab. 49) Descriptions: Module Setting > MQTT Module > List 

Module Setting > MQTT - MQTT Module > MQTT Module List 

 
Click to add a list of module. 

 Check the box in the left of the module is to select that module list, 

can delete or copy the module. 

Check the box “Select All” will select all modules in the list. 

No. The module number in the module list (System arrange, not 

editable) 

*Module Name / 

Nickname 

Module name or nick name. User can give a new name.  

(The star * means this field cannot be null.) 

Edit Click to set the module in the Module Content Setting page. 

Copy Select the module wants to copy by 

check the box and click [Copy] can copy 

module by assigning port and quantity.  

Yes: copy the module and exit. 

No: exit without copy. 

Remove Click to delete the checked module(s) 

Remove all Click to delete all modules linked with 

the selected port.  

Remove: delete the modules and exit. 

No: exit without delete module. 

 

The page number / total pages of the module list. Click < or > to go 

to the previous or the next page. 

Save Click to save the settings of this page. 

 

Click [Edit] can enter the [MQTT Client Setting] page.      
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[MQTT Client Setting] page: to set up the module and the variable table 

 

 
Fig. 113) Module Setting > MQTT Module > Setting 

 
Tab. 50) Descriptions: Module Setting > MQTT Module > Setting 

MQTT Client Setting 

No. The module number in the module list (Not editable here) 

Module Name Give a name, e.g. model number or name. Default: Name. 

MQTT 

Connection 

Broker (Local): The using Local Broker. Broker Name (Remote) will be 

another option if there is another Remote Broker setting. 

MQTT Variable Setting 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the MQTT variable. Include: Bool, Short, Unsigned 

Short, Long, Unsigned Long, Int64, Float, Double, String. 

Data Number The number for the I/O variables of the module. Default: 1. 

Create Tables Click [Add] button, it will add a variable list in the MQTT Variable Table. 

Details 

Show / Hide 

Click [Show] to display all fields, click [Hide] to hide some fields. 

The hide fields: Subscribe QoS, Publish QoS, Retain. 
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[MQTT Variable Table] : 

 
Fig. 114) Module Setting > MQTT Module > Variable Table 

Tab. 51) Descriptions: Module Setting > MQTT Module > Variable Table 

MQTT Variable Table 

Details 

Show / Hide 

Click [Show] to display all fields, click [Hide] to hide some fields. 

The hide fields: Subscribe QoS, Publish QoS and Retain. 

Remove Table / 

Remove 

Check the box in the left of the variable is to select that variable list, 

and click the “remove” on the box can delete that variable list. 

Click the “Remove” of the “Remove Table” will delete all lists. 

Name The name of the MQTT variable. Default: Tag# 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable. Include: Bool, Short, Unsigned 

Short, Long, Unsigned Long, Int64, Float, Double, String 

Subscribe Topic The topic of receiving/subscribing data message.  

Subscribe QoS 

The subscribe QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Publish Topic The topic of sending/publishing data message. 

Publish QoS 

The publish QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Description For users set up the description for the variables. 

Retain Check [Retain] box of the top row can store the broker message for all 

variables in list. Check the box of each variable can store the broker 

message just that variable. Default: Uncheck. 

OK / Cancer Click [OK] to save and exit the page settings.  

Click [Cancer] to exit without saving. 
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5.2.5 EtherNet/IP ICP DAS Module 

This setting is for UA Controller connecting the remote ICP DAS EIP module. 
 

 
Fig. 115) EtherNet/IP ICP DAS Module  

This page is for setting the communication values with the connected EIP modules. First, 

choose the Ethernet LAN port that connected with the module, and select the name of EIP 

module. Click [ ] button could add a new module, and then click [Edit] button to configure 

the module content and the MQTT variable table. 

 

Setting Steps: 

1. Select the module name of EIP-2000 

2. Click the button [ ] to add a new module 

3. Click the button [Edit] to enter the Module Content Setting page 

Set up the module IP and module I/O channels 

 

 

Fig. 116) EtherNet/IP ICP DAS Module Setting Steps 
 
The function items and setting parameters of the [EtherNet/IP Module List]: 
 

1. Select the module name 

2. Click to add 

3. Click to set the module content 
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Fig. 117) Module Setting > EtherNet/IP Module > List 

 
Tab. 52) Descriptions: Module Setting > EtherNet/IP Module > List 

Module Setting > EtherNet/IP – ICPDAS Module > EtherNet/IP Module List 

Select All 

 

Check the box in the left of the module is to select that module list, 

can delete or copy the module. 

Check the box “Select All” will select all modules in the list. 

 
Click to add a list of module. 

No. The module number in the module list (System arrange, not 

editable) 

ModuleName Select the connecting EIP-2000 module name. 

NickName User can define a nickname for the EIP-2000 module. 

Edit Click to set the module in the Module Content Setting page. 

Copy Select the module wants to copy by 

check the box and click [Copy] can copy 

module by assigning port and quantity.  

Yes: copy the module and exit. 

No: exit without copy. 

Remove Click to delete the checked module(s) 

Remove all Click to delete all modules linked with 

the selected port.  

Remove: delete the modules and exit. 

No: exit without delete module. 

 

The page number / total pages of the module list. Click < or > to go 

to the previous or the next page. 

Save Click to save the settings of this page. 

 

Click [Edit] can enter the [Module Content Setting] page to set up the module.     
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[Module Content Setting] page: 

 

  
Fig. 118) Module Setting > EtherNet/IP Module > Content 

 
Tab. 53) Descriptions: Module Setting > EtherNet/IP Module > Content 

Module Setting > EtherNet/IP – ICPDAS Module > Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The selected EIP module number. 

NickName User can define a nickname for the module. Default: Module name. 

IP Enter the IP address of the module. Default: 0.0.0.0 

ChannelNumber System auto setup the I/O channel numbers and the I/O table. Some 

module provides 2 or more channel mode needed user to select one. 
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DI/DO/AI/AO Channel Table: System auto setup the table according to the module name. 

 

 

 

 

 
Fig. 119) Module Setting > EtherNet/IP Module > I/O Channel Table 

 
Tab. 54) Descriptions: Module Setting > EtherNet/IP Module > I/O Channel Table 

Module Setting > EtherNet/IP – ICPDAS Module > Di/Do/AI/AO Channel Table 

Channel Channel number set by system. (Not editable) 

Name Channel name. User can define a new channel name. 

Attribute Display data attribute of the channel. (Not editable)  

Include: Read, Read / Write… 

Data Type Display data type of the channel. Include: Bool, Short, Float, … 

according to the module. 

Description User can set up the description for the channel. 

OK / Cancer Click [OK] to save and exit the page settings.  

Click [Cancer] to exit without saving. 
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5.2.6 XV Board 

This function can set the XV Board module on the expansion slot of the UA server. The user 

inserts the XV board into the UA slot and uses this function to select and set the XV module. 

 

UA series provides one XV expansion board slot (except for UA-7231). Users can purchase 

one XV511i module to expand 4 RS-485 ports (the UA-5231 series limits to the Rev. B version). 

Or, One of XV107/110/111/116/119/303/306/307/310 modules to expand the I/O channel. 

 
Fig. 120) Module Setting > XV Board - XV Module > List 

Tab. 55) Descriptions: Module Setting > XV Board – XV Module > List 

Module Setting > XV Board – XV Module > XV Module List 

Module Name Displays the model number of the module listed in the drop-down 

menu. Default: None. 

Edit Edit selected module content. 

 

Select the module name, and click "Edit". 

 
Fig. 121) XV Board Module Name and Edit 
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Fig. 122) Module Setting > XV Board > Content 
Tab. 56) Descriptions: Module Setting > XV Board > Content 

Module Setting > XV Board – XV Module > XV Module List > Module Content Setting 

Module Name Display the current module name 

Nick Name Display/edit the nick name of the current module (default: current 

module name) 

 

 
 

 
Fig. 123) Module Setting > XV Board > DI (Counter) 

Tab. 57) Descriptions: Module Setting > XV Board > DI (Counter) 

Module Setting > XV Board – XV Module > XV Module List > Digital Input (Counter) 

Channel  Display the current channel number 

Name Display/edit the current channel name (default: DI0, 1, 2… or Counter0, 

1, 2…) 

Counter Type Set the trigger counting type of the Counter. Select Falling or Rising 

(default: Falling) 

Description Display and edit current channel descriptions (user defined) 
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Fig. 124) Module Setting > XV Board > DO 
Tab. 58) Descriptions: Module Setting > XV Board > DO 

Module Setting > XV Board – XV Module > XV Module List > Digital Input (Counter) 

Channel  Display the current channel number 

Name Display/edit the current channel name (default: DO0, 1, 2…) 

PowerOn Value Set the DO channel power-on default value. Select ON or OFF (default: 

OFF) 

Description Display and edit current channel descriptions (user defined) 

 
Fig. 125) Module Setting > XV Board > AI/O 

Tab. 59) Descriptions: Module Setting > XV Board > AI/O 

Module Setting > XV Board – XV Module > XV Module List > Analogy Input / Output 

Channel  Display the current channel number 

Name Display/edit the current channel name (default: AO0, 1… or AO0, 1…) 

Type Set AI/AO channel signal type (default: -10V~10V) 

PowerOn Value Set the AO channel power-on default value. (default: 0) 

Description Display and edit current channel descriptions (user defined) 
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5.2.7 Internal Module 

The function can create internal modules and variables for virtual reading and writing, or as an 

intermediary to provide data exchange of communication protocols. 

* Internal Variable: max. 8 internal modules; max. 100 internal variables (tags) per module. 

* Protocol Communication Conversion: provide Internal to OPC UA (Server) 

 

  
Fig. 126) Internal Module 

This page is for setting the internal module list. First, enter the name for the module. Click [ ] 

button to add a new module, and then click [Edit] button to configure the module variables. 

 

Setting Steps: 

1. Enter a name for the internal module 

2. Click the button [ ] to add the module 

3. Click the button [Edit] to enter the Module Content Setting page.  

Set up the module variables 

 

  
Fig. 127) Internal Module Setting Steps 

1. Enter an internal module 

name 2. Click to add 

3. Click to set the module 

content 
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The function items and setting parameters of the [Internal Register Module List]: 
 

 
Fig. 128) Module Setting > Internal Module > List 

Tab. 60) Descriptions: Module Setting > Internal Module > List 

Module Setting > Internal – Internal Module > Internal Register Module List 

Select All  

 

Check the box “Select All” will select all modules in the list. 

Check the box in the left of the module is to select that module list, 

can delete or copy the module. 

 
Click to add a list of module. 

No. The module number in the module list (System arrange, not 

editable) 

*Module Name / 

Nickname 

Module name or nickname. User can give a new name.  

(The star * means this field cannot be null.) 

Edit Click to set the module in the Module Content Setting page. 

Copy Select the module wants to copy by 

check the box and click [Copy] can copy 

module by assigning port and quantity.  

Yes: copy the module and exit. 

No: exit without copy. 

Remove Click to delete the checked module(s) 

Remove all Click to delete all modules linked with 

the selected port.  

Remove: delete the modules and exit. 

No: exit without delete module. 

 

The page number / total pages of the module list. Click < or > to go 

to the previous or the next page. 

Save Click to save the settings of this page. 

 
 
Click [Edit] can enter the [Internal Module Content Setting] page. 
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[Internal Module Content Setting] page: to set up the module and the variable table 

 
Fig. 129) Module Setting > Internal Module > Content 

Tab. 61) Descriptions: Module Setting > Internal Module > Content 

Internal Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name Give a name, e.g. model number or name. 

Internal Variable Setting 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read/Write… 

Data Type Display data type of the MQTT variable. Include: Bool, Short, Unsigned 

Short, Long, Unsigned Long, Float, Double, String. 

Data Number The number for the I/O variables of the module. Default: 1. 

Create Tables Click [Add] button, it will add a variable list in the Variable Table. 

 
The Internal Variable Table is as below. 

 
Fig. 130) Internal Variable Table 

> Internal Variable Table: 

Sequentially select the Attribute, 

Data Type, and Data Number of 

the variable, and then click [Add]. 

 

EX: Internal-1 has 2 “Bool” type 

variables, then select Type “Bool”, 

Number “2”, then click [Add]. If 

user needs other variables, please 

add more variables by your case. 



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

127 

[Internal Variable Table] : 

 

 
Fig. 131) Module Setting > Internal Module > Variable Table 

Tab. 62) Descriptions: Module Setting > Internal Module > Variable Table 

Internal Variable Table 

Remove Table / 

Remove 

Check the box in the left of the variable is to select that variable list, 

and click the “remove” on the box can delete that variable list. 

Click the “Remove” of the “Remove Table” will delete all lists. 

No. The module number in the module list (Not editable here) 

Name The name of the variable. Default: Tag# 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read/Write… 

Data Type Display data type of the variable. Include: Bool, Short, Unsigned Short, 

Long, Unsigned Long, Int64, Float, Double, String  (Not editable) 

Description For users set up the description for the variables. 

OK / Cancer Click [OK] to save and exit the page settings.  

Click [Cancer] to exit without saving. 
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5.3 Main Menu: IoT Platform Setting 

IoT Platform Setting is the third item of the Main Menu. It manages the interaction of the UA 

series connecting with the host computer in the Internet of Things. It provides OPC UA and 

MQTT protocols connection services via the Ethernet interface for data transmission. 

 

UA series is generally connected to IoT Cloud platforms such as Amazon AWS, IBM Bluemix 

and Microsoft Azure through MQTT connections. Common cloud platform connections can use 

the "MQTT Connection > Remote Broker" item, such as Amazon AWS, IBM Bluemix, 

Thingspeak, Baidu Cloud... However, connect to the Azure platform is more complicated, 

please use the "MQTT Connection > Microsoft Azure Platform" item. For the setting examples, 

please refer to the UA FAQ web site. 

 

Fig. 132) CH5.3 IoT Platform Function 

[IoT Platform Setting] includes five sub-menu functions in MQTT and OPC UA two connections 

and the function descriptions are listed on the page of the Main Menu. This chapter will 

introduce these function items and setting parameters. 

 
Fig. 133) Main Menu: IoT Platform Setting 

https://www.icpdas.com/en/faq/index.php?kind=326#950
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5.3.1 MQTT Local Broker 

UA series controller built-in MQTT Broker that compliance with MQTT v3.1.1 protocol and 

supporting MQTT message distribution management. When using MQTT communication, 

there is no need to build a new Broker system. 

 

Fig. 134) IoT Platform Setting > MQTT > Local Broker 
Tab. 63) Descriptions: IoT Platform Setting > MQTT > Local Broker 

MQTT Connection > Local Broker Setting 

Port MQTT Local Broker’s COM port. System default: 1883 

Anonymous Login Check to allow anonymous login. Default: Check Enabled. 

WebSocket Check to enable MQTT Broker WebSocket communication 

Port Set WebSocket port 

SSL/TLS Check to enable MQTT Broker SSL/TLS communication 

Port Set SSL/TLS port 

Certificate The Certificate required for MQTT Broker SSL/TLS 
communication. The user clicks Select File to select the 
certificate file to be uploaded on the browser side. Then click 
Upload to upload the file. 

Private Key The Private Key required for MQTT Broker SSL/TLS 
communication. The user clicks Select File to select the 
certificate file to be uploaded on the browser side. Then click 
Upload to upload the file. 

Save Click to save the settings of this page. 
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5.3.2 MQTT Remote Broker 

UA series is generally connected to IoT Cloud platforms such as Amazon AWS, IBM Bluemix 

and Microsoft Azure through MQTT connections. Common cloud platform connections can use 

the "MQTT Connection > Remote Broker" item, such as Amazon AWS, IBM Bluemix, 

Thingspeak, Baidu Cloud... However, connect to the Azure platform is more complicated, 

please refer to the next two section "MQTT Connection > Microsoft Azure Platform". For the 

setting examples, please refer to the UA FAQ web site. 

 

 

 
Fig. 135) MQTT Remote Broker Application 

 

UA series controller built-in MQTT Broker, but when users want to use the external MQTT 

Broker, UA system also provides the settings to connect and publish/subscript messages with 

the MQTT Remote Broker. 

 

  

https://www.icpdas.com/en/faq/index.php?kind=326#950
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This page can set up the MQTT connection with the remote Broker. User can publish and 

subscribe messages to the remote Broker through this connection. 

 

 

Fig. 136) IoT Platform Setting > MQTT > Remote Broker 

 

Setting Sequence for the MQTT Connection: 

 

1. Add and set up a connection Broker name in the Remote Broker List. 

 

2. Set up the contents of the Topic messages published/subscribed by other external MQTT 

devices for mapping to the Variables Table of the UA controller. 

 

3. Convert the data contents of the MQTT device to communicate with other protocols. 

 

 

For the certificate about the communication security, please refer to Chapter 7. 

 

This section will introduce the function items and setting parameters. 
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Fig. 137) IoT Platform Setting > MQTT > Remote Broker List 

Tab. 64) Descriptions: IoT Platform Setting > MQTT > Remote Broker List 

MQTT Connection > Remote Broker > Remote Broker List 

Broker Name MQTT Remote Broker name.  

User can give a new name, e.g. Broker1. Default: Name. 

 Click to add a list of remote Broker. 

Save Click to save the settings of this page. 

 
After adding a list of the Remote Broker: 

 
Fig. 138) IoT Platform Setting > MQTT > Remote Broker List > Edit 

Tab. 65) Descriptions: IoT Platform Setting > MQTT > Remote Broker List > Edit 

MQTT Connection > Remote Broker > Remote Broker List 

Broker Name The MQTT remote Broker name. 

IP / Domain The IP address or domain name of the remote Broker. 

Port The communication port of the remote Broker. 

 Check the box in the left of the Broker is to select that Broker, can 

delete or copy the Broker. Check the box on the top of the list will 

select all Brokers in the list. 

Edit Click to set up the remote Broker in the Broker Content Setting 

page. 

Remove Click to delete the checked Broker(s) 

 

The page number / total pages of the Broker list. Click < or > to go to 

the previous or the next page. 

Save Click to save the settings of this page. 
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Click [Edit] to set up the group in the Broker Content Setting page. 

 
Fig. 139) IoT Platform Setting > MQTT > Remote Broker Content 

Tab. 66) Descriptions: IoT Platform Setting > MQTT > Remote Broker Content 

MQTT Connection > Remote Broker List > Broker Content Settings 

Broker Name The name of the remote MQTT Broker. User can define a new name. 

IP / Domain Set the IP address or domain name of the Remote MQTT Broker. 

Default: 127.0.0.1 

Port The remote Broker port. Default: 1883. 

Client ID Set the MQTT Client ID value, default: random value. 

Keep Alive 

Time (second) 

Set the time in second that pass away without communication between 

the UA controller and Cloud platform. Default: 60 second. 

SSL/TLS Check to enable SSL/TLS security communication. Default: Uncheck. 

Sub-item: Trusted Certificate/Certificate/Private Key. Before enabling, 

upload the needed file from [File Setting] function menu. 

Trusted 

Certificate 

Select the trusted root CA file name uploaded to the controller via the 

File Setting function to verify the broker side certificate. 

Certificate Select the name of the certificate file uploaded to the controller via the 

File Setting function as the client side certification. When the 

"Certificate" field is not empty, the "Private Key" field cannot be empty. 

Private Key Select the name of the Private Key file uploaded to the controller via 

the File Setting function as the client side Private Key. When the 

"Private Key" field is not empty, the "Certificate" field cannot be empty. 

Anonymous 

Login 

Check to allow anonymous login. Default: Check Enabled. 

OK / Cancel Click: save the setting and exit this page.  

Cancel: exit without saving. 
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5.3.3 MQTT Group Connection 

This function is mainly the MQTT group list of UA series controllers, including adding, removing, 

setting, and function parameter description. 

 

MQTT groups can combine with the MQTT JSON function of conversion settings to 

encapsulate device I/O data into JSON format content in groups and then publish or subscribe 

to a single topic. 

 

  
Fig. 140) IoT Platform Setting > MQTT Group Connection 

 

Setting Sequence for the MQTT Group Connection: 

 

1. Set up a connection MQTT Broker of Local or Remote Broker. 

2. Add and set up a MQTT connection group name in the List. 

Set up the contents of the Topic messages published/subscribed by other external MQTT 

devices that supporting JSON format for mapping to the Variables Table of the UA 

controller. 

3. Convert the data contents of the MQTT device into JSON format of groups to communicate 

with other protocols. 

 

 

For the certificate about the communication security, please refer to Chapter 7. 

 

This section will introduce the function items and setting parameters. 
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Fig. 141) IoT Platform Setting > MQTT Connection > Group Name List 

Tab. 67) Descriptions: IoT Platform Setting > MQTT Connection > Group Name List 

IoT Platform Setting > MQTT Connection > MQTT Connection Group Name List 

Group Name MQTT connection group name.  

User can give a new name, e.g. Group1. Default: Name. 

 Click to add a list of MQTT connection group. 

Save Click to save the settings of this page. 

 
After adding a list of the MQTT connection group: 
 

  
Fig. 142) IoT Platform Setting > MQTT Connection > Group Name List Edit 

Tab. 68) Descriptions: IoT Platform Setting > MQTT Connection > Group Name List Edit 

IoT Platform Setting > MQTT Connection > MQTT Connection Group Name List 

Group Name The MQTT connection group name.  

 Check the box in the left of the Group name is to select that group, 

can delete or copy the group. Check the box on the top of the list will 

select all groups in the list. 

Edit Click to set up the group in the MQTT Client Setting page. 

Remove Click to delete the checked group(s) 

 

The page number / total pages of the group list. Click < or > to go to 

the previous or the next page. 

Save Click to save the settings of this page. 
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Click [Edit] to set up the group in the MQTT Client Setting page. 
 

   
Fig. 143) IoT Platform Setting > MQTT Connection > Group Client Setting 

Tab. 69) Descriptions: IoT Platform Setting > MQTT Connection > Group Client Setting 

IoT Platform Setting > MQTT Connection > MQTT Client Setting 

No. The MQTT Client Number. (Un-editable) 

Group Name The name of the Group. User can define a new name.  

Scan Rate(ms) Set an update frequency for the data. Unit: ms. Default: 1000 ms.  

Dead Band Give a dead bend value for updating a float signal. Default: 0 

Dead Band: The minimum amount by which the tag value must 

change in order for the new tag value to be saved. 

Will Topic The title of a disconnect notice. Default: Null. 

Will  The disconnect notice. Default: Null. 

Add Timestamp Add the timestamp in MQTT JSON format message 

MQTT 

Connection 

Check the Broker for this MQTT connection, Local Broker or Remote 

Broker. Remote Broker option will appear only when set in advance. 
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Fig. 144) IoT Platform Setting > MQTT Connection > Group – Publish & Subscribe 

 
Tab. 70) Descriptions: IoT Platform Setting > MQTT Connection > Group – Publish & Subscribe 

IoT Platform Setting > MQTT Connection > MQTT Client Setting – Publish & 

Subscribe 

Publish Topic The topic of sending/publishing data message. 

Publish QoS 

The publish QoS (Quality of Service) levels. Default: 2. 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Subscribe Topic The topic of receiving/subscribing data message. 

Subscribe QoS 

The subscribe QoS (Quality of Service) levels. Default: 2. 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Retain Whether the Broker to store the message. Default: No. 

OK Click to save the setting and exit this page. 

Click [Cancel] to exit this page without saving. 
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5.3.4 MQTT Connection - Microsoft Azure Platform 

Microsoft Azure Platform is a common platform to integrate IoT devices into the cloud. Many 

of the applications use MQTT connection to the cloud for the setting is fast and easy. The UA 

series also provides the MQTT function for module to connect to the Azure platform and allows 

users to publish messages to Microsoft Azure and receive messages from Microsoft Azure.  

 
Fig. 145) MQTT Connection Microsoft Azure Application 

This page will introduce the settings for UA series controller using MQTT service to connect to 

the Microsoft Azure Platform. It includes new, remove and set up the Azure list and the function 

parameters 

 
Fig. 146) IoT Platform Setting > MQTT > Microsoft Azure Platform 
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Fig. 147) IoT Platform Setting > MQTT > Azure > Azure List 

Tab. 71) Descriptions: IoT Platform Setting > MQTT > Azure > Azure List 

IoT Platform Setting > MQTT Connection > Microsoft Azure Platform > Azure List 

Azure Name Azure name. User can give a new name1. Default: Name. 

 Click to add a list of Azure. 

 
After adding a list of the Azure: 
 

  
Fig. 148) IoT Platform Setting > MQTT > Azure > Azure List Edit 

Tab. 72) Descriptions: IoT Platform Setting > MQTT > Azure > Azure List Edit 

IoT Platform Setting > MQTT Connection > Microsoft Azure Platform > Azure List 

Azure Name Azure name. User can define the name. Default: Name.  

 Click to add a new Azure list. 

 Check the box in the left of a Azure name is to select that Azure, 

can delete or copy the Azure. Check the box on the top of the list 

will select all Azures in the list. 

Edit Click to set up the Azure in the Azure Content Setting page. 

Remove Click to delete the checked Azure(s). 

 

The page number / total pages of the Azure list. Click < or > to go 

to the previous or the next page. 

Save Click to save the settings of this page. 

 
Click [Edit] to set up the Azure in the Azure Content Setting page. 
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Fig. 149) IoT Platform Setting > MQTT > Azure > Azure Content 

Tab. 73) Descriptions: IoT Platform Setting > MQTT > Azure > Azure Content 

IoT Platform Setting > MQTT Connection > Microsoft Azure Platform > Azure Content Settings 

Azure Name Azure name. User can define the name. Default: Name.  

SAS Token Input the SAS Token which you previously registered for the UA 

controller from Microsoft Azure. For the procedure to generate a SAS 

Token, please refer to the “Documentation > Azure IoT Hub > IoT 

Hub MQTT support” section on the Microsoft Azure Web Site for 

detailed information. 

Trusted 

Certificate 

Select the Trusted Certificate file that you previously got for the UA 

controller from Microsoft Azure, and uploaded in the menu [MQTT 

Certificate] of [File Setting] function. Sub-filename: .crt   

Keep Alive Time 

(second) 

Set the time in second that pass away without communication 

between the UA controller and Microsoft Azure. Default: 60 second. 

Scan Rate(ms) Set an update frequency for the task data.  

Default: 1000 (Unit: ms) 

Dead Band Give a dead bend value for updating a float signal. Default: 0 

Dead Band: The minimum amount by which the tag value must 

change in order for the new tag value to be saved. 

OK / Cancel OK: save and exit this page.  

Cancel: exit without saving. 

 



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

141 

5.3.5 OPC UA Connection - Local Server 

UA series controller built-in OPC UA Server service can integrate the I/O products and the 

third-party devices, import their data to the back-end SCADA management system or the big-

data analysis/decision system, to satisfy the reliability, interoperability and security needs of 

the Industrial 4.0 automation system. 

 

This setting is for the related service function of OPC UA Server built in UA series controller. 

The Security policy function is default all enabled of the None, Basic128Rsa15, Basic256, 

Basic256Sha256, Aes128_Sha256_RsaOaep, Aes256_Sha256_RsaPss, and provides the 

options of "Sign", "Sign and Encrypt" and "Sign; Sign and Encrypt". 

 

This page provides the settings for the UA series built-in OPC UA Server. 

 

 
Fig. 150) IoT Platform Setting > OPC UA > Local Server > Server 

Tab. 74) Descriptions: IoT Platform Setting > OPC UA > Local Server > Server 

OPC UA Connection > Local Server – Server 

Server Name  Display the active OPC UA Server name. Not editable. 

System values: ICPDAS_OPC_UA_Server 

Port The communication port number of the OPC UA Server. 

System Default: 48010. 

Save Click to save the settings of this item. 
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Fig. 151) IoT Platform Setting > OPC UA > Local Server > Server Certificate 

 
Tab. 75) Descriptions: IoT Platform Setting > OPC UA > Local Server > Server Certificate 

OPC UA Connection > Local Server – Server Certificate 

Common Name 

Set the content of the self-signed certificate automatically 
generated by the OPC UA Server 

Organization 

Organization Unit 

Locality 

State 

Country 

Certificate Validity (Years) Set the validity period of the certificate (unit year) 

Key Length Set the length of Key (2048) 

IP Set the IP address of the OPC UA Server service 

 
Note: The format of the generated certificate is SHA256. 
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Fig. 152) IoT Platform Setting > OPC UA > Local Server > Security Setting 

Tab. 76) Descriptions: IoT Platform Setting > OPC UA > Local Server > Security Setting 

OPC UA Connection > Local Server – Security Setting 

Security Policy 

Set the message security mode that the OPC UA Server 

opens to the Client. 6 Policy: None, Basic128Rsa15, 

Basic256, Basic256Sha256, Aes128_Sha256_RsaOaep, 

Aes256_Sha256_RsaPss. All default enabled. 

None This policy do not use any security policy. 

Basic128Rsa15 Each policy has 3 selections: 

Sign: Message Signing 

Sign and Encrypt: Message Signing and Encryption 

Sign; Sign and Encrypt: Message Signing; Message 

Signing and Encryption 

Basic256 

Basic256Sha256 

Aes128_Sha256_RsaOaep 

Aes256_Sha256_RsaPss 

 
Fig. 153) IoT Platform Setting > OPC UA > Local Server > Tokens 

Tab. 77) Descriptions: IoT Platform Setting > OPC UA > Local Server > Tokens 

OPC UA Connection > Local Server – User Identity Tokens 

Anonymous Login Check to enable the anonymous login of clients. Default: check. 

User Password 

Login 

Check to enable the user password login of clients. Default: uncheck. 

User Name: If check the “Enabled”, show the User name for setting. 

Password: If check the “Enabled”, show the Password for setting. 

Certificate Login Check to enable the certificate login of clients. Default: uncheck. 

Save Click to save the settings of this item. 
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5.4 Main Menu: Convert Setting 

Convert Setting is the 4th item of the Main Menu for the communication conversion.  

 

There are 4 converting types: OPC UA, MQTT, MQTT JSON & MQTT Custom. Each type has 

some convert settings items for conversion with the Modbus RTU/TCP/ASCII (Master), MQTT, 

EtherNet/IP protocols, the OPC UA with XV Module or Internal virtual converting for the data 

communication, and user custom converting. The function descriptions are on the home page 

of the Main Menu. This chapter will introduce these function items and setting parameters.  

 

 

Fig. 154) CH5.4 Main Menu: Convert Setting 
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The settings of Modbus RTU/ASCII are the same. Here will introduce them together. 

Tab. 78) CH5.4 Convert Setting Function Item Chapter Table 

OPC 

UA  

Use OPC UA Service to convert with Modbus RTU/ASCII protocol. (5.4.1) 

Use OPC UA Service to convert with Modbus TCP protocol. (5.4.2) 

Use OPC UA Service to convert with MQTT protocol. (5.4.3) 

Use OPC UA Service to convert with EtherNet/IP protocol. (5.4.4) 

Use OPC UA Service to convert with XV Module communication. (5.4.5) 

Use OPC UA Service to convert with Internal communication. (5.4.6) 

MQTT  

Use MQTT Service to convert with Modbus RTU/ASCII protocol. (5.4.6) 

Use MQTT Service to convert with Modbus TCP protocol. (5.4.7) 

Use MQTT Service to convert with EtherNet/IP protocol. (5.4.8) 

MQTT 

JSON 

Use MQTT Service in group of JSON format to convert with Modbus 

RTU/ASCII protocol. (5.4.9) 

Use MQTT Service in group of JSON format to convert with Modbus TCP 

protocol. (5.4.10) 

MQTT 

Custom 

IoTCloud: Users can customize the MQTT format layout and add the 

module value to the publishing message. With customized MQTT 

message content, this function can support multiple IoT platforms. (5.4.11) 

 

UA Series Function Diagram: 

 

 

 

 

 

 

 

 

 

 

Application Solution:  

 
 
 
 
 
 
 
 
 
 
 
 

Fig. 155) Convert Setting Function Diagram and Application Solution 
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5.4.1 OPC UA and Modbus RTU/ASCII Conversion 

This page provides OPC UA and Modbus RTU/ASCII (Master) communication protocol 

conversion. With this function, the OPC UA Server can read and write the Modbus RTU / ASCII 

device that connected to the controller. 

 

The settings of Modbus RTU/ASCII are the same. Here will introduce them together. 

 

Function Diagram: 

 
Fig. 156) OPC UA and Modbus RTU/ASCII Convert Setting Function Diagram 

Application Solution: 

 
Fig. 157) OPC UA and Modbus RTU/ASCII Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [OPC UA] > Modbus RTU 

(Master) or Modbus ASCII (Master), the Modbus RTU/ASCII modules preset in the [Module 

Setting] will show up in the Module List. (Refer to Chapter 5.2 for the Module Setting.) 

 

 
Fig. 158) Convert Setting > OPC UA > Modbus RTU > Module List 

 
Tab. 79) Descriptions: Convert Setting > OPC UA > Modbus RTU > Module List  

Convert Setting > OPC UA > Modbus RTU (Master) Module List 

No. The module number in the module list (Not editable here) 

*Module Name / 

Nickname 

The module name set in the module list (Not editable here) 

All Enabled  

Enable  

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

Edit If user wants to enable some I/O channels for conversion, click 

[Edit] of that module to enter the “Variable Tale” setting. It is normal 

to set all channels as enabled, and the conversion will not affect 

the unconnected channels. 

 

The page number of the module list: Current page / Total pages. 

Click < or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “Module Content Setting” page. 
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The “Module Content Setting” page after clicking the [Edit] button: 
 

 
Fig. 159) Convert Setting > OPC UA > Modbus RTU > Module Content 

 
Tab. 80) Descriptions: Convert Setting > OPC UA > Modbus RTU > Module Content 

Convert Setting > OPC UA > Modbus RTU (Master) – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Convert Setting > OPC UA > Modbus RTU (Master) – Variable Table 

Name Display the variable name that set in the Modbus Address Mapping 

Table page (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck.  

OK Click to save this page settings and back to the module list page. 

 
 

When complete the setting, click [OK] to save this page settings and back to the module list 

page. Remember to click [Save] to save the Convert Setting. 
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5.4.2 OPC UA and Modbus TCP Conversion 

This page provides OPC UA and Modbus TCP (Master) communication protocol conversion. 

With this function, the OPC UA Server can read and write the Modbus TCP device that 

connected to the controller. 

 

Function Diagram: 

 

 
Fig. 160) OPC UA and Modbus TCP Convert Setting Function Diagram 

Application Solution: 

 
Fig. 161) OPC UA and Modbus TCP Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [OPC UA] > Modbus TCP 

(Master), the Modbus TCP modules preset in the [Module Setting] will show up in the Module 

List. (Refer to Chapter 5.2 for the Module Setting.) 

 

 
Fig. 162) Convert Setting > OPC UA > Modbus TCP > Module List 

 
Tab. 81) Descriptions: Convert Setting > OPC UA > Modbus TCP > Module List  

Convert Setting > OPC UA > Modbus TCP (Master) Module List 

No. The module number in the module list (Not editable here) 

*Module Name 

/ Nickname 

The module name set in the module list (Not editable here) 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

Edit Click to enter the “Module Content Setting” page to set up and 

enable the I/O. 

 

The page number of the module list: Current page / Total pages. Click 

< or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “Module Content Setting” page. 
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The “Module Content Setting” page after clicking the [Edit] button: 

 

  
Fig. 163) Convert Setting > OPC UA > Modbus TCP > Module Content 

 
Tab. 82) Descriptions: Convert Setting > OPC UA > Modbus TCP > Module Content 

Convert Setting > OPC UA > Modbus TCP (Master) – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Convert Setting > OPC UA > Modbus TCP (Master) – Variable Table 

Name Display the variable name that set in the Modbus Address 

Mapping Table page (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Enabled Check [Enabled] box of the top row can enable all variables in 

list. Check the box of each variable can enable just that variable 

for conversion. Default: Uncheck.  

OK Click to save this page settings and back to the module list page. 

 
 

When complete the setting, click [OK] to save this page settings and back to the module list 

page. And remember to click [Save] to save the Convert Setting. 
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5.4.3 OPC UA and MQTT Conversion 

This page provides OPC UA and MQTT communication protocol conversion. With this function, 

the OPC UA Server can read and write the MQTT device that connected to the controller. 

 

Function Diagram: 

 
Fig. 164) OPC UA and MQTT Convert Setting Function Diagram 

Application Solution: 

  
 

Fig. 165) OPC UA and MQTT Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [OPC UA] > MQTT, the MQTT 

modules preset in the [Module Setting] will show up in the Module List. (Refer to Chapter 5.2 

for the Module Setting.) 

 

 
Fig. 166) Convert Setting > OPC UA > MQTT > Module List 

 
Tab. 83) Descriptions: Convert Setting > OPC UA > MQTT > Module List  

Convert Setting > OPC UA > MQTT - MQTT Module List 

No. The module number in the module list (Not editable here) 

*Module Name 

/ Nickname 

The module name set in the module list (Not editable here) 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

Edit Click to enter the “MQTT Client Setting” page to enable the I/O. 

 

The page number of the module list: Current page / Total pages. Click 

< or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “Module Content Setting” page. 
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[Module Content Setting] page: 

 

 
Fig. 167) Convert Setting > OPC UA > MQTT > Module Content 

 
Tab. 84) Descriptions: Convert Setting > OPC UA > MQTT > Module Content 

Convert Setting > OPC UA > MQTT - MQTT Module List > Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name Give a name, e.g. model number or name. Default: Name. 

Convert Setting > OPC UA > MQTT - MQTT Module List > Variable Table 

No. The module name in the module list (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the MQTT variable. Include: Bool, Short, 

Unsigned Short, Long, Unsigned Long, Float, Double, String. 

Enabled Check [Enabled] box of the top row can enable all variables in 

list. Check the box of each variable can enable just that variable 

for conversion. Default: Uncheck.  

OK / Cancer Click [OK] to save and exit the page settings.  

Click [Cancer] to exit without saving. 

 
 
 
 

  



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

155 

5.4.4 OPC UA and EtherNet/IP Conversion 

This page provides OPC UA and EtherNet/IP communication protocol conversion. With this 

function, the OPC UA Server can read and write the EtherNet/IP EIP-2000 device that 

connected to the controller. 

 

Function Diagram: 

 
Fig. 168) OPC UA and EtherNet/IP Convert Setting Function Diagram 

Application Solution: 

 

  
Fig. 169) OPC UA and EtherNet/IP Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [OPC UA] > EtherNet/IP, the 

EIP-2000 modules preset in the [Module Setting] will show up in the Module List. (Refer to 

Chapter 5.2 for the Module Setting.) 

 

 
Fig. 170) Convert Setting > OPC UA > EtherNet/IP > Module List 

 
Tab. 85) Descriptions: Convert Setting > OPC UA > EtherNet/IP > Module List  

Convert Setting > OPC UA > EtherNet/IP Module List 

No. The module number in the module list (Not editable here) 

Module Name The module name selected in the module list (Not editable here) 

Nickname The user defined name for the module (Not editable here) 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

Edit Click to enter the “Module Content Setting” page to set up and 

enable the I/O. 

 

The page number of the module list: Current page / Total pages. Click 

< or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “Module Content Setting” page. 
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The “Module Content Setting” page after clicking the [Edit] button: 

 

  
 

  
Fig. 171) Convert Setting > OPC UA > EtherNet/IP > Module Content 

 
Tab. 86) Descriptions: Convert Setting > OPC UA > EtherNet/IP > Module Content 

Convert Setting > OPC UA > EtherNet/IP – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Convert Setting > OPC UA > EtherNet/IP – Variable Table 

Name Display the variable name that set in the Modbus Address 

Mapping Table page (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Enabled Check [Enabled] box of the top row can enable all variables in 

list. Check the box of each variable can enable just that variable 

for conversion. Default: Uncheck.  

OK Click to save this page settings and back to the module list page. 

 

When complete the setting, click [OK] to save this page settings and back to the module list 

page. Remember to click [Save] to save the Convert Setting. 
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5.4.5 OPC UA and XV Module Conversion 

This page provides OPC UA and ICP DAS XV module data conversion. With this function, the 

OPC UA Server can read and write the XV module on the controller. 

 

UA series supplies one XV expansion board slot (except the UA-7231). Users can purchase 1 

XV511i module to expand 4 RS-485 ports (UA-5231 series is limited to Rev.B version), or, buy 

one of the XV107/110/111/116/119/303/306/307/310 modules to expand the I/O channels. 

 

When entering the menu [Convert Setting] and the sub-menu [OPC UA] > XV Module, the XV 

module preset in the [Module Setting] will show up in the Module List. (Refer to Chapter 5.2 

for the Module Setting.) 

 
Fig. 172) Convert Setting > OPC UA > XV Module > Module List 

Tab. 87) Descriptions: Convert Setting > OPC UA > XV Module > Module List  

Convert Setting > OPC UA > XV Module > XV Module List 

No. The module number in the module list (Not editable here) 

Module Name The module name selected in the module list (Not editable here) 

Nickname The user defined name for the module (Not editable here) 

Edit Click to enter the “Module Content Setting” page to set up and 

enable the I/O. 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Check the box of each module can enable just that module for 

conversion. Default: Uncheck.  

 

The page number of the module list: Current page / Total pages. Click 

< or > to go to the previous or next page. 

Save Click to save the settings of this page. 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “Module Content Setting” page.    



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

159 

The “Module Content Setting” page after clicking the [Edit] button: 

 

 

  
Fig. 173) Convert Setting > OPC UA > XV Module > Module Content 

Tab. 88) Descriptions: Convert Setting > OPC UA > XV Module > Module Content 

Convert Setting > OPC UA > EtherNet/IP – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Nickname The user defined name for the module (Not editable here) 

Convert Setting > OPC UA > EtherNet/IP – Variable Table 

Name Display the variable name that set in the Modbus Address Mapping 

Table page (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck.  

OK / Cancer Click [OK] to save and exit the page settings.  

Click [Cancer] to exit without saving. 

 

When complete the setting, click [OK] to save this page settings and back to the module list 

page. Remember to click [Save] to save the Convert Setting. 
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5.4.6 OPC UA and Internal Conversion 

The Internal function can create internal modules and variables for virtual reading and writing, 

or as an intermediary to provide data exchange for the communication of OPC UA Clients. 

 

* Internal Variable: max. 8 internal modules; max. 100 internal variables (tags) per module. 

* Protocol Communication Conversion: provide Internal to OPC UA Server conversion. 

 
 
 

Application Solution: 

 

 
Fig. 174) OPC UA and Internal Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [OPC UA] > Internal, the 

internal modules preset in the [Module Setting] will show up in the Module List. (Refer to 

Chapter 5.2 for the Module Setting.) 

 

 
Fig. 175) Convert Setting > OPC UA > Internal > Module List 

Tab. 89) Descriptions: Convert Setting > OPC UA > Internal > Module List  

Convert Setting > OPC UA > Internal - Internal Module List 

No. The module number in the module list (Not editable here) 

Module Name 

/ Nickname 

The module name set in the module list (Not editable here) 

Edit Click to enter the “Internal Client Setting” page to enable the I/O. 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

 

The page number of the module list: Current page / Total pages. Click < or 

> to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “Module Content Setting” page. 
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[Module Content Setting] page: 

 

 
Fig. 176) Convert Setting > OPC UA > XV Module > Module List 

Tab. 90) Descriptions: Convert Setting > OPC UA > XV Module > Module List  

Convert Setting > OPC UA > Internal - Internal Module List > Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name Give a name, e.g. model number or name. Default: Name. 

Convert Setting > OPC UA > Internal - Internal Module List > Variable Table 

Variable Name The Variable name in the module list (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the Internal variable. Include: Bool, Short, 

Unsigned Short, Long, Unsigned Long, Float, Double, String.  

(Not editable here) 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck.  

OK / Cancer Click [OK] to save and exit the page settings.  

Click [Cancer] to exit without saving. 
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5.4.7 MQTT and Modbus RTU/ASCII Conversion 

This page provides MQTT and Modbus RTU/ASCII (Master) communication protocol 

conversion. With the MQTT Service function, users can set the MQTT client to publish the 

message to the specified broker or subscribe the topic, and so to read and write the single 

channel of the Modbus device that connected to the controller. 

 

The settings of Modbus RTU/ASCII are the same. Here will introduce them together. 

For the certificate about the communication security, please refer to Chapter 7. 

 

Function Diagram: 

 
Fig. 177) MQTT and Modbus RTU/ASCII Convert Setting Function Diagram 

Application Solution: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 178) MQTT and Modbus RTU/ASCII Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [MQTT] > Modbus RTU 

(Master) or Modbus ASCII (Master), the Modbus RTU/ASCII modules preset in the [Module 

Setting] will show up in the Module List. (Refer to Chapter 5.2 for the Module Setting.) 

 

 
Fig. 179) Convert Setting > MQTT > Modbus RTU > Module List 

Tab. 91) Descriptions: Convert Setting > MQTT > Modbus RTU > Module List  

Convert Setting > MQTT > Modbus RTU (Master) Module List 

No. The module number in the module list (Not editable here) 

*Module Name 

/ Nickname 

The module name set in the module list (Not editable here) 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

Edit Click to enter the “MQTT Client Setting” page to enable I/O or set up 

the Topic, QoS, Publish, Subscribe … 

 

The page number of the module list: Current page / Total pages. Click 

< or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “MQTT Client Setting” page. 
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The “MQTT Client Setting” page after clicking the [Edit] button: 
 

 
Fig. 180) Convert Setting > MQTT > Modbus RTU > Client Setting 

 
Tab. 92) Descriptions: Convert Setting > MQTT > Modbus RTU > Client Setting  

Convert Setting > MQTT > Modbus RTU (Master) – MQTT Client Setting 

No. The module number in the module list (Un-editable) 

Module Name The module name set in the module list (Not editable here) 

Scan Rate(ms) Set an update frequency for the task data. Default: 1000 (Unit: ms) 

Dead Bend Give a dead bend value for updating a float signal. Default: 0 

Dead Band: The minimum amount by which the tag value must 

change in order for the new tag value to be saved. 

Will Topic Enter the title of a disconnect notice. Default: Null. 

Will  Enter a disconnect notice. Default: Null. 

MQTT 

Connection 

Check the Broker for this MQTT connection, Local Broker or Remote 

Broker. Remote Broker option will appear only when set in advance. 
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Fig. 181) Convert Setting > MQTT > Modbus RTU > Publish & Subscribe 

 
Tab. 93) Descriptions: Convert Setting > MQTT > Modbus RTU > Publish & Subscribe  

Convert Setting > MQTT > Modbus RTU (Master) – Publish & Subscribe 

Details Click [Show] to display all fields, click [Hide] to hide some fields.  

Name The variable name of the mapping address. (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Subscribe Topic The topic of receiving/subscribing data message.  

Subscribe QoS 

The subscribe QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Publish Topic The topic of sending/publishing data message. 

Publish QoS 

The publish QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Retain Check [Retain] box of the top row can store the broker message for 

all variables in list. Check the box of each variable can store the broker 

message just that variable. Default: Uncheck. 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck. 

OK Click to save this page settings and back to the module list page. 
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5.4.8 MQTT and Modbus TCP Conversion 

This page provides MQTT and Modbus TCP (Master) communication protocol conversion. With 

the MQTT Service function, users can set the MQTT client to publish the message to the 

specified broker or subscribe the topic, and so to read and write the single channel of the 

Modbus device that connected to the controller. 

 

For the certificate about the communication security, please refer to Chapter 7. 

 

Function Diagram: 

 
Fig. 182) MQTT and Modbus TCP Convert Setting Function Diagram 

Application Solution: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 183) MQTT and Modbus TCP Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [MQTT] > Modbus TCP 

(Master), the Modbus TCP modules preset in the [Module Setting] will show up in the Module 

List. (Refer to Chapter 5.2 for the Module Setting.) 

 

 
Fig. 184) Convert Setting > MQTT > Modbus TCP > Module List 

 
Tab. 94) Descriptions: Convert Setting > MQTT > Modbus TCP > Module List  

Convert Setting > MQTT > Modbus RTU (Master) Module List 

No. The module number in the module list (Not editable here) 

*Module Name 

/ Nickname 

The module name set in the module list (Not editable here) 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

Edit Click to enter the “MQTT Client Setting” page to enable I/O or set up 

the Topic, QoS, Publish, Subscribe … 

 

The page number of the module list: Current page / Total pages. Click 

< or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “MQTT Client Setting” page. 
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The “MQTT Client Setting” page after clicking the [Edit] button: 
 

 
Fig. 185) Convert Setting > MQTT > Modbus TCP > Client Setting 

 
Tab. 95) Descriptions: Convert Setting > MQTT > Modbus TCP > Client Setting  

Convert Setting > MQTT > Modbus TCP (Master) – MQTT Client Setting 

No. The module number in the module list (Un-editable) 

Module Name The module name set in the module list (Not editable here) 

Scan Rate(ms) Set an update frequency for the task data. Default: 1000 (Unit: ms) 

Dead Bend Give a dead bend value for updating a float signal. Default: 0 

Dead Band: The minimum amount by which the tag value must 

change in order for the new tag value to be saved. 

Will Topic Enter the title of a disconnect notice. Default: Null. 

Will  Enter a disconnect notice. Default: Null. 

MQTT 

Connection 

Check the Broker for this MQTT connection, Local Broker or Remote 

Broker. Remote Broker option will appear only when set in advance. 
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Fig. 186) Convert Setting > MQTT > Modbus TCP > Publish & Subscribe 

 
Tab. 96) Descriptions: Convert Setting > MQTT > Modbus TCP > Publish & Subscribe  

Convert Setting > MQTT > Modbus TCP (Master) – Publish & Subscribe 

Details Click [Show] to display all fields, click [Hide] to hide some fields.  

Name The variable name of the mapping address. (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Subscribe Topic The topic of receiving/subscribing data message.  

Subscribe QoS 

The subscribe QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Publish Topic The topic of sending/publishing data message. 

Publish QoS 

The publish QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Retain Check [Retain] box of the top row can store the broker message for 

all variables in list. Check the box of each variable can store the broker 

message just that variable. Default: Uncheck. 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck. 

OK Click to save this page settings and back to the module list page. 
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5.4.9 MQTT and EtherNet/IP Conversion 

This page provides MQTT and EtherNet/IP communication protocol conversion. With this 

MQTT Service function, users can set the MQTT client to publish the message to the specified 

broker or subscribe the topic, and so to read and write the single channel of the ICP DAS EIP-

2000 device that connected to the controller. 

 

For the certificate about the communication security, please refer to Chapter 7. 

 

Function Diagram: 

 
Fig. 187) MQTT and EtherNet/IP Convert Setting Function Diagram 

Application Solution: 

 
Fig. 188) MQTT and EtherNet/IP Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [MQTT] > EtherNet/IP, the ICP 

DAS EtherNet/IP modules EIP Series preset in the [Module Setting] will show up in the 

Module List. (Refer to Chapter 5.2 for the Module Setting.) 

 

 
Fig. 189) Convert Setting > MQTT > EtherNet/IP > Module List 

 
Tab. 97) Descriptions: Convert Setting > MQTT > EtherNet/IP > Module List  

Convert Setting > MQTT > EtherNet/IP Module List 

No. The module number in the module list (Not editable here) 

Module Name The EIP series model selected in the module list (Not editable here) 

Nickname The user defined name for the module (Not editable here) 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for conversion. 

Default: Uncheck.  

Check the box of each module can enable just that module for 

conversion. 

Edit Click to enter the “MQTT Client Setting” page to enable I/O or set up 

the Topic, QoS, Publish, Subscribe … 

 

The page number of the module list: Current page / Total pages. Click 

< or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, please check the 

box of the converting module. If user wants to enable some I/O of the module, please 

click [Edit] button to enter the “MQTT Client Setting” page. 
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The “MQTT Client Setting” page after clicking the [Edit] button: 
 

 
Fig. 190) Convert Setting > MQTT > EtherNet/IP > Client Setting 

 
Tab. 98) Descriptions: Convert Setting > MQTT > EtherNet/IP > Client Setting  

Convert Setting > MQTT > EtherNet/IP – MQTT Client Setting 

No. The module number in the module list (Un-editable) 

Module Name The module name set in the module list (Not editable here) 

Scan Rate(ms) Set an update frequency for the task data. Default: 1000 (Unit: ms) 

Dead Bend Give a dead bend value for updating a float signal. Default: 0 

Dead Band: The minimum amount by which the tag value must 

change in order for the new tag value to be saved. 

Will Topic Enter the title of a disconnect notice. Default: Null. 

Will  Enter a disconnect notice. Default: Null. 

MQTT 

Connection 

Check the Broker for this MQTT connection, Local Broker or Remote 

Broker. Remote Broker option will appear only when set in advance. 
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Fig. 191) Convert Setting > MQTT > EtherNet/IP > Publish & Subscribe 

Tab. 99) Descriptions: Convert Setting > MQTT > EtherNet/IP > Publish & Subscribe  

Convert Setting > MQTT > EtherNet/IP – Publish & Subscribe 

Details Click [Show] to display all fields, click [Hide] to hide some fields.  

Name The variable name of the mapping address. (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Subscribe Topic The topic of receiving/subscribing data message.  

Subscribe QoS 

The subscribe QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Publish Topic The topic of sending/publishing data message. 

Publish QoS 

The publish QoS (Quality of Service) levels. Default: 2 

0: Delivering a message at most once. 

1: Delivering a message at least once. 

2: Delivering a message at exactly once. 

Retain Check [Retain] box of the top row can store the broker message for 

all variables in list. Check the box of each variable can store the broker 

message just that variable. Default: Uncheck. 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck. 

OK Click to save this page settings and back to the module list page. 
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5.4.10 MQTT JSON and Modbus RTU/ASCII Conversion 

This page provides MQTT JSON and Modbus RTU/ASCII (Master) communication protocol 

conversion. With the MQTT Service function, users can set the MQTT client to publish the 

message to the specified broker or subscribe the topic, and combine several messages that 

converted in JSON format into a group to read and write the multiple channels of the Modbus 

RTU/ASCII devices that connected to the controller. 

 

The settings of Modbus RTU/ASCII are the same. Here will introduce them together. 

For the certificate about the communication security, please refer to Chapter 7. 

 

Function Diagram: 

 
Fig. 192) MQTT JSON and Modbus RTU/ASCII Convert Setting Function Diagram 

Application Solution: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 193) MQTT JSON and Modbus RTU/ASCII Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [MQTT JSON] > Modbus RTU 

or Modbus ASCII (Master), the Modbus RTU/ASCII modules preset in the [Module Setting] 

will show up in the Module List. (Refer to Chapter 5.2 for the Module Setting.) 

 

 
Fig. 194) Convert Setting > MQTT JSON > Modbus RTU > Module List 

Tab. 100) Descriptions: Convert Setting > MQTT JSON > Modbus RTU > Module List  

Convert Setting > MQTT JSON > Modbus RTU (Master) Module List 

No. The module number in the module list (Not editable here) 

*Module Name / 

Nickname 

The module name set in the module list (Not editable here) 

Connection Name Select a group connection name, and then click [Apply]. 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for 

conversion. Default: Uncheck. Check the box of each module 

can enable just that module for conversion. 

Edit If user wants to enable some I/O channels for conversion, click 

[Edit] of that module to enable I/O or check the “Module Content 

Setting” and “Variable Tale” page. 

 

The page number of the module list: Current page / Total pages. 

Click < or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, first select the 

[Connection Name] and click [Apply] button, and then check the box   of the 

converting module. If user wants to enable some I/O of the module, please click [Edit] 

button to enter the “Module Content Setting” page. 
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Fig. 195) Convert Setting > MQTT JSON > Modbus RTU > Module Content 

Tab. 101) Descriptions: Convert Setting > MQTT JSON > Modbus RTU > Module Content 

Convert Setting > MQTT JSON > Modbus RTU (Master) – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Convert Setting > MQTT JSON > Modbus RTU (Master) – Variable Table 

Details Click [Show] to display all fields, click [Hide] to hide some fields.  

Variable Name The variable name of the mapping address. (Not editable here) 

Alias The user cannot change the variable name but can set an alias for 

data separation and identification. It is used in the "Name" element 

parameter of the MQTT JSON format. Refer to Appendix A. 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Connection Name Select the group name that set in the group list page. 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck. 

OK Click to save this page settings and back to the module list page. 
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5.4.11 MQTT JSON and Modbus TCP Conversion 

This page provides MQTT JSON and Modbus TCP (Master) communication protocol 

conversion. With the MQTT Service function, users can set the MQTT client to publish the 

message to the specified broker or subscribe the topic, and combine several messages that 

converted in JSON format into a group to read and write the multiple channels of the Modbus 

TCP devices that connected to the controller. 

 

For the certificate about the communication security, please refer to Chapter 7. 

 

Function Diagram: 

 
Fig. 196) MQTT JSON and Modbus TCP Convert Setting Function Diagram 

Application Solution: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 197) MQTT JSON and Modbus TCP Convert Setting Application Solution 
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When entering the menu [Convert Setting] and the sub-menu [MQTT JSON] > Modbus TCP 

(Master), the Modbus TCP modules preset in the [Module Setting] will show up in the Module 

List. (Refer to Chapter 5.2 for the Module Setting.) 

 

 
Fig. 198) Convert Setting > MQTT JSON > Modbus TCP > Module List 

Tab. 102) Descriptions: Convert Setting > MQTT JSON > Modbus TCP > Module List  

Convert Setting > MQTT JSON > Modbus TCP (Master) Module List 

No. The module number in the module list (Not editable here) 

*Module Name / 

Nickname 

The module name set in the module list (Not editable here) 

Connection Name Select a group connection name, and then click [Apply]. 

Edit If user wants to enable some I/O channels for conversion, click 

[Edit] of that module to enter the “Module Content Setting” and 

“Variable Tale” page. 

All Enabled  

Enable 

Check [All Enabled] box to enable all modules in list for 

conversion. Default: Uncheck. Check the box of each module 

can enable just that module for conversion. 

 

The page number of the module list: Current page / Total pages. 

Click < or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 

This function is to enable the communication conversion module, first select the 

[Connection Name] and click [Apply] button, and then check the box   of the 

converting module. If user wants to enable some I/O of the module, please click [Edit] 

button to enter the “Module Content Setting” page. 
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Fig. 199) Convert Setting > MQTT JSON > Modbus TCP > Module Content 

Tab. 103) Descriptions: Convert Setting > MQTT JSON > Modbus TCP > Module Content 

Convert Setting > MQTT JSON > Modbus TCP (Master) – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Convert Setting > MQTT JSON > Modbus TCP (Master) – Variable Table 

Details Click [Show] to display all fields, click [Hide] to hide some fields.  

Variable Name The variable name of the mapping address. (Not editable here) 

Alias The user cannot change the variable name but can set an alias for 

data separation and identification. It is used in the "Name" element 

parameter of the MQTT JSON format. Refer to Appendix A. 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Connection 

Name 

Select the group name that set in the group list page. 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck. 

OK Click to save this page settings and back to the module list page. 
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5.4.12 MQTT Custom and IoT Cloud Conversion 

This page provides customized MQTT communication conversion for the IoT Cloud Platform. 

Users can customize the MQTT format layout and add the module value to the publishing 

message. With customized MQTT message content, this function can support multiple IoT 

platforms. 

 

For the certificate about the communication security, please refer to Chapter 7. 

 

Function Diagram: 

 
Fig. 200) MQTT Custom and IoT Cloud Convert Setting Function Diagram 
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Enter the menu [Convert Setting] and the sub-menu [MQTT Custom] > [IoT Cloud], then can 

set up the customized MQTT IoT Cloud settings. 

 

 
Fig. 201) Convert Setting > MQTT Custom> IoT Cloud > List 

 
Tab. 104) Descriptions: Convert Setting > MQTT Custom > IoT Cloud > List  

Convert Setting > MQTT Custom > IoTCloud – MQTT IoT Cloud List 

No. The number in the IoT Cloud list (Not editable here) 

*Setting Name / 

Nickname 

The Setting name or Nickname set in the IoT Cloud list (editable) 

Edit Click the [Edit] button to enter the Module List, select the module 

and set up the message to be published. 

Connection Name Select a connection name set in the step of the “IoT Platform”, 

and then click [Apply]. 

Enabled   Check the box of list to enable that conversion. Default: Enable 

 

The page number of the list: Current page / Total pages. Click < 

or > to go to the previous or next page. 

Save Click to save the settings of this page. 
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Click [Edit] button to enter the Module List page, the modules preset in the [Module Setting] 

will show up in the selected items. (Refer to Chapter 5.2 for the Module Setting.) 

 

 

Fig. 202) Convert Setting > MQTT Custom> IoT Cloud > List Edit 
 

Tab. 105) Descriptions: Convert Setting > MQTT Custom > IoT Cloud > List Edit 

Convert Setting > MQTT Custom > IoT Cloud – MQTT IoT Cloud Module List 

No. The number in the IoT Cloud setting list (Cannot be changed here) 

Setting Name The setting name set in the IoT Cloud list, can change it here. 

Type The user can find out the variable name of the current module tags 

through the following steps:  

1. Select the type of module. 

2. Select the number of the set module you want to use. 

3. Select the module name you want to use. 

4. Select the tag attribute of the module. 

5. Select the tag name of the module. 

No. 

Name 

Attribute 

Tag Name 

Insert 
Click "Insert" to add the variable name of the module tag to the "Send 

Message" field. 

Send Message 
Message format editing interface, user can click the insert button to add 

I/O tags and then edit the messages. 

OK / Cancel 
Click [OK] to save the settings of this page, and exit. 

Click [Cancel] to exit this page but do not save the settings. 
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5.5 Main Menu: Advanced Setting 

Advanced Setting is the fifth (5th) item of the Main Menu, mainly to provide advanced 

monitoring and control related settings. 

 

Advanced Setting provides virtual device function or cloud service function. The description is 

on the page of the Main Menu. It will support more functions in the future. 

The items in the advanced setting functions are “PID Operation” and “IFTTT Condition 

Trigger” and “Data Logger” that includes “Local Data Logger”, “MS SQL” and “MySQL / 

MariaDB”. This chapter will introduce the function items and setting parameters. 

 

 
Fig. 203) CH5.5 Main Menu: Advanced Setting 

 

 

The setting for UA series controllers is to set up from the left to the right of the main menu 

functions. User can find the setting step and Web UI information in the following chapters. 

   CH2 Quick Start 1: Hardware/Network Connection  

   CH3 Quick Start 2: Web UI / Setting Steps   

   CH4 Function Wizard: Project Quick Setup  
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5.5.1 PID Operation 

This page is about the virtual device function to allow users to simulate various devices with 

the real I/O by using the tuning function of PID operation.  

 

Fig. 204) Advanced Setting > PID Operation 

PID (Proportional-Integral-Derivative) control is the most widely used in industrial control 

systems. A regulator which is controlled in accordance with Proportional, Integral and 

Derivative is called PID control for short, also called PID regulator. When the user cannot fully 

grasp or measure parameters of the control system, the PID regulator is the best solution. 

 

The PID controller is a common feedback loop component in industrial control applications. 

The controller compares the collected data with a reference value and then uses this difference 

to calculate a new input value whose purpose is to allow the system data to reach or remain at 

the reference value. 

 

Function Diagram: 

 

Fig. 205) PID Operation Function Diagram 
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PID Operation Solution Example:  

 

 
Fig. 206) PID Operation Solution Example 

In the PID Operation function, UA controller collects the module’s data to operate via the 

feedback loop component of PID control. The controller compares the collected data with a 

reference value and then uses this difference to calculate a new input value whose purpose is 

to allow the system data to reach or remain at the reference value. 

 

The setting steps of the PID Operation are as below. The descriptions for the steps setting 

please refer to Section 4.4 “PID” items in the Function Wizard.  

 

[Step Box] of [PID Operation] : 

 

[Step Box] of [PID Operation + OPC UA Conversion] :  

 

Fig. 207) PID Operation Step Box 

 

This section will introduce the function items and setting parameters of the PID Operation. 

 

  



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

187 

 

 
Fig. 208) Advanced Setting > PID Operation > PID List 

 
Tab. 106) Descriptions: Advanced Setting > PID Operation > PID List  

Advanced Setting > PID Operation > PID List 

PID Name PID name, user can define, e.g. Task1. Default: Task. 

 Click to add a new PID Task.  

Edit / Remove Click [Edit] can set the PID content.  

Click the left box and [remove] can delete the PID list. 

 

The page number of the PID list: Current page / Total pages. Click < or 

> to go to the previous or next page. 

Save Click to save the setting of this page. 

 

 

Click [Edit] botton to enter the [Content Settings] page: 

 

 
Fig. 209) Advanced Setting > PID Operation > Content 

 
Tab. 107) Descriptions: Advanced Setting > PID Operation > Content 

Advanced Setting > PID Operation > Content Settings 

PID Name PID name, user can define, e.g. Task1. Default: Task. 
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Fig. 210) Advanced Setting > PID Operation > Input Item 

 
Tab. 108) Descriptions: Advanced Setting > PID Operation > Input Item 

Advanced Setting > PID Operation > Input Item 

Module 

selection 

Choose a predefined module for input data of the PID. Select the 

type, number and name of the input module. If no option is available, 

add a new module. 

Variable 

selection 

Choose a predefined float variable as the input parameter for PID 

operation. Select the attribute, type and name of the float variable. 

Auto Tune Enable: Auto-tuning PID parameters for your system. Default: check. 

Un-Enable: Tuning PID parameters manually, e.g. Kp, Ki, Kd. 

Sample Time 

(ms) 

Set the sampling time. (Unit: ms) Default: 500 ms. 

Setpoint The target value for PID control. Default: 0. 

Controller Mode DIRECT: Set it as positive output value. Default: DIRECT. 

REVERSE: Set it as reverse output value. 

Kp Set the Proportional gain. Default: 1. 

Ki Set the Integral gain. Default: 1. 

Kd Set the Derivative gain. Default: 1. 
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Fig. 211) Advanced Setting > PID Operation > Output Item 

 
Tab. 109) Descriptions: Advanced Setting > PID Operation > Output Item 

Advanced Setting > PID Operation > Output Item 

Module 

selection 

Choose a predefined module for output data of the PID. Select the type, 

number and name of the input module. If no option is available, add a 

new module. 

Variable 

selection 

Choose a predefined float variable as the output parameter for PID 

operation. Select the attribute, type and name of the float variable. 

Max Set the upper-limit value for the variable. Default: 0. 

Min Set the lower-limit value for the variable. Default: 0. 

OK Click to save the settings of the page and back to the PID list page. 

 

PID Operation Solution Example:  

 

Fig. 212) PID Operation Application 
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5.5.2 IFTTT Condition Trigger 

This page is about use the IFTTT cloud platform function. Combine with the IFTTT Condition 

Trigger function, when the special events occur, the users can send messages to IFTTT-related 

cloud services (such as Line, Twitter, etc.). 

 

 
Fig. 213) Advanced Setting > IFTTT Condition Trigger 

 

IFTTT (if this then that) is a cloud service platform that easy to get your apps and devices 

working together via creating chains of simple conditional statements (applets). An applet is 

triggered by changes that occur within other web services such as Line, Twitter, Gmail, 

Instagram, etc. For example, “if” Line (Service A) has a new message, “then” send an email to 

Gmail (Service B).  

 

UA using the IFTTT cloud platform functions, the users can send messages to cloud services 

such as Line, Twitter, etc. when the special events occur. 

 

  

 

 
Fig. 214) Advanced Setting > IFTTT Condition Trigger Function Diagram 
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The settings for sending the message to the APP with the "IFTTT Condition Trigger (Line, 

Twitter)" function includes two parts: 

 

1. IFTTT Cloud Platform Setting: (Refer to FAQ-app-1.) 

In the IFTTT website, set up the “if” side service and event (this: use webhooks for the 

UA), the “then” side service and action (that: user can select the service, such as the Line, 

twitter, etc.). And then fill the “Event Name” and “Key” getting from the IFTTT website 

setting into the “Content Setting” of the UA We HMI. (Detail in the FAQ-app-1 & FAQ List.) 

 

 

2. UA Web Interface Setting: (Sec.5.5.2 Advanced Setting > IFTTT Condition Trigger) 

In the UA Web HMI, set up the UA controller, modules, IFTTT trigger conditions, the 

condition variable table, and the IFTTT event connection. (Fill the Event Name and Key 

from IFTTT website into the “Content Setting” of the UA Web UI.) 

 

 

This section introduces the setting part on the UA Web Interface, including the IFTTT trigger 

condition, variable table and the event message. About the setting on the IFTTT Cloud Platform, 

user can set up on the IFTTT website and get the “Event Name” and “Key” for the configuration 

here. If you are not familiar about the IFTTT, please refer to the FAQ-app-1 & FAQ List. 

 

For the whole steps to send the message to an APP from setting the UA controller, module, I/O 

variables to the IFTTT Condition Trigger, the users can refer to the Section 4.5 and the step 

box below.  

 

[Step Box : IFTTT Condition Trigger (Line, Twitter)]:  

 
Fig. 215) Advanced Setting > IFTTT Condition Trigger (Line, Twitter) Step Box 

 
This section will introduce the setting of the IFTTT condition trigger list, variable table and the 
event message. 
 

  

http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
http://www.icpdas.com/en/faq/index.php?kind=326#923
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
http://www.icpdas.com/en/faq/index.php?kind=326#923
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Fig. 216) Advanced Setting > IFTTT Condition Trigger > List 

Tab. 110) Descriptions: Advanced Setting > IFTTT Condition Trigger > List  

Advanced Setting > IFTTT Condition Trigger > FTTT Condition Trigger List 

Add Message Click to add a new IFTTT message. After setting, an IFTTT condition 

trigger list will show on the bottom, includes left box, event name, key 

and status. 

 Check the box in the left of the list is to select and to delete the list. 

Check the box on the top will select all lists. 

Event Name Display the “Event Name” setting in the IFTTT website. (FAQ-app-1) 

Key Display the “Key” getting from the IFTTT website. (FAQ-app-1) 

Edit Click [Edit] can set the IFTTT condition trigger content.  

Status Display the enable status of the IFTTT condition trigger list. 

Remove Click the left box and [remove] can delete the IFTTT list. 

 

The page number of the IFTTT list: Current page / Total pages. Click < 

or > to go to the previous or next page. 

Save Click to save the setting of this page. 

 

Click [Add Message] botton to enter the IFTTT [Content Settings] page: 

 

Fig. 217) Advanced Setting > IFTTT Condition Trigger > Content 
Tab. 111) Descriptions: Advanced Setting > IFTTT Condition Trigger > Content 

Advanced Setting > IFTTT Condition Trigger > Content Setting 

Event Name Input the “Event Name” setting in the IFTTT website. (FAQ-app-1) 

Key Input the “Key” getting from the IFTTT website. (FAQ-app-1) 

Status Check to enable the IFTTT condition trigger event. 

 

Note: The “Event Name” and “Key” are set in the IFTTT website. If you are not familiar with 

IFTTT, please see the FAQ-005 for the setting introductions.  

http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
http://www.icpdas.com/web/product/download/iiot/ua/faq/FAQ-en-app-01.pdf
https://www.icpdas.com/web/product/download/iiot/ua/faq/UA-en-FAQ-005.pdf
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The condition setting field may different depending on the selected variable attribute. 

 
Fig. 218) Advanced Setting > IFTTT Condition Trigger > Condition Setting 

 
Tab. 112) Descriptions: Advanced Setting > IFTTT Condition Trigger > Condition Setting 

Advanced Setting > IFTTT Condition Trigger > Condition Setting 

Module 

Variables 

Select the module and variable for the condition trigger. 

Module Type: select the module type, Modbus RTU/TCP/ASCII… 

Module Name: select the module that set for condition trigger.  

Variable Attribute: select the variable attribute for condition trigger. 

Variable Name: select the variable name for condition trigger. 

The following condition fields may different depending on the selected variable attribute. 

The condition trigger method will be descripted after this table. 

Operator Select the operator for the trigger condition. 

Value Set up the value for the condition, include Type and Dead Band. 

Status Set up the status for the condition. Default: 0. 

Add Click to add a condition trigger list in the Condition Table.. 
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Condition Trigger Descriptions:  

 

The condition trigger method will different depending on the attribute of the selected variable 

and the trigger will be different. There are two operation styles: DIO and AIO. 

 

 

 

(A) If select DIO variable, then Condition is “Status Change”. When detecting the status is changed, 

it will trigger the event and send the assigned message. (Below is a switch detecting example.) 

 
Fig. 219) Conditional Trigger Method: Variable DIO 

 

 

DIO Trigger: (Detect per 500 ms) 

 

1. Detect initial switch status "Off" (status = 0) 

2. Detect "Off" (status = 0, status no change), no trigger 

3. Detect "On" (status = 1, status changed), trigger a message notification 

4. Detect "On" (status = 1, status no change), no trigger 

5. Detect "Off" (status = 0, status changed), trigger a message notification 

 

 

  

On/Off 

Time (ms) 

3. Trigger 

5. Trigger 
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(B) If select AIO variable, then Condition is “Value” and can set the “Dead Band”. The condition 

will be triggered and send the message when the detected value exceeds the upper or 

lower Dead Band. (Below is a CO2 example. Detect per 500 ms) 

 

    
Fig. 220) Conditional Trigger Method: Variable AIO 

 
 

AIO Trigger:  (Detect per 500 ms. The yellow block means the Dead Band.) 

 

1. Detect initial CO2 concentration 600 (ppm).  

   Set Dead Band=400 (Initial Trigger Condition: >= 1000 or <= 200) 

2. Detect CO2 concentration 800. It is in the range of Dead Band.  

3. Detect CO2 concentration 1100. It exceeds the upper value (>= 1000) of Dead Band,  

   so trigger a message for danger notification.  

4. Detect CO2 concentration 1100. It is in the new range of Dead Band.  

   Dead Band=400 (New Trigger Condition: >= 1500 or <= 700) 

5. Detect CO2 concentration 650. It is below the lower value (<= 700) of Dead Band,  

   so trigger a message for safety notification.  

 

 

  

3. Trigger 

5. Trigger 
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Please refer to the previous Condition Trigger Descriptions to set up your Condition. 

When complete, click the “Add” button. The setting will show in the Condition Table. 

Below Table is setting 2 conditions.  

 

 
Fig. 221) Advanced Setting > IFTTT Condition Trigger > Condition Table 

Tab. 113) Descriptions: Advanced Setting > IFTTT Condition Trigger > Condition Table 

Advanced Setting > IFTTT Condition Trigger > Condition Table 

Module Display the module type and name of the condition. (Not editable here) 

Variable Display the variable attribute and name of the condition. (Not editable 

here) 

Condition Display the trigger condition. (Not editable here) 

Define 

Message 

Default Message: module code variable code. The user can define own 

message in the format of English character, number, general symbol… 

Remove Click the left box and [remove] can delete the IFTTT list. 

OK Click to save this page settings and back to the module list page. 

Cancel Click to exit without saving and back to the module list page. 

 

When back to the IFTTT Condition Trigger List, the condition trigger message will show 

as below picture. If need more trigger conditions, click the “Add Message” again to 

combine the IFTTT APP message sending and the UA system. At last, click the Save 

button.  

 
Fig. 222) Advanced Setting > IFTTT Condition Trigger  Completed Setting Picture 



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

197 

5.5.3 Data Logger: Local Data Logger 

UA's Local Data Logger function can automatically record the I/O status at setting intervals and 

save them in a CSV file on the local microSD card. 

 

This function is for setting the local data logger and the microSD card. For the setting about 

the logger and module, please refer to Chapter 5.6. 

 

When the local data logger function is running, the system will allocate memory as a 

read/write file cache temporarily. When the function runs for a long time, it will increase 

the memory resource utilization. This situation is normal and does not affect the long-

term stability of UA operation. 

 

Function Diagram: 

 

Fig. 223) Local Data Logger Function Diagram 

Application: 

 

Fig. 224) Local Data Logger Application 
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Enter the main menu [Advanced Setting] > [Data Logger] > [Local Data Logger]:  

 

 
Fig. 225) Advanced Setting > Data Logger - Local Data Logger 

Tab. 114) Descriptions: Advanced Setting > Data Logger - Local Data Logger 

Advanced Setting > Data Logger > Local Data Logger 

Folder Name  The folder name in microSD card of UA, user definable. The I/O 

data will save into the file “log.csv” under this folder. 

File Length Unit: hour. User can select per 1, 2, 3, … 8, 12, or 24 hours to 

divide the log.csv into the file “log-Y-M-D-H-M-S.csv” under the 

folder “Y-M”. (e.g. 2018-12) 

Log Interval The interval to save I/O data per seconds, minutes or hours. 

Time Alignment Align records time at selected log intervals (default: unchecked). 

When enabling the Time Alignment, it will record the first log at 

the beginning time. And will align other log times with multiples of 

the log interval (seconds, minutes, hours). For example, if the log 

interval is 5 seconds, the first log time is 13:01:04, and the 

following log records will be 13:01:05, 13:01:10, etc., the seconds 

being multiples of 5 seconds. 

Max SD Card 

Usage Rate (%) 

Set up the maximum usage rate (Unit: %) of UA microSD card. If 

the data current rate meet the max rate, the oldest data will be 

removed first. 

SD Card Currently 

Usage Rate 

Display the current usage rate of UA microSD card (show %). 

SD Card Mount: Click to mount microSD card and begin to record data. 

Unmount: Click to unmount microSD card and stop record data. 

Save Click to save the settings of this item. 
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 CVS local data log file: fields and example 

 

1. The Log record will be stored to the microSD card in the UA PAC, and the default name is 

the folder “Datalog” which can be customized by the user. 

2. I/O data records will be stored in the file “log.csv” under this folder. 

3. The log data file is divided every 1, 2, 3… 8, 12 or 24 hours according to user settings, 

and saved under the folder "YYYY-MM". 

4. Save to the file "log-YYYY-MM-DD-HH-MM-SS.csv". Each tag data and status are 

recorded in each separate row, the row is added down for each interval, and the tag 

data is recorded in time sequence. 

 

 
Fig. 226) Advanced Setting > Data Logger - Local Data Logger Setting Steps 

Tab. 115) Descriptions: Advanced Setting > Data Logger - Local Data Logger  “log.cvs” 

  

[ EX ] Folder Name: [Datalog] 

Save I/O data per 10 sec to the file [log.csv]. 

Divide file per 1 hr to the folder of [Y-M-folder]  

into the file [log-Y-M-D-H-M-S.csv]  

File Name 

File Name 
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5.5.4 Data Logger: MS SQL 

UA's: MS SQL data logger function can automatically record I/O status at setting intervals, and 

write the data directly to remote MS SQL databases. 

 

This function is for setting the remote database connection. For the setting about the logger 

and module, please refer to Chapter 5.6. 

 

Function Diagram: 

 
Fig. 227) Remote Database Function Diagram 

Application: 

 

Fig. 228) Remote Database Application 
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Enter the main menu [Advanced Setting] > [Data Logger] > [MS SQL] screen, enter a Name 
(e.g. “ICPDAS_Cycle_DateTime”), and click the plus sign to add a MS SQL remote 
database list as below.  

 

 
Fig. 229) Advanced Setting > Data Logger – MS SQL > List 

Tab. 116) Descriptions: Advanced Setting > Data Logger - MS SQL > List 

Advanced Setting > Data Logger > MS SQL List 

 Remove  
Check Remove box to remove all database connection in list.  

Check the box of each database and click the “Remove” button 

can remove just that database connection. 

Identification Name User defined name to identify the remote database.  

Default: Name. 

Status Display the status (Enable/Disable) of the database connection. 

Default: Enable. 

 Click to add a new remote database connection.  

Edit Click to enter the “Content Setting” page of the remote 

database. 

 

The page number of the database list: Current page / Total 

pages. Click < or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 
Click “Edit” to enter the “MS SQL connect settings” page. 
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Fig. 230) Advanced Setting > Data Logger – MS SQL > Content 

Tab. 117) Descriptions: Advanced Setting > Data Logger - MS SQL > Content 

Advanced Setting > Data Logger > MS SQL – Content Setting 

Identification Name User defined name to identify the database. 

Database Name The name of the remote database. If not exist, It will create one. 

Table Name The table name of the remote DB. If not exist, It will create one. 

Server Name The Server IP and name of the remote database.  

Port The port to link with database. Default: 1433 (for MS SQL) 

Account The login name of the remote database. 

Password The login password of the remote database. 

Log Mode Cycle: Record one log data at the interval time (set below). 

Cycle-Time Alignment: Cycle mode with Time Alignment. 

Time Alignment is to align records time at the selected interval. It 

will record the first log at the beginning time. And will align other 

log times with multiples of the log interval (seconds, minutes, 

hours). For example, if the log interval is 5 seconds, the first log 

time is 13:01:04, and the following log records will be 13:01:05, 

13:01:10, etc., the seconds being multiples of 5 seconds. 

Data Change: Only record when the data has changed. 

Interval Seconds Set up the interval time to save the I/O data to the remote 

database. Unit: Second. 

Date Time Format Select to separate the date and time into two [Columns] or 

combine the date and time in one [Column]. 
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Advanced Setting > Data Logger > MS SQL – Content Setting 

Offline Data Recovery 

(Note 1) 

Check to enable the Offline Data Recovery (Note 1). If the 

database is offline, UA will temporarily store the data in the SD 

card. When the connection is online, UA will retrieve the data from 

the SD card and re-sent it to the database. (Default: unchecked) 

Enable Enable the data logger to the remote database. Default: check. 

Test Connection Click to test the connection to the remote database.  

Result: Success or Failure.  

OK / Cancel Click “OK” to save the settings of this page. 

Click “Cancel” to exit the setting page without saving. 

 
Note 1. 

 Offline Data Recovery Mechanism 

For general data collection, the sensor data will be sent to the control center and imported into 

the Database at cloud. But when the network experience a disconnection, the data transmitted 

during the offline period will be lost. UA Series supports the Offline Data Recovery mechanism. 

When experiences network disconnection, all data will be stored in the SD cards in UA Series. 

And when the network return to normal status, the data stored in SD card will be re-sent to UA, 

and imported into Database to ensure the integrity of historical data. 

 

 
Fig. 231) Offline Data Recovery Data Record Diagram 

 
When offline occurs, the data storage capacity of the 4GB SD card and the time to write data 
back to SQL after online again: 
 
Tab. 118) Data storage capacity and the time to write data back after online again 

         1000 Tags 

Log Interval 

Data amount 
for offline 1 hr. 

Time to write data to 
SQL after offline 1 hr. 

Time capacity  
of 4 GB SD card 

10 Seconds 22.4 MB 28 Minutes 5.5 Days (132 Hours) 

30 Seconds 7.47 MB 9.34 Minutes 16.5 Days (396 Hours) 

1 Minute 3.73 MB 4.67 Minutes 33 Days (732 Hours) 

5 Minutes 0.47 MB 0.94 Minutes 165 Days (3960 Hours) 
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 MS SQL Remote Database Example Descriptions:  

 

Each tag data and status are recorded in each separate row, the row is added down for 

each interval, and the tag data is recorded in time sequence. 

 

For database operation, please refer to FAQ-Dev-001 of the UA series FAQ list:  

FAQ-Dev-001 How to save the UA collected data into SQL and then show trend chart in 

InduSoft? (Take MS SQL 2017 Express as an example)   

 

The connection screen view of the MS SQL Remote Database.  

 

1. MS SQL database screen view: Date/Time column separated  
 

 
Fig. 232) MS SQL database screen view: Date/Time column separated 

 

  

https://www.icpdas.com/en/faq/index.php?kind=326
https://www.icpdas.com/web/product/download/iiot/ua/faq/UA-en-FAQ-001.pdf
https://www.icpdas.com/web/product/download/iiot/ua/faq/UA-en-FAQ-001.pdf
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2. MS SQL database screen view: Date/Time column combined 
 

 
Fig. 233) MS SQL database screen view: Date/Time column combined 
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5.5.5 Data Logger: MySQL / MariaDB 

UA's: MySQL / MariaDB data logger function can automatically record I/O status at setting 

intervals, and write the data directly to remote MySQL and MariaDB databases. 

 

This function is for setting the remote database connection. For the setting about the logger 

and module, please refer to Chapter 5.6. 

 

Function Diagram: 

 
Fig. 234) Remote Database Function Diagram 

Application: 

 

Fig. 235) Remote Database Application 
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Enter the main menu [Advanced Setting] > [Data Logger] > [MySQL/MariaDB], enter a name 
(e.g. “ICPDAS_Cycle_DateTime”), and click the plus sign to add a MySQL or DariaDB remote 
database list.  

 

 
Fig. 236) Advanced Setting > Data Logger – MySQL/MariaDB > List 

Tab. 119) Descriptions: Advanced Setting > Data Logger - MySQL/MariaDB > List 

Advanced Setting > Data Logger > MySQL/MariaDB – MySQL/MariaDB List 

 Remove  
Check Remove box to remove all database connection in list.  

Check the box of each database and click the “Remove” button 

can remove just that database connection. 

Identification Name User defined name to identify the remote database.  

Default: Name. 

Status Display the status (Enable/Disable) of the database connection. 

Default: Enable. 

 Click to add a new remote database connection.  

Edit Click to enter the “Content Setting” page of the remote database. 

 

The page number of the database list: Current page / Total pages. 

Click < or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 
Click “Edit” to enter the “Remote database connect settings” page. 
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Fig. 237) Advanced Setting > Data Logger – MySQL/MariaDB > Content 

Tab. 120) Descriptions: Advanced Setting > Data Logger - MySQL/MariaDB > Content 

Advanced Setting > Data Logger > MySQL/MariaDB – Content Settings 

Identification Name User defined name to identify the database. 

Database Name The name of the remote database. If it does not exist, it will add a 

new database with this name. 

Table Name The table name of the remote database. If it does not exist, it will 

add a new table with this name. 

IP The Server IP and name of the remote database.  

Port The port to connect with database. Default: 3306 (for 

MySQL/MariaDB) 

Account The login name of the remote database. 

Password The login password of the remote database. 

Log Mode Cycle: Record one log data at the interval time set below. 

Cycle-Time Alignment: Cycle mode with Time Alignment. 
Time Alignment is to align records time at the selected interval. It 
will record the first log at the beginning time. And will align other log 
times with multiples of the log interval (seconds, minutes, hours). 
For example, if the log interval is 5 seconds, the first log time is 
13:01:04, and the following log records will be 13:01:05, 13:01:10, 
etc., the seconds being multiples of 5 seconds. 

Data Change: Only record when the data has changed. 

Interval Seconds Set up the interval time to save the I/O data to the remote 

database. Unit: Second. 

Date Time Format Select to separate the date and time into two [Columns] or combine 

the date and time in one [Column]. 

Enable Check to enable the data logger to the remote database.  

Default: check. 



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

209 

Advanced Setting > Data Logger > MySQL/MariaDB – Content Settings 

Test Connection Click to test the connection to the remote database.  

Result: Success or Failure.  

OK / Cancel Click “OK” to save the settings of this page. 

Click “Cancel” to exit the setting page without saving. 

 

 MySQL/MariaDB Remote Database Example Descriptions:  

 

Each tag data and status are recorded in each separate row, the row is added down for 

each interval, and the tag data is recorded in time sequence. 

 

For database operation, please refer to FAQ-Dev-002 (MySQL) of the UA series FAQ list:  

FAQ-Dev-002_How to save the UA collected data into SQL and then show trend chart in 

InduSoft? (Take MySQL Installer 5.7.31 as an example)  

 

The connection screen view of the MySQL Remote Database.  

 

1. MySQL database screen view: Date/Time column separated (reference) 

 
Fig. 238) MySQL database screen view: Date/Time column separated (reference) 

 

https://www.icpdas.com/en/faq/index.php?kind=326
https://www.icpdas.com/web/product/download/iiot/ua/faq/UA-en-FAQ-002.pdf
https://www.icpdas.com/web/product/download/iiot/ua/faq/UA-en-FAQ-002.pdf
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2. MySQL database screen view: Date/Time column combined (reference) 
 

 
Fig. 239) MySQL database screen view: Date/Time column combined (reference) 
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The connection screen view of the MariaDB Remote Database.  

 

1. MariaDB database screen view: Date/Time column separated (reference) 
 

 
Fig. 240) MariaDB database screen view: Date/Time column separated (reference) 
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2. MariaDB database screen view: Date/Time column combined (reference) 
 
 

 
Fig. 241) MariaDB database screen view: Date/Time column combined (reference) 
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5.5.6 Block List: Block Rule 

UA supports a dynamic block list function for information security. This function can set up the 

rules to block IP connections. When the conditions have met the rules, the system can add the 

IP to the block list and block it through the firewall. It also provides the IP situation of the block 

list and the function to unblock the current blocked IP. 

 

The Block List function includes: Block Rule (this section) and Block Status (next section). 

 

Enter the menu [Advanced Setting] > [Block List] - [Block Rule], the screen is as follows. 

 

Fig. 242) Advanced Setting > Block List > Block Rule 
Tab. 121) Descriptions: Advanced Setting > Block List > Block Rule  

Advanced Setting > Block List > Block Rule – Block Rule  

Select All 

  

Check “Select All” box can select all block rules in the list.  

Check the box of each list can select one list, and click the “Remove” 

button can remove just that rule. 

Block Name User defined name to identify the block rules. Default: BlockRule. 

 Click  can add a new Block Name, and then click the [Edit] to set 

up the Block Rule 

Edit Click the [Edit] button to edit the block rules. 

Remove Check the box of the list and click the “Remove” button can remove 

that rule. 

 

The page number of the list: Current page / Total pages. Click < or > to 

go to the previous or next page. 

Save Click to save the settings of this page. 

 
Click the [Edit] button of the Block List to edit the block rules. 
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Fig. 243) Advanced Setting > Block List > Block Rule Edit 

Tab. 122) Descriptions: Advanced Setting > Block List > Block Rule Edit 

Advanced Setting > Block List > Block Rule – Block Rule (Edit) 

Block Name Set the Block Rule Name 

Monitor Port Set the number of the monitor port  

Condition Set and check the connection status threshold and the interval 

for the IP block list of the monitoring port. 

Established 

Connections 

The threshold for established connections 

SYN_RECV 

Connections 

The threshold for SYN_RECV connections 

CLOSE_WAIT 

Connections 

The threshold for CLOSE_WAIT connections 

Interval Time(s) Set the interval time to check (in seconds) 

OK / Cancel 
Click [OK] to save the settings of this page, and exit. 

Click [Cancel] to exit this page but do not save the settings. 
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5.5.7 Block List: Block Status 

UA supports a dynamic block list function for information security. This function can set up the 

rules to block IP connections. When the conditions have met the rules, the system can add the 

IP to the block list and block it through the firewall. It also provides the IP situation of the block 

list and the function to unblock the current blocked IP. 

 

The Block List function includes: Block Rule (previous section) and Block Status (this section). 

 

Enter the menu [Advanced Setting] > [Block List] - [Block Status], the screen is as follows. 

 

 

Fig. 244) Advanced Setting > Block List > Block Status 
Tab. 123) Descriptions: Advanced Setting > Block List > Block Status 

Advanced Setting > Block List > Block Status – Block Status 

IP Display the blocked IP and port number of the block list. 

Can remove the blocked IP from the block list via the "Remove" button. Port 

Remove Check the box of the list and click the “Remove” button can remove the IP 

from the Block List. 
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5.6 Main Menu: Logger Setting 

Logger Setting is the 6th item of the Main Menu, mainly to provide the data logger and the 

connecting modules related settings. 

  

“Logger Setting” provides “Local Data Logger”, “MS SQL” and “MySQL/MariaDB”, and all have 

RTU/TCP module two setting items. The Local Data Logger provides users to record data such 

as RTU/TCP module (Master) channel data into Local CSV log files of the microSD card in UA. 

The “MS SQL” or “MySQL / MariaDB” Remote Database provides users to record data between 

RTU/TCP module (Master) channel data directly into remote database, such as SQL DB. 

 

 

Fig. 245) CH5.6 Main Menu: Logger Setting 

 

The setting for UA series controllers is to set up from the left to the right of the main menu 

functions. User can find the setting step and Web UI information in the following chapters. 

   CH2 Quick Start 1: Hardware/Network Connection  

   CH3 Quick Start 2: Web UI / Setting Steps   

   CH4 Function Wizard: Project Quick Setup  
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5.6.1 Local Data Logger: RTU / TCP Module (Master) 

“Local Data Logger” of “Logger Setting” provides users to record I/O log data of the connecting 

RTU/TCP module (Master) into the local microSD card. 

 

This function is for setting the local data logger and the RTU/TCP modules, using “RTU” 

module setting as an example. For the setting about the logger and microSD card, please 

refer to Chapter 5.5.3. 

 

Function Diagram: 

 
Fig. 246) Logger Setting Function Diagram 

Application: 

 

Fig. 247) Logger Setting Application 

 

 

 
 



UA-2200/UA-5200/7200 User Manual V7.7   ICP DAS 

218 

Enter the main menu [Logger Setting] > [Local Data Logger] > [RTU Module (Master)].  

This setting page is to enable the module(s) or I/O channels for data logger. 

 

 
Fig. 248) Logger Setting > Local Data Logger > RTU Module > List 

Tab. 124) Descriptions: Logger Setting > Local Data Logger > RTU Module > List 

Logger Setting > Local Data Logger - RTU Module (Master) – Modbus Module List 

No. The module number in the module list (Not editable here) 

*Module Name / 

Nickname 

The module name set in the module list (Not editable here) 

Edit If user wants to enable some I/O channels for data logger, click 

[Edit] of that module to enter the “Variable Tale” setting. It is normal 

to set all channels as enabled, and the conversion will not affect 

the unconnected channels. 

All Enabled   

 Enable 

Check [All Enabled] box to enable all modules in list for data 

logger. Default: Uncheck.  

Check the box of each module can enable just that module for data 

logger. 

 

The page number of the module list: Current page / Total pages. 

Click < or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 
 

This function is to enable the module for data logger, please check  the box of the 

module. If user wants to enable some I/O of the module, please click [Edit] button to 

enter the “Module Content Setting” page. 
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The “Module Content Setting” page after clicking the [Edit] button: 
 

 
Fig. 249) Logger Setting > Local Data Logger > RTU Module > Content 

Tab. 125) Descriptions: Logger Setting > Local Data Logger > RTU Module > Content 

Logger Setting > Local Data Logger > RTU Module (Master) – Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Logger Setting > OPC UA > Modbus RTU (Master) – Variable Table 

Variable Name Display the variable name that set in the Modbus Address Mapping Table 

page (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Enabled Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for data 

logger. Default: Uncheck.  

OK Click to save this page settings and back to the module list page. 

 
 

When complete the setting, click [OK] to save this page settings and back to the module list 

page. Remember to click [Save] to save the Convert Setting. 
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5.6.2 MS SQL: RTU / TCP / MQTT Module (Master) 

 

“MS SQL” of “Logger Setting” provides users to record I/O log data of the connecting 

RTU/TCP/MQTT module (Master) into the MS SQL remote database. 

 

This function is for setting the remote data logger and the RTU/TCP modules, using “TCP 

module” setting as an example. For the setting about the MS SQL data logger, please refer 

to Chapter 5.5.4. 

 

Function Diagram: 

 

Fig. 250) MS SQL Remote Database Function Diagram 

Application: 

 

Fig. 251) MS SQL Remote Database Application 
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Enter the main menu [Logger Setting] > [MS SQL] > [TCP Module (Master)], e.g. the remote 

database Name as below.  

 

 
Fig. 252) Logger Setting > MS SQL > TCP Module > List 

Tab. 126) Descriptions: Logger Setting > MS SQL > TCP Module > List 

Logger Setting > MS SQL - TCP Module (Master) > Modbus TCP Module List 

No. The module number in the module list (Not editable here) 

*Module Name / 

Nickname 

The module name set in the module list (Not editable here) 

Edit If user wants to enable some I/O channels for data logger, click [Edit] 

of that module to enter the “Variable Tale” setting. It is normal to set all 

channels as enabled, and the conversion will not affect the 

unconnected channels. 

Database Name 

Apply 

Select the database name set in the “MS SQL” of the “Advanced 

Setting”. Click “Apply” (Text color will change from black to gray). 

All Enabled  

Enabled 

Check [All Enabled] box to enable all modules in list for data logger. 

Default: Uncheck.  

Check the box of each module can enable just that module for data 

logger. 

 

The page number of the module list: Current page / Total pages. Click < 

or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 
 

First select [Database name] and click [Apply] button, and check the enable box of the 

module. If user wants to enable some I/O of the module, please click [Edit] button to 

enter the “Module Content Setting” page. 
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Fig. 253) Logger Setting > MS SQL > TCP Module > Content 

Tab. 127) Descriptions: Logger Setting > MS SQL > TCP Module > Content 

Logger Setting > MS SQL > TCP Module (Master) – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Logger Setting > MS SQL > TCP Module (Master) – Variable Table 

Variable Name Display the variable name that set in the Modbus Address Mapping 

Table page (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Database 

Name 

Display the database name select in previous setting page. (Not 

editable here) 

Enabled  
Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck.  

OK / Cancel Click “OK” to save this page settings and back to the module list page. 

Click “Cancel” to leave this page without save. 
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5.6.3 MySQL / MariaDB: RTU / TCP / MQTT Module (Master) 

 

“MySQL / MariaDB” of “Logger Setting” provides users to record I/O log data of the connecting 

RTU/TCP/MQTT module (Master) into the MySQL / MariaDB remote database. 

 

This function is for setting the remote data logger and the RTU/TCP modules, using “RTU 

module” setting as an example. For the setting about the MySQL / MariaDB data logger, 

please refer to Chapter 5.5.5. 

 

Function Diagram: 

 

Fig. 254) MySQL/MariaDB Remote Database Function Diagram 

Application: 

 

Fig. 255) MySQL/MariaDB Remote Database Application 
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Enter the main menu [Logger Setting] > [MySQL / MariaDB] > [RTU Module (Master)], e.g. 
the remote database Name “Toshiba”, as below.  

 

  
Fig. 256) Logger Setting > MySQL/MariaDB > RTU Module > List 

Tab. 128) Descriptions: Logger Setting > MySQL/MariaDB > RTU Module > List 

Logger Setting > MySQL/MariaDB - RTU Module (Master) - Module List 

No. The module number in the module list (Not editable here) 

*Module Name / 

Nickname 

The module name set in the module list (Not editable here) 

Edit If user wants to enable some I/O channels for data logger, click 

[Edit] of that module to enter the “Variable Tale” setting. It is normal 

to set all channels as enabled, and the conversion will not affect 

the unconnected channels. 

Database Name 

Apply 

Select the database name set in the “MS SQL” of the “Advanced 

Setting”. Click “Apply” (Text color will change from black to gray). 

All Enabled  

Enabled 

Check [All Enabled] box to enable all modules in list for data 

logger. Default: Uncheck.  

Check the box of each module can enable just that module for data 

logger. 

 

The page number of the module list: Current page / Total pages. 

Click < or > to go to the previous or next page. 

Save Click to save the settings of this page. 

 
 

First select [Database name] and click [Apply] button, and check the enable box of the 

module. If user wants to enable some I/O of the module, please click [Edit] button to 

enter the “Module Content Setting” page. 
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Fig. 257) Logger Setting > MySQL/MariaDB > RTU Module > Content 

Tab. 129) Descriptions: Logger Setting > MySQL/MariaDB > RTU Module > Content 

Logger Setting > MySQL/MariaDB - RTU Module (Master) – Module Content Setting 

No. The module number in the module list (Not editable here) 

Module Name The module name set in the module list (Not editable here) 

Logger Setting > MySQL/MariaDB - RTU Module (Master) – Variable Table 

Variable Name Display the variable name that set in the Modbus Address Mapping 

Table page (Not editable here) 

Attribute Display data attribute of the variable. (Not editable)  

Include: Read, Read/Write… 

Data Type Display data type of the variable that set in the Modbus Address 

Mapping Table page. (Not editable) Include: Bool, Short, Float… 

Database 

Name 

Display the database name select in previous setting page. (Not 

editable here) 

Enabled  
Check [Enabled] box of the top row can enable all variables in list. 

Check the box of each variable can enable just that variable for 

conversion. Default: Uncheck.  

OK / Cancel Click “OK” to save this page settings and back to the module list page. 

Click “Cancel” to leave this page without save. 
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5.7 Main Menu: I/O Status 

I/O Status is the 6th item of the Main Menu, mainly to display the retime I/O status of all the 

modules.  

 
I/O Status page offers an easy way to view monitoring page that allows you to view important 
controller information in real time. The I/O Status page includes the following information.  
 
i. System default I/O Status page: It displays the all I/O channel information based on the 

sorting of all I/O Modules.  
ii. Related settings and the user-defined I/O Status page: It displays the I/O channel status 

based on the user-defined arrangement. 
 
The user can click the module name on the left site, and the right will show all the real time 
I/O status of the selected module. 
 

 
 
And the I/O status for the following: 
 

           
 

Fig. 258) CH5.7 Main Menu: I/O Status 
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5.8 Main Menu: File Setting 

File Setting is the last item of the Main Menu, mainly to provide the settings about the files, 

such as remove, update, upload and download the files of the project and certificate. 

 
File Setting provides 4 sub-menu functions. This chapter will introduce the function items and 
setting parameters.  
 

 
Fig. 259) CH5.8 Main Menu: File Setting 

 
 

The setting for UA series controllers is to set up from the left to the right of the main menu 

functions. User can find the setting step and Web UI information in the following chapters. 

   CH2 Quick Start 1: Hardware/Network Connection  

   CH3 Quick Start 2: Web UI / Setting Steps   

   CH4 Function Wizard: Project Quick Setup  
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5.8.1 Project File 

This page provides 3 setting items: Remove the file, Upload the file to the controller, and 

Download the file to the local computer. 

 

 
Fig. 260) File Setting > Project File 

Tab. 130) Descriptions: File Setting > Project File 

File Setting > Project File > Remove the File 

Project File Click [Remove] to delete all project settings current in the UA series 

controller. 

File Setting > Project File > Upload the file to the controller 

Project File Select File: click to select the project that want to upload to the UA 

controller. (Extension name of the project file: “.tar”) 

Upload: upload the project file into the UA controller. 

If select a wrong file (extension name is not “.tar”), the system will show 

an error message. 

   

Select a right format file with extension name of “.tar”, as below. 

 

File Setting > Project File > Download the file to the local computer 

Project File Download: Download the project with all Web UI settings to the current 

computer. (Extension name of the project file: “.tar”) 
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5.8.2 OPC UA Certificate 

UA controller supports OPC UA Server security connection, including identity 

authentication, data encryption, data signature. Server and Client authenticate each 

other through x.509 certificate. Compared with the traditional method, it has the following 

functional advantages. 

 

 
Fig. 261) OPC UA Identity Authentication / Data Encryption 

 

This function is the certificate file management function of OPC UA Server. There are 3 setting 

items about OPC UA Certificate: Remove, Upload the file to the controller, download the file 

from the controller. If your project need not the certificate, you can skip this step. 

 

In the [OPC UA Certificate] step, users can add mutual credentials on both side's devices to 

strengthen security encryption. 

 

 First, obtain the OPC UA Client trust certificate file of the device from the connected party, 

save it to the PC. In this step, select this file and upload it to the UA controller. (If there was 

an old certificate file in UA, remove it first.) 

 

 The device of the other side needs the UA certificate also. In this step, download the OPC 

UA Server certificate file (Certicate_IPAddress_.tar) to the other party, so that they can 

decompress the file (icpdasuaserver.der) and upload to their device.  
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Fig. 262) File Setting > OPC UA Certificate  

 
Tab. 131) Descriptions: File Setting > OPC UA Certificate 

File Setting > OPC UA Certificate > Remove the File 

Trusted 

Certificate 

Remove: Click to delete the OPC UA client Trusted Certificate current in 

the UA controller. 

OPC UA 

Server 

Certificate 

Remove: Click to delete the OPC UA Server Certificate current in the UA 

controller. 

File Setting > OPC UA Certificate > Upload the file to the controller 

Trusted 

Certificate 

Select File: select the OPC UA Trusted Certificate file in PC to upload to 

the UA controller. 

Upload: upload the Trusted Certificate file to the UA controller. 

 File format must be DER. Extension name must be “der / cer / crt”.  

     
 If select a wrong file, the system will show an error message. 

 

File Setting > OPC UA Certificate > Download the file from controller 

OPC UA 

Server 

Certificate 

Download: Download the OPC UA Server Certificate file to the current 

using computer. 

 File format: DER.  File name: Certicate_IP-address_.tar  

e.g. .  

Before using, decompress to icpdasuaserver.der, as below. 
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5.8.3 MQTT Certificate 

UA controller supports MQTT Client secure encrypted certificate file management. 

There are three types of files: Trusted Certificate, Certificate, and Private Key. Compared 

with the traditional method, it has the following functional advantages. 

 

 
Fig. 263) MQTT Identity Authentication / Data Encryption 

 

The [MQTT Certificate] is for setting up security communications to upload and remove the 

MQTT Certificate.  

 

The users upload the file to the UA controller according to the type of obtained certificate. There 

are 3 types of MQTT Certificate: 

 Trusted Certificate 

 Certificate 

 Private Key 

 

If you want to perform Broker authentication, you need to upload the Trusted Certificate. If 

you want to perform the Broker/Client two-way authentication, you need to upload the 

Credential and Private Key additionally. The user can skip this step if the user project does 

not use certificate transmission security. 
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This page provides 2 setting items: Remove the file, and Upload the file to the controller for 

the MQTT Trusted Certificate, Certificate and Private Key. 

 

 
Fig. 264) File Setting > MQTT Certificate  

 

Tab. 132) Descriptions: File Setting > MQTT Certificate 

File Setting > MQTT Certificate > Remove the File 

Trusted 

Certificate 

Remove: delete the MQTT Trusted Certificate current in the UA series 

controller. 

Certificate Remove: delete the MQTT Certificate current in the UA series controller. 

Private Key Remove: delete the MQTT Private Key current in the UA series controller. 

File Setting > MQTT Certificate > Upload the file to the controller 

Trusted 

Certificate 

Select File: select the MQTT Trusted Certificate file of the device. 

Upload: upload the MQTT Trusted Certificate file to the UA controller. 

 File format must be PEM. Extension name must be “pem / cer / crt”.  

 If select a wrong file, the system will show an error message. 

 

Certificate Select File: select the MQTT Certificate file of the device. 

Upload: upload the MQTT Certificate file to the UA controller. 

 File format must be PEM. Extension name must be “pem / cer / crt”.  

 If select a wrong file, the system will show an error message. 

Private Key Select File: select the MQTT Private Key of the device. 

Upload: upload the MQTT Private Key file to the UA controller. 

 File format must be PEM. Extension name must be “.key”.  

 If select a wrong file, the system will show an error message. 
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5.8.4 Log File Download 

This function page is to view and download the Local Data Logger files of the microSD card 

in the UA series controller. 

 
Fig. 265) File Setting > Log File Download 

 

When enable the [Local Data Loger] function, the module's Data log files will be regularly 
generated and stored in the microSD card of the UA. The User can download the generated 
data log files to a PC in this function. 

 
Fig. 266) File Setting > Log File Download > DataLog  

 

When enable the [System Log] of [controller service setting] or [boot], you can download the 

[syslog] file here to view the UA system status. 

 
Fig. 267) File Setting > Log File Download > DataLog > syslog 

 
Tab. 133) Descriptions: File Setting > Log File Download > DataLog > syslog 

File Setting > Log File Download > DataLog 

File Name At first, display the year-month folder (e.g. 2020-01), click the year-

month folder to list all log files in this month, with the file name  

"log-YYYY-MM-DD-HH-mm-ss.csv ". 

File Size The size of the log file. Unit: KB 

Download Click to download the Log file to the specific folder of the PC. 

 
The page number of the Log file list: Current page / Total pages. Click < 

or > to go to the previous or next page. 
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5.8.5 Firmware Update 

This function is about the update operation of the firmware file, mainly uploading the firmware 

file to update the version of the UA controller. 

 

Before updating, please download the latest Firmware software file from ICP DAS UA series 

download center, save it to your computer, and then can upload the file to the UA controller. 

 

UA series Download Center): 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=ua-  

Note: unzip the zip file to “.tar”, DO NOT decompress the “.tar” file again. 

 

 

Fig. 268) File Setting > Firmware Update 
Tab. 134) Descriptions: File Setting > Firmware Update 

File Setting > Firmware Update  

Upload the 

Firmware 

Go to the UA series download center of the ICP DAS website to download the 

latest Firmware software file, save it to your computer. Note: unzip the zip 

file to “.tar”, DO NOT decompress the “.tar” file again.  

Click “Upload the Firmware” button and select the firmware file. 

Update / 

Information 

Box 

Select the Firmware file and click the “Update” button, it will update the 

Firmware version automatically.  

In the update operation, the information box below will display the updating 

status, and a final message will show if the updating succeeded or failed. 

 

http://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=ua-
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6. Factory Setting Recovering and Firmware Updating  

This chapter will introduce the settings by hardware Rotary Switch, including “Factory Setting 

Recovering” and “Firmware Updating” that supported since Version 1.0.0.3. 

 

6.1 Recovering to Factory Setting (Rotary Switch: 8 / DIP 
Switch: 4) 

Switch the Rotary Switch of UA-5200/2200 to “8” or the DIP Switch #4 of UA-7200 to “ON” for 

recover the UA Series to the factory setting. Before that, first to connect the UA controller via 

a network cable to a PC or a Switch. 

 

The steps:  

1. After connecting the network, power off the UA hardware. 

Turn the Rotary Switch of UA-5200/2200 to “8”, 

or switch the DIP Switch #4 of UA-7200 to “ON”. 
                                          Fig. 269) CH6. Rotary Switch - 8 

 

2. Reboot the UA and wait a long buzzer sound that means of doing the recovering. 

 

3. Wait about 3 minutes until 2 long buzzer sounds, and then turn the Rotary Switch of UA-

5200/2200 to “0”, or switch the DIP Switch #4 of UA-7200 back to “OFF”.  

Note: If the buzzer makes 4 short beeps, it means the network is not connected 

properly. Please check the network cable again.  

 

4. Reboot the UA again, and the system will recover to the factory settings. 

 

Tab. 135) Factory Default Settings of UA Series 

Factory Default Settings of UA Series 

Network 

IP  
LAN1: 192.168.255.1 
LAN2: 10.0.0.1 Assign UA a new IP address 

according to your case.  
For UA-2200 series, set the 
LAN1 for the connection. 

Mask 255.255.0.0 

Gateway 
LAN1: 192.168.1.1 
LAN2: 10.168.1.1 

Web UI 
Account 

Username root 
After login, change your 
password as soon as 
possible.  
(Section 5.1.4 for Web UI) 

Password root 
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6.2 Updating Firmware A – via Web UI of UA 

The user can update firmware via the Web UI function of the UA controller. 

Before updating, please download the latest Firmware software file from ICP DAS UA series 

download center, save it to your computer, and then can upload the file to the UA controller. 

 

UA series Download Center: 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=ua-  

Note: DO NOT decompress the “.tar” Firmware file. 

 

 
Fig. 270) Download Firmware File 

 

Fig. 271) Firmware Update - via Web UI of UA 
Tab. 136) Descriptions: File Setting > Firmware Update 

File Setting > Firmware Update  

Upload the 

Firmware 

Go to the UA series download center of the ICP DAS website to download the 

latest Firmware software file, save it to your computer.  

Note: DO NOT decompress the “.tar” firmware file.  

Click “Upload the Firmware” button and select the firmware file. 

Update / 

Information 

Box 

Select the Firmware file and click the “Update” button, it will update the 

Firmware version automatically.  

In the update operation, the information box below will display the updating 

status, and a final message will show if the updating succeeded or failed. 

   

http://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=ua-
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6.3 Updating Firmware B - via USB (Rotary Switch: 9) 

Turn the Rotary Switch of UA series to “9” can update the Firmware version via USB.  

 

Note: UA-7200 series has no USB, so it is not suitable for this method. After updating the 

system version, only reserve the environment settings (IP, Mask, and Gateway) of the 

UA series on the last network, and the rest settings will be factory recovered. 

 

The steps: 

1. Power off the UA hardware, and turn the Rotary Switch to “9”. 

 

 
Fig. 272) Rotary Switch - 9 

 

2. Download the Firmware package file of the UA hardware corresponding model.  

UA Download Center: 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=ua-   

 

3. Save the Firmware package file into an empty FAT32 format USB drive and put to the 

UA USB port. 

 

4. Reboot the UA and wait a long buzzer sound that means of doing the version updating. 

 

5. Wait about three minutes until two long buzzer sounds, and then turn the Rotary Switch 

to “0”. 

Note:  

If the buzzer makes 4 short beeps, it means the USB may not connected properly. 

Please check the USB again. 

 

6. Reboot the UA again, and the system will update to the version of the package file. 

 

Note:  

If the updating Firmware via USB still fails, please refer to nest section for using the 

MicroSD card to manually update the Firmware version. 

 
 
 
 

  

http://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=ua-
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7 Security Certificate: Download / Upload  

UA communication security includes the username/password protection, SSL/TLS 

secure communication (Secure Socket Layer / Transport Layer Security), and OPC UA 

Server / MQTT Client certificate mechanism to protect data transmission security.  

 

OPC UA certificate provides the certificate exchange with Server and Client side to 

authenticate each other through the x.509 certificate to protect the data transmission security. 

OPC UA default enables encryption and security mechanisms with advanced processing, 

including: Authentication, Authorization, Confidentiality and Integrity. 

 

MQTT certificate provides three certificate types: Trusted Certificate, Certificate, and 

Private Key. Depending on the type of certificate obtained to perform the Broker verification 

or Broker/Client mutual verification. It supports identity verification and data encryption, and 

provides a secure connection. mechanism. 

 

 OPC UA Server Certificate management 

UA controller supports OPC UA Server security connection, including identity 

authentication, data encryption, data signature. Server and Client authenticate each 

other through x.509 certificate.  

There are 3 items in OPC UA Certificate: Remove, Upload and Download the Certificate file. 

Download is for providing the OPC UA Server certificate to the other side. 

Upload is to save the other’s trust certificate into the UA. So before uploading, please get the 

certificate file of the other side device first. Please refer to 7.2.1 for details. 

 

 MQTT Client Certificate management 

UA controller supports MQTT Client secure encrypted certificate file management. 

There are three types of files: Trusted Certificate, Certificate, and Private Key. The users 

upload the file to the UA controller according to the type of obtained certificate. If you want to 

perform Broker authentication, you need to upload the Trusted Certificate. If you want to 

perform the Broker/Client two-way authentication, you need to upload the Credential and 

Private Key additionally.  

Therefore, before uploading, you must confirm the required verification method, obtain the 

required certificate file, and store it in your computer before you can configure the upload 

certificate. Please refer to 7.2.2 for details. 
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The upload and download of OPC UA and MQTT Certificates are in the main menu [File 

Setting]. Before setting this function, you need to download or upload the relevant certificates. 

This chapter is divided into two sections, download/upload, to explain the setting steps and 

notices. 

 

 

Fig. 273) CH7. OPC UA Certificate 

 

 

Fig. 274) MQTT Certificate 

 

7.1 Download the Certificate from UA Controller  

7.2 Upload the Certificate to UA Controller   

  7.2.1 OPC UA Certificate 

  7.2.2 MQTT Certificate 
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7.1 Download the Certificate from UA Controller  

 

Download is for providing the OPC UA Server certificate to the other side. 

 

   
Fig. 275) Download OPC UA Certificate 

 
 

1. Click the main menu [ File Setting > OPC UA Certificate > Download the file from 

the controller – OPC UA Server Certificate] and then click on the button  [Download]. 

 

2. Save the OPC UA Server certificate file to your designated folder. The downloaded 

certificate file (*.tar) of the UA series controller looks similar to the figure below. 

 
Fig. 276) OPC UA Certificate File 
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7.2 Upload the Certificate to UA Controller 

The user can store trusted certificates of the OPC UA client or the MQTT Broker from other 

device into the UA project for setting up security communications. 

 

7.2.1 OPC UA Certificate 

 
Fig. 277) Upload OPC UA Certificate 

 

1. Get the trusted certificates from OPC UA Client and save in the PC. 

 

2. Click the main menu [File Setting >  OPC UA Certificate > Upload the file to the 

controller – Trusted Certificate], click on the button  [Select File] to select the trusted 

certificates from OPC UA Client. 

 

3. Click the button  [Upload], then can upload and exchange the certificate authentication. 

 

Notes for OPC UA Certificate: 

 The supported code format: “DER”. 

 The supported file extension name: “ *.der / *.cer / *.crt ” .  

 The OPC UA Server Certificate downloaded from UA series: 

File name: Certicate_IP-address_.tar, e.g. .  

Before using, decompress to icpdasuaserver.der, e.g.  

 Refer to 5.8.2 for detail parameter descriptions. 
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7.2.2 MQTT Certificate 

If you want to perform Broker authentication, you need to upload the Trusted Certificate. If 

you want to perform the Broker/Client two-way authentication, you need to upload the 

Credential and Private Key additionally. 

 

 
Fig. 278) Upload MQTT Certificate 

 

1. Get the trusted certificates from MQTT Client and save in the PC. 

 

2. Click the main menu [  File Setting >  MQTT Certificate > Upload the file to the 

controller – Trusted Certificate / Certificate / Private Key], click on the button  

 [Select File] to select the Trusted Certificate, Certificate or Private Key from MQTT 

Client. 

 

3. Click the button  [Upload], then UA system can exchange the certificate 

authentication. 

 

 

Notes for MQTT Client Certificate: 

 The supported code format: “PEM”. 

 The supported file extension name for Certificates: “ *.pem / *.cer / *.crt ” .  

 The supported file extension name for Private Key: “ *.key ” .  

 Refer to 5.8.3 for detail parameter descriptions. 
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Appendix A. MQTT JSON Format of the UA Series 

Tab. 137) Appendix A. MQTT JSON Format 

 

MQTT JSON Example & Format Descriptions: 

{ 

  "Variable" : [ { 

    "Name" : "Bool_R[0]", 

    "Attribute" : "R", 

    "Datatype" : "Bool", 

    "Value" : 0, 

    "Quality" : "Uncertain" 

  }, { 

    "Name" : "Short_R[0]", 

    "Attribute" : "R", 

    "Datatype" : "Int16", 

    "Value" : 0, 

    "Quality" : "Uncertain" 

  }, { 

    "Name" : "Short_R[1]", 

    "Attribute" : "R", 

    "Datatype" : "Int16", 

    "Value" : 0, 

    "Quality" : "Uncertain" 

  }, { 

    "Name" : "Short_R[2]", 

    "Attribute" : "R", 

    "Datatype" : "Int16", 

    "Value" : 0, 

    "Quality" : "Uncertain" 

  }, { 

    "Name" : "Short_RW[2]", 

    "Attribute" : "RW", 

    "Datatype" : "Int16", 

    "Value" : 0, 

    "Quality" : "Uncertain" 

  } ] 

} 

Name Descriptions 

Variable The array name of JSON.  

Its structure includes several member 

data as below. 

Name The member name of the array element 

Attribute The member attribute of the array 

element: 

“R” : can read 

“W” : can write 

”RW” : can read and write 

Datatype The member’s data type of the array 

element: 

"Bool"  

"Int8"  

"UInt8"  

"UInt16"  

"Int16"  

"UInt32"  

"Int32"  

"UInt64"  

"Int64"  

"Float"  

"Double"  

"String" 

Value The member’s current value of the array 

element 

Quality The member’s current status of the 

array element: 

"Uncertain" 

"Good" 

"Bad" 
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Appendix B. Protocol Technical Reference 

 OPC UA 

https://opcfoundation.org/ 

 

 MQTT 

http://mqtt.org/ 

 

 Modbus 

http://modbus.org/ 

 

 

  

https://opcfoundation.org/
http://mqtt.org/
http://modbus.org/
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Appendix C. LED Indicators 

LED indicators of UA Series provide a very convenient way of status indications for faster, 

easier diagnostics. 

    

C.1  UA-5231/5231M LEDs 

 

  
Fig. 279) UA-5231/5231M LED Indicators 

 
Tab. 138) Appendix C.1 LED Status Description Table: UA-5231/5231M 

UA-5231 / UA-5231M 

LED LED Status Module Status 

PWR Green: ON The module is powered on. 

RUN Red: Blinking The system is functioning normally.  

When power on UA, please wait about one minute for 

completing the start-up procedure until the "RUN" LED 

starts blinking. 

L1  OFF Function reserved 

L2 Green:  

Blinking, then ON, 

and then OFF. 

When install or update the Firmware, L2 will blinking. 

When complete the process, L2 will steady ON to notify 

user and then OFF.  
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C.2  UA-5231M-3GWA/-4GE/-4GC LEDs 

  

  
Fig. 280) UA-5231M-3GWA/-4GE/-4GC LED Indicators 

Tab. 139) Appendix C.2 LED Status Description Table: UA-5231M-3GWA/-4GE/-4GC 

UA-5231M-3GWA / UA-5231M-4GE / UA-5231M-4GC 

LED LED Status Module Status 

PWR  Green: ON The module is powered on. 

RUN  Red: Blinking  The system is functioning normally.  

When power on UA, please wait about one 

minute for completing the start-up procedure 

until the "RUN" LED starts blinking.  

3G Green: ON The modem is functioning normally, and SIM 

card inside. 

OFF The modem is not functioning, or no SIM card 

inside. 

4G Green Light Flash:  

ON for 2 seconds, OFF for 1 sec, 

and flashing alternately. 

The modem is functioning normally, and the 

SIM card inside. 

Green Light Flash: 

ON for 1 second, OFF for 2 secs, 

flashing alternately, or OFF . 

The modem is not functioning, no SIM card 

inside, or the PIN is still locked. 

Green Light Flash: Quickly Data is transmitting.  

L1 OFF Function reserved 

L2 Green:  

Blinking, then ON, and then OFF. 

When install or update the Firmware, L2 will 

blinking. When complete the process, L2 will 

steady ON to notify user and then OFF.  
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C.3  UA-2241M/2241MX-4GE/2241MX-4GC LEDs 

 

UA-2241M   UA-2241MX-4GE/C 
Fig. 281) UA-2241M/-4GE/-4GC LED Indicators 

Tab. 140) Appendix C.3 LED Status Description Table: UA-2241M/-4GE/-4GC  

UA-2241M / UA-2241MX-4GE / UA-2241MX-4GC 

LED LED Status Module Status 

PWR Green: ON The module is powered on. 

RUN  Red: Blinking  The system is functioning normally.  

When power on UA, please wait about one 

minute to complete the start-up procedure 

until the "RUN" LED starts blinking. 

L1 / L3 OFF Function reserved 

L2 Yellow Light:  

Blinking, then ON, and 

then OFF. 

When install or update the Firmware, L2 will 

blinking. When complete the process, L2 will 

steady ON to notify user and then OFF.  

4G  

(UA-2241MX-4GE 

UA-2241MX-4GC) 

Orange Light:  

Flashing per 2 seconds, 

and then ON. 

The modem is functioning normally, and the 

SIM card is functioning normally. 

Orange Light: 

Flashing per 2 seconds, 

and then OFF.  

Or OFF. 

The modem is not functioning,  

no SIM card inside,  

or the PIN is still locked. 

Light Flash: Quickly Data is transmitting.  
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C.4  UA-7231M LEDs 

 

 
Fig. 282) UA-7231M LED Indicators 

 
Tab. 141) Appendix C.4 LED Status Description Table: UA-7231M  

UA-7231M 

LED LED Status Module Status 

PWR Red: ON The module is powered on. 

RUN Green: Blinking The system is functioning normally.  

When power on UA, please wait about one minute for 

completing the start-up procedure until the "RUN" 

LED starts blinking. 

PoE Green: ON The module has been connected to a PoE Ethernet 

switch 

E1 

(Ethernet) 

Green: Blinking The Ethernet network is connected and 

communicating. 
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Appendix D. Mounting the XV-board for UA Series 

 
XV-board Expansion Module Supported List of UA Series :  
Tab. 142) Appendix D. XV-board Supported List of UA Series 

XV-board Type XV-board Model Supported UA Model 

I/O Expansion 
XV107, XV110, XV111, XV116, XV119, 

XV303, XV306, XV307, XV310 
UA-2200 / 5200 / 2800 Series 

RS-485 Expansion XV511i 
UA-2241M, UA-2841M,  

UA-5231, UA-5231M 

 

For more detailed information about the all XV-board specifications, please refer to the XV-

board Expansion Module. 

 
Tab. 143) PIN Assignment Table of XV511i RS-485 I/O Expansion Board 

Model Descriptions 

XV511i 

 
4-channel RS-485 I/O Expansion Board (RoHS) 
 

PIN Assignment: 
 
 
 
 

 
 

P4: ttyO9   P3: ttyO8   P2: ttyO7   P1: ttyO6 
 

 
 

  

https://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__I_O__Modules+XV-board
https://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__I_O__Modules+XV-board
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D.1 Mounting Steps For UA-2241M Series 

 

UA-2241M has one I/O expansion bus to expand the functions by insert one optional XV-

board. The supported XV-boards are listed after the mounting steps below.  

 

Mounting Steps: 

Step 1: Remove stripped screws and then remove the cover 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 283) Appendix D.1 UA-2241M Mounting XV-board Step 1 
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Step 2: Hold the XV-board vertically and align the socket, and then carefully press the 

XV-board onto the I/O expansion bus 

Step 3: Fasten the XV-board using the screws supplied 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 284) Appendix D.1 UA-2241M Mounting XV-board Step 3 
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Step 4: Close the cover and then fasten the screws 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 285) Appendix D.1 UA-2241M Mounting XV-board Step 4 

Step 5: Insert the I/O terminal 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

Fig. 286) Appendix D.1 UA-2241M Mounting XV-board Step 5 
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D.2 Mounting Steps For UA-5231 

 

 

 
Fig. 287) Appendix D.2 UA-5231 Mounting XV-board Steps 
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D.3 Mounting Steps For UA-5231M Series 

 

 
Fig. 288) Appendix D.3 UA-5231M Mounting XV-board Steps 
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Appendix E. Import Modbus Module Profile and CSV 

File Field Descriptions 

When UA connects many modules, setting multiple modules one by one is very time-consuming. 

UA allows setting many modules at once by writing the setting data of many modules in a CSV 

file and importing it to UA. Please write the different types of modules in different CSV files. 

 

The following sections describe the Modbus RTU and TCP module configuration file functions 

and the field data of the CSV file. 

 

 

E.1 Modbus RTU Module Profile and Field Descriptions 

The Import Modbus RTU module profile function is in the menu [Module Setting] > [Modbus > 
RTU Module] > [Import Module Profile] – [Upload Module Profile] option. as follows. 
 
 

Modbus RTU Import Module Profile function: 
 
Click the [Upload Module Profile] button, then select the prepared CSV file, import it, and save 
the settings. The setting modules will show on the [Module List], and click the [Edit] button to 
see the module settings. 
 
 

 
Fig. 289) Appendix E.1 Modbus RTU Import CVS Module Profile function 
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Field Setting Descriptions of CVS File for Modbus RTU Module: 
 

 
Fig. 290) Field Setting Example of CVS File for Modbus RTU Module 

Tab. 144) Field Setting Descriptions of CVS File for Modbus RTU Module 

First Table Field Descriptions: 

ModuleName The module name. e.g. in the example, the module name is "DL-302". 

SlaveID The Slave ID of the module. e.g. In the example, the Slave ID is "1". 

Timeout The time no response, unit: ms. If the module does not respond within 
this period, the communication is considered failed. In the example, 
the timeout is "500" ms. 

Second Table Field Descriptions: 

VariableName The variable name, e.g. "CO2", "Relative_humidity", etc. 

ModuleName The module name of the variable, e.g. this example sets "DL-302", 
indicating that the variable belongs to DL-302. 

DataType The type of data, includes "Bool", "Short", "Unsigned Short", "Long", 
"Unsigned Long", "Int64", "Float", "Float64" and other types. 

Function The Modbus function codes of the variable, includes "0x", "1x", "3x", 
and "4x". 

Address The address of the Modbus variable. 

FunctionGroup Functional group of variable. Variables in the same group are 
represented as being in the same Modbus command. 

IsSwap Set whether the value of the variable swaps the byte positions. 
"TRUE" means swap, and "FALSE" does not swap. 

Description Description of the variable, such as "CO2", "Hhumidity", etc. 

Scaling Name The name of the Scaling variable, fill in if you want to set Scaling. 

Original The range of the original value is separated by the “~” symbol, such 
as 0~1000. 

Target The range of the value after scaling is separated by the “~” symbol, 
such as 0~100. 

Offset The offset of the value after scaling 

Scaling Description Description of Scaling variables 
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E.2 Modbus TCP Module Profile and Field Descriptions 

 
The Import Modbus TCP module profile function is in the menu [Module Setting] > [Modbus > 
TCP Module] > [Import Module Profile] – [Upload Module Profile] option. as follows. 
 
 

Modbus TCP Import Module Profile function: 
 
 
Click the [Upload Module Profile] button, then select the prepared CSV file, import it, and save 
the settings. The setting modules will show on the [Module List], and click the [Edit] button to 
see the module settings. 

 

 
Fig. 291) Appendix E.2 Modbus TCP Import CVS Module Profile function 
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Field Setting Descrptions of CVS File for Modbus TCP Module: 
 

 
Fig. 292) Field Setting Example of CVS File for Modbus TCP Module 

Tab. 145) Field Setting Descriptions of CVS File for Modbus TCP Module 

First Table Field Descriptions: 

ModuleName The module name. e.g. in the example, the module name is "DL-302". 

IP IP of the connected module 

Port The connected TCP communication port 

SlaveID The Slave ID of the module. e.g. In the example, the Slave ID is "1". 

Timeout The time no response, unit: ms. If the module does not respond within 
this period, the communication is considered failed. In the example, 
the timeout is "500" ms. 

PollingRate The interval time between polling commands 

Second Table Field Descriptions: 

VariableName The variable name, e.g. "CO2", "Relative_humidity", etc. 

ModuleName The module name of the variable, e.g. this example sets "DL-302", 
indicating that the variable belongs to DL-302. 

DataType The type of data, includes "Bool", "Short", "Unsigned Short", "Long", 
"Unsigned Long", "Int64", "Float", "Float64" and other types. 

Function The Modbus function codes of the variable, includes "0x", "1x", "3x", 
and "4x". 

Address The address of the Modbus variable. 

FunctionGroup Functional group of variable. Variables in the same group are 
represented as being in the same Modbus command. 

IsSwap Set whether the value of the variable swaps the byte positions. 
"TRUE" means swap, and "FALSE" does not swap. 

Description Description of the variable, such as "CO2", "Hhumidity", etc. 

Scaling Name The name of the Scaling variable, fill in if you want to set Scaling. 

Original The range of the original value is separated by the “~” symbol, such 
as 0~1000. 

Target The range of the value after scaling is separated by the “~” symbol, 
such as 0~100. 

Offset The offset of the value after scaling 

Scaling Description Description of Scaling variables 
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